
About (Help Menu)    
Displays the name of the licensed user and the version number of the FlexiFAMILY product which is 
currently running.



The underlined triangle is the active color. Its color is displayed in the Color preview display. You can 
change the color by clicking the Color button and editing the Color dialog box.



Click the Add button to move a fill from the Color palette to the fill library or vice versa.



Add Control Point (Path Edit Palette)    

The Add Control Point tool adds control points to uncompounded paths.

To add a control point to a path, click the Add Control Point tool on the path where you want the new 
point.    Continue adding points by clicking the tool on the path.    To stop adding points, click another tool.

NOTE If you cannot select a single point, the path may be compounded.    To correct this, choose 
Release Compound from the Arrange menu.

See Also
Release Compound

Point Selection tool

Delete Control Point tool



If you choose Advance After Plot, the media moves forward and resets the origin after the job is cut.



Align (Arrange Menu)    
Arranges selected text or graphic objects in relation to each other or to the drawing border.

To arrange objects relative to each other, use the Arrow tool to select the object with which you 
want to align other objects, then hold down the Shift key and select the objects to be aligned. 
Choose the Align command from the Arrange menu and then choose the desired alignment 
option.

To align one object to the drawing border, select it using the Arrow tool.    Choose the Align 
command from the Arrange menu and then choose the desired alignment option.

To align multiple objects to the drawing border, hold down the Shift key and select them using the 
Arrow tool.    Next, choose the Align command from the Arrange menu and then hold down 
the Ctrl key while choosing the desired alignment option.

NOTE To change the alignment of a text block (e.g., Left, Center, Right), use the Alignment or Full 
Justify commands found on the Text menu.

Alignment options
Left sides    All selected text and graphic objects move horizontally (left or right) so their left sides are in 
line with the left side of the object which was selected first or with the left side of the drawing border if only
one object is selected.

Right sides    All selected text and graphic objects move horizontally (left or right) so their right sides are 
in line with the right side of the object which was selected first or with the right side of the drawing border 
if only one object is selected.

Bottom edges    All selected objects move vertically (up or down) so their bottom edges are in line with 
the bottom edge of the first object selected or with the bottom edge of the drawing border if only one 
object is selected. Notice that the bottom edge of a text object’s bounding extent is aligned, not the 
baseline    of the text.

Top edges    All selected objects move vertically (up or down) so the top edges of their bounding extents 
are in line with the top edge of the first object selected or with the top edge of the drawing border if only 
one object is selected.

Horizontal centers    All selected objects move horizontally (left or right), so their centers are in line with 
the center of the object which was selected first or with the center of the drawing area if only one object is 
selected. Notice that the centers of the objects’ bounding extents are aligned.

Vertical centers    All selected objects move vertically (up or down) so their centers are in line with the 
center of the first object selected or with the center of the drawing area if only one object is selected.

Both centers    All selected objects move vertically and horizontally to align the objects on top of the first 
object selected or if only one object is selected, in the vertical and horizontal center of the drawing area. 
This is especially useful for centering objects within a border.

Text baselines    All text objects in separate blocks move vertically so their baselines are in line with the 
first text object selected. Notice that graphic objects do not move even if they are selected when this 
command is applied.

Character    All text objects move horizontally so a specified character found in each object is aligned.    
(When this option is selected, a dialog box is displayed which allows you to specify the character.)    If the 
character appears more than once in any of the objects, the specified character which appears closest to 
the left in the object aligns with the character in other objects.    This option is perfect for aligning decimals
on menu boards.

See Also
Alignment (Text Menu)



Full Justify (Text Menu)



Align Diagonal (Path Edit Palette)    

The Align Diagonal tool arranges selected control points along a diagonal line, allowing you to let Flexi 
average their new location automatically, place the new angle and location freehand, or use the reference
angle as the angle of alignment. This tool can also align entire paths.

Aligning points automatically
To align points to the average diagonal line between the selected control points:

- Select three or more points by holding down the Shift key and clicking each point with the 
Point Selection tool or by dragging across them. The points can be on the same path or 
different paths.

- Click on the Align Diagonal tool.

NOTE If the cursor displays as a question mark or the paths move instead of just the points, you need 
to choose the Average option. To change this setting, double-click or hold down the Ctrl key and 
click the Align Diagonal tool. In the Diagonal Alignment Options dialog box, choose the Average 
option, make sure the Move entire path option is not selected, and click OK.

Aligning points freehand
To align points diagonally by placing an alignment line:

- Select two or more points by holding down the Shift key and clicking each point with the Point
Selection tool or by dragging across them. The points can be on the same path or on 
different paths.

- Double-click or hold down the Ctrl key and click the Align Diagonal tool.

- In the Diagonal Alignment Options dialog box, select the Freehand option, make sure the 
Move entire path option is not selected, and click OK.

- To change the position of the alignment line which is displayed, drag the point at the center.

- To change the angle along which the points will align, drag either end of the alignment line.

- Press Enter to align the selected points.

Aligning points to a specified angle
To specify the angle at which to align points diagonally:

- Select two or more points by holding down the Shift key and clicking each point with the Point
Selection tool or by dragging across them. The points can be on the same path or on 
different paths.

- Double-click or hold down the Ctrl key and click the Align Diagonal tool.

- In the Diagonal Alignment Options dialog box, select the Specify option and make sure the 
Move entire path option is not selected.

- If you wish to change the reference angle, enter a new value in the Ref. Angle entry box. 
(This value can also be changed in Object Info.)

- Click OK.

- Move the alignment line which is displayed to the desired location and click the mouse button
to align the selected points.



Aligning entire paths
To align two or more paths by selecting a reference point on each path:

- Select one point on each path you wish to align by holding down the Shift key and clicking on
each of them with the Point Selection tool or by dragging it across them.

- Double-click or hold down the Ctrl key and click the Align Diagonal tool.

- In the Diagonal Alignment Options dialog box, select the Average, Freehand, or Specify 
option, select the Move entire path option, and click OK.

- If the Freehand or Specify option was selected, move the alignment line which is displayed to
the desired location and angle and click the mouse button.

See Also
Point Selection tool

Align Horizontal tool

Align Vertical tool

Editing Paths with Object Info



Align Horizontal (Path Edit Palette)    

The Align Horizontal tool arranges selected control points along a horizontal line, allowing you to either 
place the points' new location freehand or let Flexi center them automatically. This tool can also align two 
or more paths.

Aligning points automatically
To align points to a horizontal line halfway between the selected points, centering them automatically:

- Select two or more points by holding down the Shift key and clicking each point with the Point
Selection tool. The points can be on the same path or on different paths.

- Click on the Align Horizontal tool.

NOTE If the cursor displays as a question mark or the paths move instead of just the points, the wrong 
option is selected. To change this setting, double-click or hold down the Ctrl key and click the 
Align Horizontal tool, choose the Average option, make sure the Move entire path option is not 
selected, and click OK.

Aligning points freehand
To align points horizontally by placing an alignment line:

- Select two or more points by holding down the Shift key and clicking each point with the Point
Selection tool. The points can be on the same path or on different paths.

- Double-click or hold down the Ctrl key and click the Align Horizontal tool.

- In the Horizontal Alignment Options dialog box, select the Freehand option, make sure the 
Move entire path option is not selected, and click OK.

- Move the alignment line which is displayed to the desired location and click the mouse 
button.

Aligning entire paths
To align two or more paths by selecting a reference point on each path:

- Select one point on each path you wish to align by holding down the Shift key and clicking on
each of them with the Point Selection tool or by dragging it across them.

- Double-click or hold down the Ctrl key and click the Align Horizontal tool.

- In the Horizontal Alignment Options dialog box, select either the Average or the Freehand 
option, select the Move entire path option, and click OK.

- If the Freehand option was selected, move the alignment line which is displayed to the 
desired location and click the mouse button.

See Also
Point Selection tool

Align Vertical tool

Align Diagonal tool



Align Vertical (Path Edit Palette)    

The Align Vertical tool arranges selected control points along a vertical line, allowing you to either place 
the points' new location freehand or let Flexi center them automatically. This tool can also align two or 
more paths.

Aligning points automatically
To align points to a vertical line halfway between the selected points, centering them automatically:

- Select two or more points by holding down the Shift key and clicking each point with the Point
Selection tool. The points can be on the same path or on different paths.

- Click on the Align Vertical tool.

NOTE If the cursor displays as a question mark or the paths move instead of just the points, the wrong 
option is selected. To change this setting, double-click or hold down the Ctrl key and click the 
Align Vertical tool, choose the Average option, make sure the Move entire path option is not 
selected, and click OK.

Aligning points freehand
To align points vertically by placing an alignment line:

- Select two or more points by holding down the Shift key and clicking each point with the Point
Selection tool. The points can be on the same path or on different paths.

- Double-click or hold down the Ctrl key and click the Align Vertical tool.

- In the Vertical Alignment Options dialog box, select the Freehand option, make sure the 
Move entire path option is not selected, and click OK.

- Move the alignment line which is displayed to the desired location and click the mouse 
button.

Aligning entire paths
To align two or more paths by selecting a reference point on each path:

- Select one point on each path you wish to align by holding down the Shift key and clicking on
each of them with the Point Selection tool or by dragging it across them.

- Double-click or hold down the Ctrl key and click the Align Vertical tool.

- In the Vertical Alignment Options dialog box, select either the Average or the Freehand 
option, select the Move entire path option, and click OK.

- If the Freehand option was selected, move the alignment line which is displayed to the 
desired location and click the mouse button.

See Also
Point Selection tool

Align Horizontal tool

Align Diagonal tool



Alignment (Contour Options) note



Alignment (Text Menu)    
Changes the arrangement of lines within a selected text block to Left, Center, or Right.    If no text is 
selected, all new text is created in the alignment chosen.    The text alignment can also be changed using 
the Text Specs command or Object Info.

To change the alignment of a text block, first select it by dragging one of the text tools over it or by
clicking it with the Arrow tool.    (To change the alignment for new text, make sure nothing is 
selected.)    Choose Alignment from the Text menu and then choose the desired option (Left, 
Center, Right) from the cascading menu.    When you release the mouse button, the text is 
changed.

NOTE If you use one of the text tools to select a partial block, the alignment still changes for the entire 
block.    To vary alignment, make separate text blocks.

To full justify text, so that it is aligned on both the left and right edges of the text block, use the Full
Justify command on the Text menu.

To change the alignment of graphic objects, use the Align command on the Arrange menu.

See Also
Preferences

Align

Text Specs 

Full Justify

Text Palette 

Object Info



Enter a value from 0 to 360 degrees to rotate the stripe counterclockwise. You can also change the angle 
by clicking and dragging within the preview.



Apply Angle (Path Edit Palette)    

The Apply Angle tool changes the angle of any control point or path segment to the current reference 
angle. You can also apply the reference angle using Object Info.

NOTE you cannot change the angle of a corner point (cusp) using the Apply Angle tool.

To change the angle of a control point or path segment to the current reference angle:

- Click on the control point or path segment with the Point Selection tool to select it.

- Click the Apply Angle tool.

- If a segment is selected and the cursor changes to a question mark, the Freehand option is 
selected. Click on one of the segment's endpoints in order to have that end stay fixed while 
the other one moves.

NOTE The Apply Angle tool can apply the reference angle from the center of a segment, so both 
endpoints move, or freehand, so you can click one end of a segment to make it stay in place 
while the other end moves. Double-click the Apply Angle tool to change these settings. (These 
settings also affect the Apply Ref button in Object Info.)

See Also
Point Selection tool

Apply Length tool

Editing Paths with Object Info



Apply Length (Path Edit Palette)    

The Apply Length tool changes the length of any path segment to the current reference length. You can 
also apply the reference length using Object Info.

To change the length of a path segment to the current reference length:

- Use the Point Selection tool to select the segment by either clicking on the middle of the 
segment or by holding down the Shift key and clicking each of its endpoints.

- Click the Apply Length tool.

- If the cursor changes to a question mark, the Freehand option is selected. Click on one of the
segment's endpoints in order to have that end stay in place while the other one moves.

NOTE The Apply Length tool can apply the reference length from the center of the segment, so both 
endpoints move, or freehand, so you can click one end to make it stay in place while the other 
end moves. Double-click the Apply Length tool to change these settings. (These settings also 
affect the Apply Ref button in Object Info.)

See Also
Point Selection tool

Apply Angle tool

Editing Paths with Object Info



Apply Style (Text Menu)    
Applies previously copied text attributes to the selection.

To apply a style to existing text, first copy the style of existing text using the Copy Style command.    Next, 
select the text to be changed using the Arrow tool or one of the text tools.    Choose Apply Style from the 
Text menu.    The text attributes of the selection change to the indicated style.

NOTE    Only text attributes can be copied as a style.    Color, shadows, outlines, etc., will not copy into the
style.    Also, styles only apply to the type of text from which they were copied.    Normal text 
styles apply only to normal text and arc text styles apply only to arc text.

See Also
Text Specs 

Copy Style

Text Palette 

Object Info



Arc Text (Text Palette)    

The Arc Text tool creates and edits arc text.    Normal text is edited using the Text tool.

Creating arc text
To create arc text using the Arc Text tool, click and drag the tool on the drawing area to specify the

size of the arc's radius and release the mouse button.    Type in the desired text.    When the 
text is entered, either click another tool to finish entering text or click the Text tool on the 
drawing area to create a new text block.

NOTE To specify the arc's diameter rather than its radius, hold down the Shift key while you drag.    To 
specify a 3-point circle, hold down the Ctrl key and click to place the first point.    Once the first 
point is placed, a line will extend from that point.    Release the mouse button and Ctrl key and 
click to place the second point, displaying a circular bounding extent, and then click to place the 
third point.

To create arc text using the Text Specs command, first click the Arc Text tool to select it and then 
choose Text Specs from the Text menu.

Editing arc text
To add characters to a block of arc text, click the Arc Text tool where you want to insert characters 

and begin typing.

To delete characters from a block of arc text, highlight them by dragging the Arc Text tool over 
them and either press the Delete key or choose the Clear command from the Edit menu.

To change the size or shape of text using the Arrow tool, click and drag one of the control points 
on the text block. 

To edit a block of arc text using Text Specs, click on it with the Arrow tool and then double-click it.   
The Arc Text Specs dialog box is displayed.

To edit part of a block of arc text using Text Specs, drag the Arc Text tool over the desired text to 
highlight it and choose Text Specs from the Text menu.

See Also
Text Specs 

Text tool



Arc Text Specs    
Allows you to create or edit arc text.    This dialog box contains the following options

Placement Icon    (Left icon)    When you click and hold the mouse on this icon, it pops out to 
display the three placement options.    These options determine which part of the text is 
placed on the arc    the baseline, center, or top.

Invert Icon    (Right icon)    When you click and hold the mouse on this icon, it pops out to display 
the two orientation options.    These options determine whether or not the text is inverted.

Radius  Changes the distance from the edge to the center of the circle.

Start Angle    Changes the point on the circle where the text should start.    This value is measured
in degrees, from 0-360.

Text Entry Box    Located at the bottom of the Text Specs dialog box.    Any selected text is shown
in this entry box, and can be changed or added to using standard text editing functions.    
(These functions include dragging or double-clicking    the insertion tool to highlight text and 
using the Delete key to remove it.)    This area does not    preview any of the text attributes.

Font    Changes the current typeface.    Using this list box, you can choose a font which was 
previously selected.    If the desired font is not listed, choose the Other option to display the 
Fonts dialog box.

Size    Changes the text height when a new value is entered in the entry box.

Alignment    Changes the arrangement of lines within a text block to Left, Center, or Right.    This 
option applies to the entire text block.

Line spacing    In multi-line text blocks, changes the amount of space between the baseline of the
upper line of text and the baseline of the lower line of text.    Click the Manual option to enter 
a specific distance; click Automatic to use the default spacing for the current font and text 
size.

Tracking    Changes the spacing between all characters in a text block.    Normal tracking is 0%.    
For wider spacing, enter a number between 1 and 99%; for narrower spacing, enter a 
number between -1 and -99%.    This option applies to the entire text block.    (To change the 
space between individual characters, use manual kerning.)

Stretch    Changes the percentage of distortion applied to the length of the text block.    To stretch 
the text, enter a number between 1 and 99%.    To compact the text, enter a number between 
-1 and -99%.    This option applies to the entire text block.

Slant    Changes the angle at which selected characters slant away from their default position.    
Negative values slant characters to the left; positive values slant them to the right.

See Also
Font

Size

Alignment

Kern

Text Palette 

Object Info



When Area Contour is selected, only the object's profile is contoured. In the example below, only the 
outside of the "0" is contoured.



When Area Contour with Holes is selected, the object's profile is contoured along with any holes in your 
object. In the example below, the contour is both outside and inside the "0."



Arrange Menu Commands    
Group

Ungroup

Make Compound

Release Compound

Align

Resize

Move

Nest

Spacing

Distribute on Path

Rotate

Mirror

Move to Front

Move Forward

Move to Back

Move Backward



Arrow (Cut Palette)    

In Cut mode, the Arrow tool selects panels and registration marks for editing and allows you to move them
around the drawing area.

NOTE When Flexi is in Cut mode, the Arrow tool cannot select objects in the design.    It can only select
panels and registration marks.

To select a panel or registration mark, first change to Cut mode by clicking the Cut Palette tool on 
the bottom of the Draw palette.    (Panels and registration marks are not displayed in either 
Draw mode or Paint mode.)    Select the Arrow tool and click it on the desired item to select it.

To move a panel, click the Arrow tool on the panel (not on a point) and drag it to the desired 
location.

To move a registration mark, click the Arrow tool on it and drag it to the desired location.

To resize a panel, use the Arrow tool to click and drag one of the square white control points on 
the panel.

To adjust the placement of page or strip divisions within a panel, use the Arrow tool to click and 
drag one of the small black control points on the division line.

To add a new dividing line to a panel, drag one of the small black points on an outside edge to the 
desired location.    For a horizontal dividing line, drag from the top or bottom edge; for a 
vertical dividing line, drag from the left or right edge.

To mark a page so it will not be cut, click the Arrow tool in the center of the page.    An X will 
appear across the page.    To remove the X, click the page again.

See Also
Cut palette

Registration Mark tool



Arrow (Draw Palette)    

In Draw mode, the Arrow tool selects, moves, and edits text or graphic objects.    This tool works 
differently for each of the mode palettes.

There are a number of ways to select text or graphic objects:

To select one object by clicking, click on the edge of it with the Arrow tool.    Once you see the 
object's control points, you can click anywhere on the object and drag to move it.

To select multiple objects by clicking, hold down the Shift key and click on the edge of each item 
with the Arrow tool.

To select by dragging, hold down the mouse button and drag the Arrow tool over any part of the 
object or objects to be selected.

To select part of a group of layered objects, hold down the Ctrl key and drag the Arrow tool to form
a box    around the desired objects.    Objects touched by the box which are not fully enclosed 
are not selected.

To drag an angled box to select, hold down the Alt key and drag a line at the desired angle.    
Release the Control key and continue dragging to enclosed the object in the angled box 
which appears.

To select a text block, click on it with the Arrow tool.

To select part of a block of normal text, hold down the mouse button and drag the Text tool over 
the desired characters.

To select part of a block of arc text, hold down the mouse button and drag the Arc Text tool over 
the desired characters.

To select a point or a segment on a path, click on it with the Point Selection tool. To select multiple
points, hold down the Shift key while clicking.

To select all of the text and graphic objects in the current sign, choose the Select All command 
from the Edit menu.

See Also
Select All

Text tool 

Arc Text tool

Point Selection tool

Arrow tool (Paint mode)

Arrow tool (Cut mode)



Arrow (Paint Palette)    

In Paint mode, the Arrow tool selects templates for editing and allows you to move them around the 
drawing area or resize them.

To select a template, first change to Paint mode by clicking the Paint palette tool on the Draw 
palette.    Once in Paint mode, click the template with the Arrow tool to select it.

To select a portion of a template, use either the Selection Rectangle or the Lasso tool.

To move a template, first select it with the Arrow tool as described above.    Once the template is 
selected, use the Arrow tool to click and drag it to the desired location.

To move a portion of a template, use either the Selection Rectangle or the Lasso tool.

To resize a template, either click and drag a corner of it or use the Scale Template tool.

See Also
Paint palette

Selection Rectangle

Lasso tool

Scale Template tool



Auto Layout    
Opens a new Flexi file using an existing Flexi file as a master.    Once the existing file has been selected, 
each text block can be replaced and formatted automatically.    The new file has the name "Untitled".

See Also
Open

Close

Exit



Autotrace Palette    
The Autotrace palette is a tear-off palette. It contains the tools used for the autotracing and PictureCut 
features. These tools are dimmed unless there is a template open.

Outline tool

Centerline tool

PictureCut tool



The baseline is the imaginary line on which all characters in a line of text are placed.    Descenders, the 
lower portion of characters such as p and y, extend below this line.



Bent Arrow (Label Palette)    

The Bent Arrow tool labels the selected area with a multi-segment arrow and the desired text.

To draw an arrow with multiple segments, select the Bent Arrow tool.    Enter the text and desired 
options in the Label Options dialog box (described below) and click OK.    Click the crosshair 
cursor on the drawing area to place the tip of the arrow and then drag the mouse until the first
segment of the arrow is the desired length and angle.    Click to place the segment.    Drag 
and click again to place each new arrow segment.    Press Return to finish the label.

To draw an arrow leading from a point directly to a text label, use the Straight Arrow tool.

To indicate the size of an object with two arrows, use the Horizontal Size tool, Vertical Size tool, or
Diagonal Size tool.

Label Options
Text Size    Height of the label text.

Arrow Length    Length of the arrow's head.

Arrow Width    Line width of the arrow.

Arrow Style    Shape and style of the arrow's head.

See Also
Straight Arrow tool

Horizontal Size tool

Vertical Size tool

Diagonal Size tool



A bitmap file contains images that are composed of pixels (dots) that are arranged in rows. Resizing a 
bitmap image affects its resolution.



Black Range and White Range. Use these two scales to selectively adjust the amount of black and white
in your image. When you increase the white, portions of your image that are close to white will lighten 
while the darker portions of the image remain unchanged. Likewise, when you increase the black, the 
darker portions of your image become black while the lighter sections are unaffected.



When bleed is checked, the printed area bleeds outside the cut line by the specified distance. This helps 
prevent unprinted space inside the cut line caused by imperfect registration.



Block Shadow    
Creates a block shadow around the selected text or graphic object.    A block shadow is stretched away 
from the original object, giving a 3-D effect to your sign.    You can create a block shadow by clicking and 
dragging the shadow in the preview display or by entering specific values for offset distance, angle, and 
depth.

The Block Shadow Options dialog box contains the following

Preview display    Shows the proportion of the specified shadow to the original object.    To 
change the shadow manually, move the cursor over this area until it changes into a Hand 
tool.    With the Hand tool, you can click and drag the shadow to any size or angle.    To 
change the angle of the shadow in 45° increments, hold down the Shift key while you drag.

Height,length    Shows the height and length of the original object.

Offset by percent    Measures the offset distance as a percentage of the total size of the original 
object.

Offset by size    Measures the offset distance in the default unit of measure, for example, inches.

Horizontal offset    Determines how far the shadow is placed to the left or right of the original 
object.    A negative value places the shadow to the left of the original object.

Vertical offset    Determines how far the shadow is placed above or below the original object.    A 
negative value places the shadow below the original object.

Angle    Determines the angle of the shadow from the original object, changing the shadow's 
horizontal and vertical offset at the same time.

Depth    Determines how far back the shadow is placed from the original object.    This value does 
not change the angle.

Relief    Determines how the shadow is cut out from the original object.    See Relief Options later 
in this topic.

Distance    When the offset or directional relief options are selected, determines the width of the 
space between the shadow and the original object.

Boundary shadow    Cuts out the inside of the original object, leaving an outline of the width 
specified in the Boundary thickness entry box. This option is only available when one of the 
following relief options is selected:    None, None with backing, Surround, or Offset surround.

Boundary thickness    When Boundary shadow is selected, specifies the width of the shadow's 
outline.

Color    Determines the color of the shadow.

Relief Options
None    Cuts out the shadow from the original object with no gap between that object and the shadow. 

None with backing    Does not cut out the shadow, but instead welds it with a duplicate of the original, so 
there are two layers of vinyl for the original object. 

Offset relief  Cuts out the shadow from the original object and offsets all adjoining edges by a specified 
distance.

Directional relief    Cuts out the shadow from the original object and offsets it from that object, taking into 
account the angle of the shadow from the original to create a 3-D effect. With directional relief, the 
distance specified by the user indicates the farthest distance the shadow will be offset from the original.

Surround    Places a shadow around all sides of the original object.

Offset surround    Reverse of offset relief. Cuts out the shadow from the original object and then widens 
it by a user-specified distance around all edges, surrounding the object.



Directional surround  Reverse of directional relief. Cuts out the shadow from the original object and then
widens it around all edges. The distance by which the shadow is widened varies according to the angle of
the shadow to the original object to create a 3-D effect.

See Also
Drop shadows

Cast shadows

Perspective shadows



Border (Shape Palette)    

The Border tool draws borders. Double-click this tool to choose options such as border style and corner 
radius.

To draw a border freehand, double-click or hold down the Ctrl key and click the Border tool.    Click
the Draw Freehand option.    Choose from the remaining options as described in the Border 
Tools Options section below and click OK.    Click on the corner of the intended border and 
drag to the opposite corner.    (To drag from the center, hold down the Ctrl key while 
dragging.)

To draw a border by specifying its size, double-click or hold down the Ctrl key and click the Border
tool.    Click the Specify Size option and enter the desired width and height.    Choose from the
remaining options as described in the Border Tools Options    section below and click OK.    
The cursor changes to a border of the specified size and style.    Click the Border tool once at 
the intended border's lower left corner.    (To indicate the center point, hold down the Ctrl key 
while clicking.)      Continue clicking to place more borders or click another tool to finish.

To create a circular border, draw two concentric circles using the Circle tool, select them both, and
choose the Make Compound command from the Arrange menu.

Border Tools Options
Style preview    Determines the border's border style, displaying the four basic options 

(Rectangle, Rounded Rectangle, Inverted Round Rect,and Slot), the 20 advanced borders 
which are included with Flexi, and any other borders which you have added to the border 
library.    Use the scroll box at the bottom of the preview to select a style. To scroll through the
border options automatically, click one of the black arrows at either end of the scroll bar. Click
the preview display to stop scrolling.

Add inner border    Determines whether or not a second border is placed within the first, making 
the border a line rather than a solid box.    Enter a value in the Spacing entry box to determine
the line's width.

Spacing    When the "Add inner border" option is on, determines the width of the border.

Draw Freehand    Allows you to click and drag to determine the size of the border.

Specify Size    Allows you to enter the desired width and height of the border.

Radius    Measures the corner radius of the border in the default unit of measure, for example, 
inches. Only available for Rounded Rectangle and Inverted Round Rect border styles.

Percent    Measures the corner radius as a percentage of the total length of the sides of the 
border. Only available for Rounded Rectangle and Inverted Round Rect border styles.

See Also
Make Compound

Circle tool



The border style determines the general shape of a border's corners.    The basic options are Rectangle, 
Rounded Rectangle, Inverted Round Rect, and Slot. Flexi also includes twenty advanced border options.



When you choose Bounding Box, the contour is rectangular with each side of the rectangle touching the 
outside edge of the object as in the example below.



Break Apart (Text Menu)    
Splits each line of a selected text block into a separate block, allowing you to edit each line differently.

To break apart a block of text, select the text block with the Arrow tool and choose Break Apart 
from the Text menu.

To join multiple text blocks into a single block, use the Join Together command.

See Also
Join Together



The brightness scale adjusts the luminosity of every pixel in the image. Moving the slider to the right 
increases the brightness while moving to the left decreases brightness.



Cyan, Magenta, Yellow, and Black (CMYK) is a color model based on the absorbing quality of ink printed 
on paper. Cyan, magenta, yellow, and black (CMYK) are the colors used in four-color process printing.



Click Cancel if you want to close the dialog box without making changes.



The Capacity entry boxes display the total amount each cartridge or ribbon can hold. This number does 
not change unless you type in a new number.



Capital height is the distance from the top to the baseline of a capital letter.



Case (Text Menu)    
Changes the case of selected text, providing the options UPPERCASE, lowercase, Title Case, Sentence 
case, and tOGGLE cASE.

To change the case of text, select it with the Arrow tool or one of the text tools. Choose Case from 
the Text menu and the desired case option from the cascading menu.

NOTE You can only use the Sentence case and Title Case options on text selected with the Arrow tool.

Case options
UPPERCASE changes all selected letters to uppercase.

Example:  abc def Ghi. abC becomes ABC DEF GHI. ABC

lowercase changes all selected letters to lowercase.
Example:  abc def Ghi. abC becomes abc def ghi. abc

Title Case changes the first letter of each selected word to uppercase and all the other letters to 
lowercase.

Example:  abc def Ghi. abC becomes Abc Def Ghi. Abc

Sentence case changes the first character of the text block and the first letter after each period in the 
text block to uppercase and all other letters to lowercase.

Example:  abc def Ghi. abC becomes Abc def ghi. Abc

tOGGLE cASE changes all selected uppercase letters to lowercase and all selected lowercase letters to
uppercase.

Example:  abc def Ghi. abC becomes ABC DEF gHI. ABc

See Also
Text Palette



Cast Shadow    
Creates a cast shadow from the selected text or graphic object.    A cast shadow starts from the base of 
the original object and stretches back away from it.    You can create a cast shadow by either clicking and 
dragging the shadow in the preview display or by entering specific values for offset distance, angle, and 
depth.

The Cast Shadow Options dialog box contains the following

Preview display    Shows the proportion of the specified shadow to the original object.    To 
change the shadow manually, move the cursor over this area until it changes into a Hand 
tool.    With the Hand tool, you can click and drag the shadow to any size or angle, rotating it 
360°.    To change the angle of the shadow in 45° increments, hold down the Shift key while 
you drag.

Height,length  (Below preview)     Shows the height and length of the original object.

Height    Determines the size of the shadow.    Height is measured as a percentage of the height of
the original object.    For example, if the height is 100%, the tops of the shadow and of the 
original object will line up.    To specify this value, either enter it in the entry box or click the 
scroll bar just below it.

Slant    Determines the angle of the shadow from the original object.    To specify this value, either 
enter it in the entry box or click the scroll bar just below it.

Relief  Determines how the shadow is cut out from the original object.    See Relief Options later in
this topic.

Distance    When the offset or directional relief options are selected, determines the width of the 
space between the shadow and the original object.

Color    Determines the color of the shadow.

Relief Options
None    Cuts out the shadow from the original object with no gap between that object and the shadow. 

None with backing    Does not cut out the shadow, but instead welds it with a duplicate of the original, so 
there are two layers of vinyl for the original object.

Overlap    Cuts out the shadow from the original object and overlaps the cut-out pieces over the original 
by a specified distance.

Offset relief    Cuts out the shadow from the original object and offsets all adjoining edges by a specified 
distance.

Directional relief    Cuts out the shadow from the original object and offsets it from that object, taking into 
account the angle of the shadow from the original to create a 3-D effect. With directional relief, the 
distance specified by the user indicates the farthest distance that the shadow will be offset from the 
original.

See Also
Drop shadows

Block shadows

Perspective shadows



Choose the way the image will be placed on the media from the centering menu. The choices are at 
origin, vertical center, or horizontal and vertical center.



Centerline (Autotrace Palette)    

The Centerline tool automatically traces each shape in a black & white template, placing editable paths 
down the center of each line in the image; includes an option to outline any areas which are wider than a 
specified width. Centerlining is excellent for producing neon patterns and routing and engraving paths.

Once a template has been traced, the resulting paths can be edited normally using the tools on the Path 
Edit Palette.

To trace a line down the center of the shapes in a template, first open a template using the Merge 
Bitmap command or scan in an image using the Scan command.    Select the Centerline tool. 
In the dialog box which is displayed, choose the desired options and click OK.    (These 
options are discussed in the following section, Centerline Tracing Options.)    Drag the 
Centerline tool's crosshairs from one corner of the area to be traced to the corner diagonally 
opposite it.    You can select all or part of the template.

To trace an outline around the shapes in a template, use the Outline tool.

To create special striping effects from the shapes in a template, use the PictureCut tool.

Centerline Tracing Options
Make Round Corners    When selected, automatically rounds all corners which are detected in 

the template.

Corner Detection    Determines how aggressively Flexi will detect corners when autotracing.

Setting Result
None Recovers no corners
Less Recovers fewer corners
Normal Default setting; recovers corners accurately for most templates
More Recovers maximum number of corners; for templates with very uneven edges

Tolerance    Determines how closely the template is followed during tracing.    A higher tolerance 
value follows the curve more loosely and therefore produces fewer points.    If you scanned in
the artwork at 300 dpi, you probably do not need to adjust this value.    If you scanned at a 
higher resolution (e.g., 600 dpi) or your artwork is of poor quality, you may wish to set a 
higher tolerance so the image is traced less precisely.

Outlining    Specifies that areas as wide or wider than the value in the Number of Steps box will 
outlined rather than centerlined.

Centerlining    Specifies that the template will be traced with a single line down the center of each
object in the template.

NOTE For combination centerline and outline autotracing, both the Outlining and Centerlining boxes 
must be checked.

Number of Steps    When the Outlining checkbox is selected, determines the minimum width of 
areas that will be outline traced.    This value is measured in pixels.    For example, you may 
wish that everything over 3 pixels wide be outline traced.

Closed Shape Separation    Creates a separate enclosed shape in each fully enclosed area.    
For example, in a picture of a circle in a square, two shapes would be traced, a square with a
circle cut out of its middle and a circle.

Restore Defaults    Changes all settings in the dialog box back to Flexi's standard settings.



See Also
Merge Bitmap

Scan

Point Selection tool

Path Edit Palette

Outline tool

PictureCut tool



Circle (Shape Palette)    

The Circle tool draws circles. Double-click this tool for options, including freehand, concentric, and three-
point circles.

To draw a circle freehand, click the Circle tool at one edge of the intended circle and drag it 
diagonally to the opposite edge.    (To drag from the center of the circle to an edge, hold down
the Ctrl key while dragging.)

NOTE If a circle appears on the drawing area as soon as you click, you need to choose to draw 
freehand.    Double-click or hold down the Ctrl key and click the Circle tool.    In the Circle Options
dialog box which is displayed, click the Draw Freehand option and click OK.

To specify the dimensions of one or more identical circles, double-click or hold down the Ctrl key 
and click the Circle tool.    In the Circle Options dialog box which is displayed, click the 
Specify option.    Enter the desired radius or diameter and click OK.    The dialog box closes 
and the cursor changes to an circle of the specified size.    Click on the drawing area at the 
desired location for the center of each circle.    Click another tool to finish.

To draw a 3-point circle, double-click or hold down the Ctrl key and click the Circle tool.    In the 
Circle Options dialog box which is displayed, click the 3 Point Circle option and click OK.    
Click the first point on an edge of the intended circle.    Drag the direction handle which 
appears to an opposite edge of the circle.    Drag the circular extent which appears until the 
circle is the desired size and click a third time.

To draw a set of concentric circles, double-click or hold down the Ctrl key and click the Circle tool. 
In the Circle Options dialog box which is displayed, click the Concentric Circles option and 
click OK.    Click the Circle tool at the point on the drawing area you wish to be the center of 
the circles.    Move away from the center and click to mark an edge of the second circle.    
Continue moving out and clicking until you have created the desired number of circles.    Click
another tool to finish.

TIP If you plan to move concentric circles, make sure that you select all of them first.    Each circle is 
a separate object which can be moved and edited independently of the others.    You may want 
to turn fills off using the Show Fills command or Show Fills tool so you can see each circle in 
relation to the others.

To create an oval, use the Oval tool.

See Also
Show Fills command

Oval tool

Show Fills tool



Circular Striping    
Adds stripes of varying widths to the selected object that fan out in a circular pattern from a specified 
center point.    You can choose to specify the gap between the rings, so it does not vary, or you can vary 
the gap width as well.

NOTE Any text which is striped is automatically converted to paths and can no longer be edited as text.

The Circular Stripe Options dialog box contains the following items

Preview display    Shows how the selection will look with the currently specified striping.

Invert    Reverses the colors of stripes and gaps, so stripes are shown in white and gaps are 
shown in color.

By percent    Measures the offset value and maximum ring radius as a percentage of the total 
object.    For example, if this option is selected, entering 100% in the Maximum ring radius 
entry box will place rings across the entire object, and 50% would place them across half of 
it.

By size    Measures the offset value and maximum ring radius using the default unit of measure 
(for example, inches).

Number of rings    Changes the number of rings (stripes) placed across the object.    (Unless 
Invert is selected, the rings are shown in color and the gaps are shown in white.)

Offset to first ring    Determines how far from the center of the selection the gaps will start.    (Use
the icons at the bottom of the dialog box to determine whether the gaps will get farther apart 
or closer from this point.)    Unless Invert is selected, gaps are shown in white and rings are 
shown in color.

Gradient up to    Determines the proportion of the total object which is made up of rings.

Gap percent    Determines the proportion of the total object which is made up of gaps.

Max ring radius    Determines the widest portion of the object to be striped, as measured from the
center to the edge of the rings.    When the option By percent is selected, this value is 
measured as a percentage of the total object.    When the option By size is selected, this 
value is measured using the default unit of measure (for example, inches).

Gradient direction icons    Click the left icon to make the rings get farther apart as they get 
farther from the center point.    Click the left icon to make them get closer together as they get
farther from the center point.

See Also
Even Striping

Gradient Striping

Radiant Striping



You can change the center of a circular gradient by entering a percent in the horizontal and vertical 
entry boxes. 



Clear (Edit Menu)    
Removes selection from your sign. The Delete key will also remove the selection.

See Also
Cut



Cleaver (Path Edit Palette)    

The Cleaver tool automatically splits a closed path into multiple closed paths.    This tool is especially 
useful if you have scanned in text and some of the characters are attached to one another.

NOTE To split an open or closed path into separate open paths, use the Scissors tool.

By dragging
- Using the Cleaver tool, click and drag a cut line across the selected object(s).

- Release the mouse button.    If any of the resulting paths have holes in them, such as the 
center of the letter P, they are automatically compounded.

By clicking
- Click the Cleaver tool near the first split point and click again on the other side of the path 

beside the second split point.

- Repeat the above step to split another segment or click another tool to finish. If any of the 
resulting paths have holes in them, such as the center of the letter P, they are automatically 
compounded.

See Also
Make Compound

Scissors tool



The Clipboard is an area in the computer's memory that functions as a holding place for what you last 
cut or copied. Information on the Clipboard can be pasted into your sign.



Close (File Menu)    
Closes the current file.    You are prompted to save any changes to the file.

Yes closes the file after saving any changes you have made since the last save.

No closes the file without saving any of your changes since the last save.

Cancel returns you to the file without closing it.

NOTE To discard all changes made since the last save without closing the file, use the Revert 
command.

See Also
Save

Save As

Revert

Exit



To hide the Color palette, click the close box with the Arrow tool.

To move the Color palette to another location, click on the gray drag bar beside the close box and drag it 
to the desired location.



Use the Windows Color dialog box to create new colors.

To create a new color:

1. Click the Color button. 

2. Move the crosshair in the color refiner box and the triangle beside the luminosity bar to define your 
color. 

or

Enter numbers in the Red, Green, and Blue or Hue, Sat (saturation), and Lum (luminosity) boxes. 
Your new color is previewed in the Color/Solid box.

3. Click OK.

The color you just created is displayed in the preview next to the Color button and is applied to the 
active triangle.



Click the Color Radio button if you want your image processed in four colors.

Click the Grayscale radio button if you want your image printed in grayscale.



Use this set of sliders to add or remove a color from the image in increments. You can drag the CMY/RGB
triangles to the left or right to adjust the color balance, or enter a value in the entry boxes. The color 
changes are applied separately to your image's midtones, highlights, and shadows.



Color Balance is used to remove or increase the quantity of a particular color in the printed image. To 
remove some of the blue from an image, increase the amount of yellow.



The Color boxes allow you to change the color of objects on your sign.

To change the color of an existing object, select it and then click on the desired color box.

To change the color in which new objects will be created, click on the desired color box when 
nothing is selected. This is called the active color; the current active color is displayed in the 
Fill Status box.

To see the name of a color, click its color box and hold down the mouse button. The name will pop
up.

NOTE If the corner of a color box is turned back, it is an invisible color.



Color Command Menu    
When you click the triangle on the Color palette and hold down the mouse button, the Color Command 
menu is displayed. To select one of the following commands, drag the mouse to highlight its name and 
then release the mouse button.

Color Specs    Displays the Color dialog box which allows you to rename, change, add, or delete 
colors on the Color palette.

Substrate Color    Displays the Color dialog box so you can change the color of the drawing area 
to match your substrate. (You can also do this by holding down the Ctrl key and clicking the 
desired color on the Color palette.)

Show All Colors    Displays all colors in the current sign, making all invisible colors visible.

Moved Used Down    Moves all of the colors you have used in your sign to the bottom of the 
Color palette so they are grouped together rather than scattered throughout the palette. (This
will not change the order in which the colors are layered.)

Define Gradient    Displays the dialog box used to add, delete, or rename gradient fills 
(FlexiSIGN-PRO only).

Define Pattern    Displays the dialog box used to add, delete, or rename pattern fills (FlexiSIGN-
PRO only).

Define Color Stripe    Displays the dialog box used to add, delete, or rename color stripe fills 
(FlexiSIGN-PRO only).

Return to Color Palette



Color Correction (Tools Menu)    
Use color correction to make minor changes to your bitmapped images. 

To open the Color Correction Options dialog box, select your bitmap, select Color Correction from the 
Tools menu, and drag the box around the area of your image you want to preview.

Click on any item in the dialog box below for more information.



Click the Scroll Down arrow to see colors which are lower on the Color palette.



Color Palette    
From the Color palette you can control the color of the substrate, the color of each object, the fill of each 
object, and the display of each color on your sign. This palette also controls the order in which color 
layers are displayed and cut in the Cut/Plot and Fill Plot dialog boxes. Each part of the Color palette is 
described below.

Close box and drag bar
Color Command Menu
Fill Box
Scroll Up

Color Boxes

Invisible Color

Scroll Down
Stretch box



The color preview displays the color (C,M,Y, or K) that you're editing.



Color Printer (Setup, Edit Menu)    
Allows you to create, modify, and delete printer setups on the displayed port setup or to select a different 
port for the port setup.

Click on any item in the dialog box below for more information.

Return to Setup
See Also
FlexiPRINT



Color Printer Options (FlexiPRINT)    
Click on any item in the dialog box for information.

Return to FlexiPRINT



The Stretch box on the Color palette allows you to change how much of the Color palette is displayed.

- To view more colors at one time, drag the Stretch box down with the Arrow tool.

- To view fewer colors at one time, drag the Stretch box up with the Arrow tool.



Color Stripe Options (Color Command Menu)    
Stripe fills are made by creating two or more color stripes of fixed width and repeating them.

Use the Color Stripe Options Dialog Box to create a new fill or to import a fill from the library.

Click on any item in the dialog box for a description. 

Return to Color command Menu

See Also
Gradient Fills

Pattern Fills



Color Trapping... (Tools Menu)    
Cuts away the overlapping area of selected objects, automatically creating an overlap to prevent white 
space between the objects when screen printing.    The color trapping feature uses the order in which 
colors are layered on the Color palette to determine whether objects will be choked or spread.

The Trapping Options dialog box contains the following items:

Choke/Spread Distance    Controls the amount of overlap between objects.

Correct Direction      Automatically changes the direction of affected paths so they are in the 
correct order.    When this option is selected, they will start on the inside with a clockwise 
path, alternating with counterclockwise paths from the inside out.

See Also
Combine

Stroke

Color Palette



Each color triangle represents a new color in the fill. To add a new color triangle, click the lower edge of 
the gradient bar, then click the Color button and choose your color.

When you click a color triangle, it becomes active. It is underlined and its color is displayed in the Color 
Preview. To create more or less of a color, click its triangle and slide it to the left or right. 

To delete a color, click the triangle and drag it below the line.

To change a color, click the triangle, then click the Color button and choose your new color.



Click the Scroll Up arrow to see colors which are higher on the Color palette.



ColorTrace (Outline, Autotrace Palette)    
The ColorTrace dialog box is displayed automatically whenever the Outline tool is used to trace a color 
template. The ColorTrace feature allows you to posterize and edit a color template and control how it will 
be traced.

ColorTrace Options
Preview display    Shows the selected area of the template to be posterized, edited, and autotraced. The 
ColorTrace tools and color editing tools are used to make changes within this area.

ColorTrace tools    These tools allow you to edit your template and view different portions of it before 
tracing:

Eyedropper

Magic Wand

Pencil

Zoom to Edge

Magnifying Glass

Previous View

Hand tool

Number of colors    Determines how many colors Flexi will use to posterize the template. The Original 
option displays the original template, deleting any posterizing or editing which you have performed during 
the current session.

Edge filter    Determines how aggressively Flexi will remove noise from the template when posterizing, 
especially along the edges.

Setting Result
None No noise is removed. This setting is good for templates with fine detail that is less than 2 

pixels wide, such as a stroke around an object.

Less Removes less noise than the Normal setting.

Normal Default setting. This setting removes most noise and keeps larger details.

More Removes more noise than the Normal setting.

Most Removes the maximum amount of noise. Good for templates with very uneven edges.



NOTE If you select Edge filter after selecting the Number of colors, you will need to select Number of 
colors again in order to posterize the image using the edge filter. Note that this will delete any 
changes you have made to the image since the last time it was posterized!

Display after tracing    Determines which template will be displayed on the drawing area after tracing.

Posterized template    Displays the posterized/edited template after tracing. To save this template, 
switch to Paint mode, choose Save As from the File menu, and give the template a new 
name.

Original template    Displays the original template after tracing. The posterized/edited template is 
lost.

CAUTION If you choose the Original template option, you will not be able to recover the 
posterized/edited template after tracing!

Trace with backing    Determines whether or not traced objects will be traced with a backing. The default 
is to trace all objects with a backing. If you turn this option off, every object will be cut out of the layer 
below it, with the exception of the background layer.

Corner detection    Determines how aggressively Flexi will detect corners when autotracing.

Setting Result
None Recovers no corners

Less Recovers fewer corners

Normal Default setting; recovers corners accurately for most templates

More Recovers more corners

Most Recovers maximum number of corners; for templates with very uneven edges

Round Corners    Automatically rounds all corners which are detected in the template.    Toggles with 
Sharp Corners.

Sharp Corners    Automatically makes all corners detected in the template sharp. Some round corners 
are traced as curve segments.

Tolerance    Determines how closely the template is followed during tracing.    A higher tolerance value 
follows the curve more loosely and therefore produces fewer points.    If you scanned in the artwork at 150
dpi, you probably do not need to adjust this value. If you scanned at a higher resolution (e.g., 300 dpi) or 
your artwork is of poor quality, you may wish to set a higher tolerance so the image is traced less 
precisely.

Preview color palette    Displays the colors created by posterizing the template and allows the user to 
select one or more colors for editing. This palette is blank until the Number of colors is selected.

Invisible color

Active color

Color editing tools    Allow you to edit colors selected in the preview color palette. To select one or more 
colors, click on each color's box in the preview color palette; each selected color is highlighted. To 
deselect a color, click it again. Use the following tools to edit selected colors:

Paint Bucket



Trash Can

Undo    Backs up editing changes one step.

Cancel    Closes the ColorTrace Options dialog box without tracing the template. All changes to the 
template are lost, even if the Posterized template option is selected.

OK    Closes the ColorTrace Options dialog box, traces the template with the specified colors, and adds 
any new colors to the Color palette.

NOTE To see the new colors on the Color palette, choose Move Used Down from the Color Command 
Menu.

See Also
Merge Bitmap

Scan

Scan and Trace

Point Selection tool



The ColorTrace dialog box's Hand tool pans the preview display in the direction in which the tool is 
dragged.



The ColorTrace dialog box's Magnifying Glass zooms in (magnifies the view) when you use it to click on 
an area or to drag a box around an area; it zooms out (reduces the view) when you use it to click on an 
area while holding down the Ctrl key.



ColorTrace Paint Bucket

The Paint Bucket in the ColorTrace Options dialog box has three functions:

- To fill an area with the active color, click on the area with the Magic Wand and then click the 
Paint Bucket.

- To replace all occurrences of a particular color in the template with the active color, first make
sure nothing is select with the Magic Wand. Next, click on the color to be replaced in the 
preview color palette. (Make no other colors are selected.) Click on the Paint Bucket to 
replace the selected color.

- To change the shade of one or more selected colors, select the color(s) by clicking on each of
them in the Preview color palette. (To deselect a color, click it again.) Double-click the Paint 
Bucket to display the Change Color Options dialog box, which allows you to adjust the HSB 
values of the selected color(s).. (Double-clicking a color box will also display this dialog for 
that color.) This dialog box's options are described below.

Change Color Options
Modified color display    Displays the new color with which all of the selected colors will be replaced.

Hue    Determines the color itself, e.g., red, green, or blue. To change the hue, either drag the triangle or 
enter a new value (0-100%) in the entry box.

Saturation    Determines the amount of the color in the specified hue; for example, for red, 50% would 
produce a pink and 100% would produce a fire-engine red. To change the saturation, either drag the 
triangle or enter a new value (0-100%) in the entry box.

Brightness    Determines the amount of white in the color, where 0% is black and 100% is white. To 
change the brightness, either drag the triangle or enter a new value (0-100%) in the entry box.

Color palette    Displays the colors currently included on the Color palette on the Flexi drawing area. Click
on one of these colors to apply it to the selected color(s).

Selected color    Displays the colors currently selected on the Preview color palette; all changes made in 
the Change Color Options dialog box will be applied to all of the selected colors. If more than one color is 
selected, they will all be merged into the single modified color shown in the upper left of the dialog box. To
merge two or more selected colors into one, click on the color in the Selected color palette that you wish 
to keep and then click OK to merge the colors, replacing all occurrences of the merged colors with the 
modified color.

Cancel    Closes the Change Color Options dialog box without making any changes.

OK    Closes the Change Color Options dialog box and applies the modified color shown in the upper left 
to all selected colors. If more than one color was selected, they are all merged into one color.

Return to ColorTrace topic



The ColorTrace dialog box's Pencil tool draws freehand lines in the active color.

- To draw a line in the active color, drag the Pencil tool on the preview display.

- To change the color of individual pixels, click the Pencil tool on each one.

- To change the width of the Pencil tool's line, double-click the Pencil tool and select the 
desired width from the Pencil Width dialog box.



The ColorTrace dialog box's Previous View tool returns the preview display to the last view of the 
template.



The ColorTrace Options Trash Can removes the color selected in the preview color palette and replaces 
all occurrences of it in the template with the color in the preview color palette with the nearest HSB (Hue, 
Saturation, Brightness) value.



The ColorTrace dialog box's Zoom to Edge tool zooms the preview to the edge of the template, showing 
the entire selection.



The active color in the ColorTrace Options dialog box is displayed with a triangle below it in the preview 
color palette. To make a color the active color,

- Click below its color box on the preview color palette (not on it)

or

- Click the Eyedropper on the color in the preview display

or

- Click the Magic Wand on the color in the preview display



An invisible color in the ColorTrace Options dialog box's preview color palette is displayed with its corner
turned back. An invisible color is not shown on the preview display and is not traced.

If Flexi defines a background color, it is automatically made invisible and placed to the far left of the 
preview color palette.



A row or column shift moves pattern rows horizontally or vertically by the percent specified in the entry 
box. You cannot shift both columns and rows.



Combine (Tools Menu)    
Joins two overlapping objects into one object.    This command provides up to five options:    Weld, Cut 
Out, Common, Exclude Common, and Mask.

Weld  Combines all overlapping areas of selected objects into one object, automatically deleting 
extra pieces.    (After welding, text becomes a graphic object.)    Before you can weld paths, 
they must be going in the same direction, with the outermost paths counterclockwise.    Using 
Combine Options, you can choose the 'Auto-direction' option to prepare the paths 
automatically.    You can also check paths using the Show Path Direction command on the 
Layout menu and change path direction using the Path Direction command on the Tools 
menu.

Cut Out  If two objects are selected by holding down the Shift key and clicking, removes selected 
overlapping areas from the first object selected and deletes the other selected object if 
specified. If two objects are selected by dragging, removes selected overlapping areas from 
the object on the lower color layer and deletes other selected object if specified.

Common    Deletes all of the selected objects except for the overlapping (common) area, which is 
then automatically welded into one object.

Exclude Common    Deletes the overlapping (common) area of overlapping objects and 
automatically compounds each of the remaining objects separately.

Mask    Combines two objects so they take the shape of one of the original objects. Deletes all of 
the first object selected except for the portion which overlaps the second object and cuts the 
first object out of the second object. (In other words, this option performs the Common option 
on the first object selected and Cut Out on the second object.) If the two objects are selected 
at the same time, the combined object will take the shape of the selected object on the higher
color layer.

NOTE    The Mask option is not available in FlexiLETTER.

Each of the above choices also has special options available.    Choose Options from the Combine 
cascading menu to display the Combine Options dialog box.

Combine Options
Selection menu    This list box determines how the selected objects will be combined.    The 

choices are Weld, Cut Out, Common, Exclude Common, and Mask.

Preview Display    Shows an example of the currently selected Combine choice.    (This does not 
show the objects you selected.)    Click the scroll bar below this display to see the other 
Combine choices.    The displayed choice is selected automatically.

Colors unchanged    (Cut Out, Mask)    If the selected objects are from the same color layer, this 
option keeps the color unchanged.    If they are from different color layers, the Cut Out and 
Mask options will keep the colors unchanged.    All other options (Weld, Common, and 
Exclude Common) will display an error message because the objects must come from the 
same color layer in order to be combined.

Color selection    (All choices)    Changes the color of the newly combined object.

Auto-direction    (All choices)      Automatically prepares paths for combining.    Ensures that paths 
go in the same direction and that the outermost paths are going counterclockwise.

Keep original object    (Cut Out)      Determines whether the second object is deleted after it is cut
out of the first object.

See Also
Show Path Direction



Path Direction



The Communications button displays all of the communications settings for the current setup.

Check your device's user manual to make sure that these settings are correct.



Contacting Product Support    
If you have any questions about how to use Flexi that you cannot answer by referring to this help or the 
manual, call our product support line. To answer questions about your computer or cutter, please contact 
your hardware dealer. Our product support personnel cannot answer questions concerning your 
hardware.

Before calling for help, look at the appropriate sections of the manual to try to solve the problem. If you 
still cannot find the answer you need, write down the following information before you call:

- User number found on the key

- Name and version of Flexi product

- Version of Windows system software

- Version of ATM (if applicable)

- Numbers of fonts installed (ATM and TrueType)

- Brand, model, and type of PC

- Amount of RAM installed

- Amount of free space on disk

- Type of video card

- Virtual memory setting

- Cutter/plotter model

- Scanner brand and model (except FlexiLETTER)

- Any memory-resident programs (TSRs) you may be using

- Other applications installed on your computer

NOTE The quick way to obtain most of this information is to select System Info from the Help menu in 
the upper right of your Flexi window.

Once you have gathered this information, call:

Amiable Product Support
Monday-Friday, 10 AM to 7 PM EST

Continental U.S.: (800) 229-9088
Outside the U.S.: (610) 521-6300

Fax: (610) 521-0111



Contents
FlexiFAMILY Help is designed for users of FlexiLETTER, FlexiSIGN, FlexiSIGN-Plus, and FlexiSIGN-
PRO. Every topic in FlexiFAMILY Help is marked with one or more icons to indicate which products 
include the feature discussed:

 FlexiLETTER

 FlexiSIGN
 FlexiSIGN-Plus

 FlexiSIGN-PRO
FlexiFAMILY Help is divided into the following major areas:

Menu Commands

Palettes

Object Info

System Requirements

Contacting Product Support



Contents (Help Menu)    
Displays the Contents topic for FlexiFAMILY Help. Use this topic to jump to any topic in FlexiFAMILY Help.



Contour button. If you're doing a contour cut job, you can set up the cut portion of your job from the 
Contour Options dialog box. See Contour for more information.



A contour is a closed path created around the object's border only. Holes are not traced separately in a 
contour as they are with an outline.



Contour (Tools Menu)    
Contour cutting is a production tool that helps you both print and cut your signs on vinyl.    Because you 
are printing and cutting, there are a number of steps involved in the process.

The following steps are involved:

1. Create an image to be printed.

2. Contour the object.

3. Set up print parameters in the FlexiPRINT dialog box. See below for the contour-specific features. 
See the FlexiPRINT dialog box for general information on setting up your printer.

4. Print the image.

5. Cut the image.

The Contour Option dialog box is used to create a contour line around an object. You can access this 
dialog box by selecting an object with the Arrow tool and choosing the Contour command from the Tools 
menu.

Click on any item in the dialog box below for more information.

You cannot make contours directly from bitmapped images, but there several ways to create contours 
from objects.
- Contour a PhotoMask
- Create an object the same shape and size as the bitmap, place it over the bitmapped image and then 
contour the object.
- Draw a contour using the Contour color on the Color palette. If the Contour color is not available in your 
Color palette, you can open the Color Specs dialog box and create a new color named Contour.

Once your Contour is created, you can complete the FlexiPRINT dialog box. The following items are 
important to Contour cutting:

Offsets. The default value is 0.5 inches. You may want to increase the offset so that the rollers of your 
vinyl cutter do not overlap the printed material.

Registration marks. Make certain the correct registration mark is selected.

 The default registration mark for contour cutting. Marks are at the corners of the bottom edge.

 Places registration marks at the corners of the left edge.



 Use this registration mark if you have a Summagraphics cutter with an OPUS head.
Copies. If you are printing many copies of your item, you can enter a value in the Copies entry box. Using
this option can save time because only the first item is rasterized.
Contour Option Dialog Box.

You can choose a cutter and specify cutter parameters from this dialog box. 

Click on any item in the dialog box below for more information.

4. Print Your Contour
Once the FlexiPRINT and Contour Option dialog boxes are complete, you can send your job to print. If 
you need help printing your job, see FlexiPRINT.
5. Cut Your Contour
The process of cutting your contour is controlled from Production Manager. 
a. Open the Production Manager window. 

b. Make certain the cutter you chose in the Contour Option dialog box is displayed in the Setup list box.

c. Select the file you wish to contour.

d. Click the Release button. 

e. Choose an alignment method: Interactive (Manual) or Digital (Bomb Sight).

f. You will be prompted by a series of dialog boxes to align and cut your job.



When you Contour Offset, the contour is placed outside the object by the specified amount of space. 
This produces an unprinted area inside the cut line. Offset can be used in conjunction with Area contour, 
Area contour with holes, and with Bounding box.



The preview displays an example of each of the contour/bleed options.



The Contrast scale is used to increase or decrease the difference between the light and dark areas 
throughout the image.



Use the contrast scale to increase or decrease the difference between the light and dark areas of the 
printed image.



A control point is a small handle which appears on a selected object:

- A compounded object displays a group of nine control points on and around the object.

- An uncompounded path can display the following control points, each of which contain 
information about the shape of the path:

- Unselected control point:    Small empty point on a segment's endpoint. If the segment before 
the point is a curve, the control point is round; if it is a straight line, it is square.

- Selected control point:    Small filled point on a segment's endpoint. If the segment before the 
point is a curve, the control point is round; if it is a straight line, it is square.

- Segment control point:    Large filled circle on a segment's midpoint.

- Start point:    Control point on a segment's endpoint which is slightly larger than a regular 
control point and smaller than a segment control point. On an open path, this point must be at
one of the ends of the path. This control point can be dragged for reshaping the same as any 
control point.



Convert to Paths (Tools Menu)    
Changes selected text or graphic objects into compounded paths.

NOTE To edit text or graphic objects which have been converted to paths, select the objects and 
choose the Release Compound command from the Arrange menu.    Most of the Path Edit tools 
will not work on compounded objects!

See Also
Release Compound

Show Path Direction

Path Direction



Enter the number of copies of your image to be printed.



Copy (Edit Menu)    
Copies the selection to the Clipboard.    The selection can then be placed in a new location using the 
Paste command.

To drag a single copy of the object to a new location, hold down the Ctrl key and drag the center 
control point to the object's new location.

To immediately place a copy of the selection below the original, select the object(s) with the Arrow 
tool and choose the Duplicate command.

To make multiple copies of the selection, use the Step & Repeat command.

See Also
Cut

Paste

Duplicate

Step & Repeat



Copy Style (Text Menu)    
Copies the text attributes of the selection into Text Specs.    These attributes will be applied to any new 
text you create automatically, or you can apply them to existing text using the Apply Style command.

To copy a text style, use the Arrow tool or one of the text tools to select existing text with the desired 
attributes.    Then choose Copy Style from the Text menu.

NOTE Only text attributes can be copied as a style.    Color, shadows, outlines, etc., will not copy into 
the style.    Also, styles only apply to the type of text from which they were copied.    Normal text 
styles apply only to normal text and arc text styles apply only to arc text.

See Also
Text Specs 

Apply Style

Text Palette 

Object Info



You can control the amount of space between copies by entering a measurement in the copy spacing 
entry box.



The corner radius is the radius of a hypothetical circle drawn in each corner of a rectangle.    This value 
determines the corner size for Rounded Rectangle and Inverted Round Rect border styles.    The larger 
the corner radius, the rounder the corner.



The Current fills are those available on your Color palette.



A curved segment on a path can be reshaped by dragging the segment itself or its direction handles. To 
change a curved segment into a straight segment, click on the Straight segment icon in Object Info.



The Custom list box contains three sets of commands: Start commands, Stop Commands, and Action 
Commands.



Cut (Cut Palette)    

The Cut tool controls the cut/plotting process.    You can also cut/plot using the Cut/Plot command.    Use 
the Cut tool or Cut/Plot command to cut a sign or to pen plot its outlines.

NOTE To pen plot a sign with solid fills, use the Fill Plot tool.

Cut Mode
In Cut mode, you can cut/plot using either the Cut tool or the Cut/Plot command.

To cut panels which you have created and/or edited manually, select them with the Arrow tool 
before    clicking the Cut tool or choosing the Cut/Plot command.

To automatically panel and cut the entire sign, click on a blank portion of the drawing area before 
clicking the Cut tool or choosing the Cut/Plot command.    Warning:    If you do this, Flexi will 
ignore any panels you already prepared!

Draw Mode
In Draw mode, you can only plot by using the Cut/Plot command on the File menu.

To cut selected objects, hold down the Shift key and click on the objects with the Arrow tool before
choosing the Cut/Plot command.

To automatically panel and cut the entire sign, click on a blank portion of the drawing area before 
choosing the Cut/Plot command.

For more information about the Cut/Plot dialog box, see Cut/Plot options.

See Also
Cut/Plot

Cut palette

Arrow tool

Fill Plot tool



Cut (Edit Menu)    
Removes the selection from your sign and copies it to the Clipboard.    The selection can then be placed 
in a new location using the Paste command.

See Also
Copy

Paste

Clear

Duplicate



Cut Palette    

The Cut palette is a mode palette.    It contains the tools used to panel, plot, or cut your sign. When Flexi 
is in Cut mode, all objects are displayed with fills off and only panels and registration marks can be 
selected or edited.

Arrow tool

Panel tool

Multicolor Panel tool

Registration Mark tool

Cut tool

Fill Plot tool

FlexiPRINT tool

Draw Palette



Cut/Plot... (File Menu)    
Cut/plots the current sign from either Draw mode or Cut mode.

Draw Mode
To cut selected objects, hold down the Shift key and click on the objects with the Arrow tool before

choosing the Cut/Plot command.

To automatically panel and cut the entire sign, click on a blank portion of the drawing area before 
choosing the Cut/Plot command.

Cut Mode
To cut panels which you have created and/or edited manually, select them before    choosing the 

Cut/Plot command or clicking the Cut tool.

To automatically panel and cut the entire sign, click on a blank portion of the drawing area before 
choosing the Cut/Plot command or clicking the Cut tool.    Warning:    If you do this, Flexi will 
ignore any panels you already prepared!

Cut/Plot Options
Setup selection menu    Lists all plotters set up using the Setup command. Use this menu to 

change the current device; Windows for Workgroups users can also choose a different 
Production Manager.

Custom menu    Contains special commands for the currently selected device, divided into three 
types of commands:

- Start:    Sent at the start of the job, for example, Cut fast, Pen plot

- End:    Sent at the end of the job

- Custom:    Sent immediately to configure plotter, e.g., blade number, pressure

Cut to    Controls where each plotting job goes:

- Send Now:    Sends the job to Production Manager and places it on ready status. (If you 
are working on a network, this command is not always available.)

- Save to file:    Saves the job to a file that can be plotted later using the Add Cut Job 
command in Production Manager. (If you are working on a network, this command is not 
always available.)

- Hold in Queue:    Sends the job to Production Manager and places it on hold.

Preview area    Shows all pages to be cut in current color layer; click the scroll bar to see 
additional pages. The current page is surrounded by a solid line, all others have a dotted line.
Pages that have been turned off are dimmed and moved to the end. Once the page is cut, it 
is turned off automatically.

Current page    The page currently selected for cutting; click on a page to select it. If interactive 
plotting is on, double-click a page or click the Show Me button to move the pen/knife around 
the border of the first page without cutting it.    The box in the upper left corner of each page 
controls whether or not the page is cut; an X in this box indicates that it will not be cut. Click 
in this box to turn the page on or off; once the page is cut, it is turned off automatically.

Color selection bar    Controls color layers to be plotted or cut; click on a color to select that layer
for plotting. To make a check plot with all layers plotted at once (in one color), click the 
triangle on top of the color selection bar and choose Plot all colors from the menu which is 
displayed. Colors can be turned off    by pressing the Shift key while clicking them and turned 
on again by selecting Show all colors from the Color selection bar menu.



Mirror    Cuts all panels in reverse; useful for cutting signs that will be applied to the inside of 
windows.

Rotate    Rotates all panels 90° on the media when cutting them.

Offset    Changes how far each page is shifted horizontally or vertically from the plotter’s origin 
(lower left of preview window).

Advance after plot    Moves the media forward and resets the origin after the plot is complete.

Interactive    Moves the blade on the cutter as you move the page on the preview display, 
allowing you to see exactly where it will be placed on the media.    Not all plotters support this 
feature.

Weeding border    Cuts a border around each panel, making it easier to weed. This option also 
cuts horizontal lines between strips.    The margin of this border is specified using the Plotter 
Options dialog box.

Easy Weed    Cuts a weeding border around each object or character on your sign which is as 
large or larger than the minimum size.    The margin of this border is specified using the 
Plotter Options dialog box.

Copies    Specifies how many copies to cut of each page

Options    Displays the Plotter Options dialog box.

Show Me button    Moves the pen/knife around the border of the first page without cutting it.

Poll Size button    For plotters that support interactive cutting, returns information on the actual 
height and length of the currently loaded media and displays it above the preview display.

Done button    Finishes the current plotting session by closing the Cut/Plot dialog box.    This 
button changes to Abort while the job is being plotted.

Cut button    Sends the pages in the current color layer to the destination indicated in the Cut to 
list box.

See Also
Plotter Options

Setup

Cut Tool



Choose a cutter from this list box. Your printer and cutter must be connected to the same Production 
Manager.



Clicking the Default button returns all settings in the RIP Options dialog box to the default setttings for the
current color printer, media, and ink.





The Default button returns the Dots/ml setting to its default and adjusts the % ink remaining in cartridge 
entry box to match the new setting.



Define Kerning... (Text Menu)    
Specifies the spacing between pairs of characters in a font and maintains that information in    Flexi's font 
table. Once you have defined kerning pairs for a font, they will display as specified every time you use 
that font in Flexi.

You can choose to define a font's kerning either by entering an entire string of characters and defining the
kerning for each pair of letters in the string or by entering pairs of characters and defining kerning pair by 
pair. A string can be either an existing text block selected before choosing the Define Kerning command, 
or can be entered directly in the Define Kerning Pairs dialog box. 

NOTE The kerning pairs are stored in a separate location in Flexi, so they do not affect the fonts in 
other applications, such as word processors.

The Define Kerning Pairs dialog box contains the following options:

Mode: Determines how you will define kerning:

String: Defining kerning within a string (either existing or entered in the preview)

Pair: Pair by pair, using the Pair entry boxes below the preview

TIP The simplest way to define kerning pairs is to select a text block in your sign and then choose 
Define Kerning from the Text menu. The text block is displayed in the preview and the String 
entry mode is selected automatically.

Font: This list box determines a font family for which you are defining kerning pairs. The kerning 
pairs are defined only for the selected style, not for the entire font family.

Style: This list box determines the style of the font for which you are defining kerning pairs.

Font format icon: Indicates the format of the selected font family, either TrueType or PostScript 
Type 1.

Kerning Pairs: This list box shows all of the kerning pairs defined for the selected font family and 
style, including any kerning pairs defined by the font manufacturer. Click in the scroll bar to 
the right of this list to view additional kerning pairs.

Preview display: Displays the pair or string for which kerning is being defined and allows you to 
edit the pair by dragging either character. When the Show bounding box option is selected, a 
blue bounding box is shown around the first character in the pair and a red bounding box is 
shown around the second character in the pair. When the String entry mode is selected, you 
can also enter the string directly into this display.

Delete pair: Deletes the kerning pair selected in the Kerning Pair list box and returns to the 
default setting for that pair. To delete a pair, choose the Pair entry mode, click on the desired 
kerning pair in the list box, and click the Delete Pair button.

Number of pairs: Displays the total number of pairs defined for the selected font and style.

Format: This list box determines which format you will use when entering the kerning pair 
characters. The following options are available:

char: Accepts characters as they are normally typed at the keyboard

hex: Accepts characters in hexadecimal code

dec: Accepts characters in decimal code

Pair:    When the Pair mode is selected, these entry boxes allow you to enter the kerning pair to 
be defined. Type the first character in the left entry box, press Tab, and type the second 
character in the right entry box.

em space: Determines the spacing of the current kerning pair. To change the spacing of the 
kerning pair, enter a new value (in 1/1000 of an em space) in this entry box or click the up or 



down arrows to the right. Spacing can also be changed by dragging the characters in the 
preview display. The value in the entry box changes to reflect this.

Show character bounding box:    When this option is selected, the preview display shows a blue
bounding box around the first character in the pair and a red bounding box around the 
second character in the pair. These boxes are defined by the font manufacturer and cannot 
be changed.

Save: Saves all of the kerning pair changes made in the current session.

Revert: Deletes all changes made to the kerning pairs since the last time you saved.

Done: Closes the Define Kerning Pairs dialog box, ending the current editing session. If any 
changes were made since you last saved, you are prompted to save them.

See Also
Kern

Text Specs

Text Palette

Object Info



Click the Delete button to cut the active fill.



Delete Control Point (Path Edit Palette)    

The Delete Control Point tool deletes selected control points from uncompounded paths.

NOTE If you cannot select a single point, the path may be compounded.    To correct this, choose 
Release Compound from the Arrange menu.

To delete one point at a time, select the Delete Control Point tool, click on the path to be edited so 
the points are displayed, and then click on the point to be deleted.    To delete more points, 
continue clicking them with the Delete Control Point tool.    To stop deleting points, click 
another tool.

To delete several points at once, hold down the Shift key and click on them with the Point 
Selection tool.    (A point turns solid black when it is selected.)    Once all of the desired points 
are selected, press the Delete key to delete them.

To automatically delete extra control points from a curved segment, use the Optimize Curve tool.

To automatically delete extra control points from an entire open or closed path, use the Reduce 
Points tool.

See Also
Release Compound

Point Selection tool

Optimize Curve tool

Add Control Point tool

Reduce Points tool



The Delete Setup button removes the currently displayed setup from the port setup.



The Delete ink button deletes the ink that is currently displayed.



The Delete media button deletes the media type that is currently displayed.



The Delete size button deletes the size which is currently displayed.



The Device list box allows you to choose a device for a new setup or change the device for an existing 
setup.



Diagonal Size (Label Palette)    

The Diagonal Size tool labels the diagonal dimensions of the selected area with two arrows and the 
desired text.

To label the diagonal dimensions of an area or object, select the Diagonal Size tool.    Click the 
crosshair on the first of the two points to be labeled and drag to the second point.    Enter the 
text and desired options in the Label Options dialog box (described below) and click OK.    
Move the mouse to change how far the label is from the object or where the label is placed in
relation to the dimensioning lines.    (The label can be outside or inside the lines.)    Once you 
are satisfied with the label's placement, click on the drawing area to finish it.

To draw an arrow leading from a point directly to a text label, use the Straight Arrow tool.

To draw an arrow with multiple segments, use the Bent Arrow tool.

To label the horizontal dimensions of an area or object, use the Horizontal Size tool.

To label the vertical dimensions of an area or object, use the Vertical Size tool.

Label Options
Label Text    Text to be entered on the drawing area. Automatically displays the distance you 

dragged to create the label.

Text Size    Height of the label text.

Arrow Length    Length of the arrow's head.

Arrow Width    Line width of the arrow.

Arrow Style    Shape and style of the arrow's head.

See Also
Straight Arrow tool

Bent Arrow tool

Horizontal Size tool

Vertical Size tool



The diameter is the distance from one edge of a circle to the other at its widest point.



You can use the digitize (bomb sight) method if your cutter supports it. This only works on serial 
devices.



Digitize (Path Create Palette)    

The Digitize tool draws paths freehand or from a template using a mouse or digitizing tablet.    You can 
also double-click the Digitize tool to display a dialog box which displays additional options, including 
setting up a digitizing tablet.

Drawing paths
Using the Digitize tool, you can create a variety of different segments.    You select the type of segment 
you wish to create by typing the appropriate letter on the keyboard.    The options are listed below; to 
change the key assignments, see the next section, Digitize Tool Setup Options.

Straight line segment    Click at the start and end point of each segment.    To change to a 
straight line from another segment type, type l.

Arc    Type a, click the starting point, move the mouse until the arc is the desired size and shape, 
and then click the end point.

Curved line segment  Type c and click to place each curve point.

Constrain the cursor    To limit placement of new segments to horizontal, vertical, or diagonal 
angles in 45° increments, type m.

Undo last segment    Type u.

Close the path    Type e.

End the path    Press Return.

Digitize Tool Setup Options
Double-click or hold down the Ctrl key and click the Digitize tool to display the Digitize Tool Setup dialog 
box.    This dialog box provides the following options

Use Tablet    When this option is on (checked), the Digitizing tool can be used with the currently 
selected digitizing tablet.    When it is off (unchecked), it can only be used with a mouse.

Double-Line Digitize  Use this option to create a wider line.    Creates a closed path with a width 
that totals the Left and Right Distance values.    As you draw the line, the Left Distance is 
added to the left of the line and the Right Distance is added to the right of the line.    When 
you end the path, it is closed automatically.

Distance, Left    When Double-Line Digitize is selected, this width is added to the left side of the 
line.

Distance, Right When Double-Line Digitize is selected, this width is added to the right side of the 
line.

Tablet Settings    When Use Tablet is selected, this button displays the Tablet Setup dialog box 
described below.

Key/Button Settings    Displays the Key Assignments dialog box, which allows you to change the 
key stroke assignment for each type of path segment.    (See previous section on drawing 
paths.)

Cap Style    Determines how the end of each path drawn using the Digitize tool will be shaped.    
Click the button next to the desired option to select it.

Joint Style    Determines how the corner of each path drawn using the Digitize tool will be shaped.
Click the button next to the desired option to select it.



Tablet Setup
To set up a digitizing tablet, double-click or hold down the Ctrl key and click the Digitize tool to display the 
Digitize Tool Setup dialog box.    Click the Tablet Settings button to display the Tablet Setup dialog box.    
This dialog box contains the following options

Tablet    Allows you to select your digitizing tablet's brand and model number.

Buttons    Allows you to select the number of buttons on your tablet's puck.

Button Click Sound    Determines whether Flexi will make a clicking sound every time you click 
on the tablet.

Communications    Displays the standard communications dialog box, which includes options 
such as port selection.

See Also
Pen tool

Point Selection tool



Each direction handle on a control point controls the height and roundness of the curved segment next 
to it. The length of the handle determines the height of the curve; the angle of the handle determines its 
roundness.



Distort... (Tools Menu)    
Reshapes selected text and graphic objects to a specified shape.

When you click Go in the Distortion Options dialog box (described below), the bounding box of the 
selected distortion is displayed over the object.    You can drag the control points on this bounding box to 
reshape the distortion.    The exceptions to this are the cylinder and perspective distortions, which display 
a dialog box with scroll bars which you can drag to increase or decrease values.    Once you are satisfied 
with the shape of the object, press Return to apply the distortion.

NOTE The Distortion command converts text to paths automatically.

The Distortions Options dialog box contains the following items

Selection menu    (Top left)      Specifies which distortion envelope will be applied to the object.

Distortion icons    Specifies which distortion envelope will be applied to the object; to choose a 
distortion here, click on the desired picture. Click the scroll bar below the icons to see more 
options.

Vertical distortion only    Keeps vertical lines in the object perpendicular to the baseline.

Vertical and horizontal distortion    Adjusts the vertical lines within the object to follow the curve 
of the distortion.

Preview display  (Upper right)      Shows an example of the selected distortion.    Click in the scroll
bar below it to view/select other distortions, or click one of the black arrows to scroll 
automatically.

Do not bend straight lines    Forces all horizontal and vertical lines in the object to stay in place.   
This option is not recommended for round or curved options such as Arch or Fish.

Preview    After you press OK, this option shows a full preview of the distorted object rather than 
just a bounding box.    Note    It takes longer to reshape the distortion when this object is 
selected.

See Also
Path Edit Palette



Distribute on Path (Arrange Menu)    
Arranges selected text or graphics along a specified path.

NOTE    When text is distributed on a path, it is automatically changed into a graphic.    It cannot be edited 
or formatted as text.

To distribute text or graphic objects along a path, select the items to be distributed, choose 
Distribute on Path from the Arrange menu, and click on the point on the path where you want 
the items to begin.    (If the selection flows the wrong way along the path, Undo and then use 
the Path Direction command to reverse the direction of the path.    Once this is done, try 
again to distribute on the path.)

To create arc text, use the Arc Text tool.

To create an open path (line), draw it using the Pen tool or Digitizing tool.

To create a closed path, draw a shape with one of the tools on the Shape palette, select it, and 
choose the Convert to Paths command from the Tools menu.

To change an open path into a closed path, use the Join Points tool.

See Also
Undo

Convert to Paths

Path Direction

Arc Text tool

Pen tool

Digitize tool

Join Points tool



The dot pattern used in color printing is controlled by the dither type. You can choose from five dithering 
types, although we suggest you use the default type that is customized for the printer you've selected.



Click Done to close the dialog box. All the changes you made are saved, even if you do not print.



Dot gain controls the amount of ink that is laid down when printing. 



The Dots/ml entry box displays the number of dots printed for every milliliter of ink. Changing this 
number permanently changes Flexi's ink usage formula for this color. Any changes made to this entry box
are automatically reflected in the percent ink remaining in cartridge entry box (unless there is 100% 
remaining).



Draw Palette    

The Draw palette is a mode palette. It contains all of the tools you need to design your sign.

Arrow tool

Text palette    (Text tool shown)

Path Create palette    (Pen tool shown)

Path Edit palette    (Point Selection tool shown)

Shape palette    (Rectangle tool shown)

Autotrace palette    (Outline tool shown)

Label palette    (Measure tool shown)

Paint palette

Cut palette

NOTE FlexiLETTER does not include the Paint palette.



Drawing Size... (Layout Menu)    
Allows you to change the size of the drawing area for the current sign.    Generally, the drawing area 
should be the same size as the substrate on which you plan to mount your sign or as the area on which it 
will be mounted.    The drawing area serves as a guide, showing you the size of the sign, but allowing you 
to create text and graphics which extend beyond it.

The Drawing Size dialog box contains the following items:

Preview display (On left side)    Shows the overall proportion of the sign with the current 
substrate height and length.

Substrate height    Height of the drawing area (measured from top to bottom).

Substrate length    Length of the drawing area (measured from left to right).

See Also
New

Resize



Clicking the Driver Options button displays a set of custom options for the active printer. Each printer has
its own set of driver options.



Drop Shadow    
Creates a drop shadow around the selected text or graphic object.    A drop shadow is a copy of the 
original object which is offset from it in order to make it stand out in the design.    You can create a drop 
shadow by either clicking and dragging the shadow in the preview display or by entering specific values 
for offset distance, angle, and depth.

The Drop Shadow Options dialog box contains the following

Preview display    Shows the proportion of the specified shadow to the original object.    To 
change the shadow manually, move the cursor over this area until it changes into a Hand 
tool.    With the Hand tool, you can click and drag the shadow to any angle.    To change the 
angle of the shadow in 45° increments, hold down the Shift key while you drag.

Height, length    Shows the height and length of the original object.

Offset by percent    Measures the offset distance as a percentage of the total size of the original 
object.

Offset by size    Measures the offset distance in the default unit of measure, for example, inches.

Horizontal offset    Determines how far the shadow is placed to the left or right of the original 
object.    A negative value places the shadow to the left of the original object.

Vertical offset    Determines how far the shadow is placed above or below the original object.    A 
negative value places the shadow below the original object.

Angle    Determines the angle of the shadow from the original object, changing the shadow's 
horizontal and vertical offset at the same time.

Depth    Determines how far back the shadow is placed from the original object.    This value does 
not change the angle.

Relief    Determines how the shadow is cut out from the original object.    See Relief Options later 
in this topic.

Relief distance    When the offset or directional relief options are selected, determines the width 
of the space between the shadow and the original object.

Boundary thickness    When the offset boundary option is selected, determines the width of the 
shadow's outline.    When the relief boundary option is selected, also determines the width of 
the original's outline.

Color    Determines the color of the shadow.

Relief Options
None    Cuts out the shadow from the original object with no gap between that object and the shadow. 

None with backing    Does not cut out the shadow, but instead welds it with a duplicate of the original, so 
there are two layers of vinyl for the original object.

Overlap    Cuts out the shadow from the original object and overlaps the cut-out pieces over the original 
by a specified distance.

Offset relief  Cuts out the shadow from the original object and offsets all adjoining edges by a specified 
distance.

Directional relief    Cuts out the shadow from the original object and offsets it from that object, taking into 
account the angle of the shadow from the original to create a 3-D effect. With directional relief, the 
distance specified by the user indicates the farthest distance the shadow will be offset from the original.

Offset surround    Reverse of offset relief. Cuts out the shadow from the original object and then widens 
it by a user-specified distance around all edges, surrounding the object.

Offset boundary    Similar to offset relief, which cuts out the shadow from the original object and offsets 



all adjoining edges by a specified distance.    However, this option also cuts out the inside of the shadow, 
leaving an outline of the width specified in the Boundary thickness entry box.

Relief boundary    Similar to offset boundary, except that this option also cuts out the inside of the 
original, leaving an outline of the width specified in the Boundary thickness entry box.

See Also
Block shadows

Cast shadows

Perspective shadows



Duplicate (Edit Menu)    
Places a copy of the selection below and to the right of it.

To drag a single copy of the object to a new location, hold down the Ctrl key and drag the center 
control point to the object's new location.

To make multiple copies of the selection, use the Step & Repeat command.

To place a copy of the selection on the Clipboard, select it with the Arrow tool and then choose 
either the Cut or Copy commands. Use the Paste command to place a copy of the selection 
on your sign.

See Also
Cut

Copy

Paste

Step & Repeat



When you click Duplicate, you create a copy of the currently displayed pattern. You can then create a 
new fill based on the duplicate.



Edit Menu Commands    
Undo

Redo

Cut

Copy

Paste

Clear

Select All

Duplicate

Step & Repeat

Job

Setup

Preferences



Editing Circles & Ovals with Object Info    
When a circle or oval is selected, Object Info displays the following attributes for the selected object and 
allows you to edit them:

RX    Horizontal radius of the corner

RY    Vertical radius of the corner

A    Rotation angle from the horizontal 

See Also
Editing Text with Object Info

Editing Paths with Object Info

Editing Rectangles & Borders with Object Info

Editing Panels with Object Info

Performing Math Operations with Object Info



Editing Panels with Object Info    
When a panel is selected, Object Info displays the following attributes for the selected panel and allows 
you to edit them:

W    Width of the panel

H    Height of the panel

OV    Overlap between panels 

SP    Spacing around each copy 

Plot Advance    Resets the plotter origin at the end of the panel when plotting is complete

Cut weeding border    Cuts a box around the outside of the current panel when plotting is 
complete

DX    Horizontal    distance of the panel from the origin on the media

DY    Vertical    distance of the panel from the origin on the media

Number of strips    Displays the total number of strips in the selected panel

PL    Length of the media; cannot be changed with Object Info

PH    Height of the media; cannot be changed with Object Info

See Also
Editing Text with Object Info

Editing Paths with Object Info

Editing Rectangles & Borders with Object Info

Editing Circles & Ovals with Object Info

Performing Math Operations with Object Info



Editing Paths with Object Info    
When a control point or segment is selected with the Point Selection tool, Object Info displays the 
attributes of the selection and allows you to edit these attributes.    The attributes displayed are different 
for a segment and for a control point.

Segment selected
When a segment is selected with the Point Selection tool, the following information can be edited in 
Object Info:

Segment type buttons    Determine the type of the selected segment; the current type is 
highlighted. To change the type of the segment, click the appropriate icon:

Straight segment:    Click this icon to make the segment straight. A 
straight segment cannot be reshaped by dragging.

Curved segment:    Click this icon to make the segment curved. A 
curved segment can be reshaped by dragging the segment or its 
direction handles.

Length    Displays the length of the currently selected segment as measured in a straight line 
between the two endpoints. To change the length, type directly in this field or click the Apply 
Ref button.

Reference Length buttons    Allow you to save the length of the selected segment as a reference
length (displayed in the L Ref entry box) or to apply the current reference length to the 
selected segment.

Set Ref:    Click this button to copy the value displayed in the Length 
entry box and save it as the reference length. This length is then 
displayed in the L Ref entry box to the right.

Apply Ref:    Click this button to copy the reference length displayed 
in the L Ref entry box and apply it to the currently selected 
segment. This length is then displayed in the Length entry box. 

L Ref    Displays the last reference length saved; if no value has been saved, the default is zero. 
To change the reference length, type directly in this field, click the Set Ref button, or click the 
L Ref list box.

L Ref list box:    Changes the length displayed in the L Ref entry box. 
Choices include multiplying the current reference length by 1/4, 
1/2, 2, or 4, or changing it to one of the last six reference lengths 
used.

Angle    Displays the angle of the currently selected segment. To change the angle, type directly in
this field or click the Apply Ref button.

Reference Angle buttons    Allow you to save the angle of the selected segment as a reference 
angle (displayed in the A Ref entry box).

Set Ref:    Click this button to copy the angle displayed in the Angle 
entry box and save it as the reference angle. This value is then 
displayed in the A Ref entry box to the right.

Apply Ref:    Click this button to copy the angle displayed in the A Ref 
entry box and apply it to the currently selected segment. This 
angle is then displayed in the Angle entry box. 

A Ref    Displays the last reference angle saved; if no value has been saved, the default is zero. 
To change the reference angle, type directly in this field, click the Set Ref button, or click the 
A Ref list box.



Ref list box:    Changes the angle displayed in the A Ref entry box. 
Choices include Horizontal (0°), Vertical (90°), Opposite, Add 
90°, or changing it to one of the last six reference angles used.

Control point selected
When a control point is selected with the Point Selection tool, the following information can be edited in 
Object Info:

Point type buttons    Determine the type of the selected segment; the current type is highlighted. 
To change the type of the segment, click the appropriate icon:

Cusp:    Click this icon to change the selected point to a cusp (corner 
point). On a cusp, the direction handles move independently and 
can have different lengths.

Symmetric point:    Click this icon to change the selected point to a 
symmetric point. On a symmetric point, the direction handles 
move in unison and are the same length.

Smooth point:    Click this icon to change the selected point to a 
smooth point. On a smooth point, the direction handles move in 
unison but can have different lengths.

Angle    Displays the angle at the currently selected point (not displayed for a cusp). To change 
the angle, type directly in this field or click the Apply Ref button.

Reference Angle buttons    Allow you to save the angle at the selected control point as a 
reference angle (displayed in the A Ref entry box).

Set Ref:    Click this button to copy the angle displayed in the Angle 
entry box and save it as the reference angle. This value is then 
displayed in the A Ref entry box to the right.

Apply Ref:    Click this button to copy the angle displayed in the A Ref 
entry box and apply it to the currently selected control point. This 
angle is then displayed in the Angle entry box.

A Ref    Displays the last reference angle saved; if no value has been saved, the default is zero. To
change the reference angle, type directly in this field, click the Set Ref button, or click the A 
Ref list box.

A Ref list box:    Changes the angle displayed in the A Ref entry box. 
Choices include Horizontal (0°), Vertical (90°), Opposite, Add 
90°, or changing it to one of the last six reference angles used.

See Also
Point Selection tool

Editing Text with Object Info

Editing Rectangles & Borders with Object Info

Editing Circles & Ovals with Object Info

Editing Panels with Object Info

Performing Math Operations with Object Info



Editing Rectangles & Borders with Object Info    
When a rectangle or border is selected, Object Info displays the following attributes for the selected object
and allows you to edit them:

W    Width of the object

H    Height of the object

A    Rotation angle from the horizontal 

RX    Horizontal radius of the corner

RY    Vertical radius of the corner

See Also
Editing Text with Object Info

Editing Paths with Object Info

Editing Circles & Ovals with Object Info

Editing Panels with Object Info

Performing Math Operations with Object Info



Editing Text with Object Info    
When text is selected, Object Info displays the attributes of the selected text and allows you to edit these 
attributes.    The attributes displayed are different for text blocks selected with the Arrow tool than for text 
selected with one of the text tools.

Text Selected with Arrow tool
H    Height/text size

T  Tracking

A    Rotation angle from horizontal 

DL    Distortion length/horizontal scale

TL    Total line length

LS    Line spacing 

S    Slant angle from vertical 

Text alignment (justify left, center, justify right)

Font (See Font command)

Mirrored status (on or off)

Orientation (vertical or horizontal); normal text only

Text Selected with Text or Arc Text tool
H    Height/text size

A    Rotation angle from horizontal 

K    Kerning 

LS    Line spacing 

S    Slant angle from vertical 

Text alignment (justify left, center, justify right)

Font (See Font command)

Mirrored status (on or off)

See Also
Font command

Text Specs

Text Palette

Editing Paths with Object Info

Editing Rectangles & Borders with Object Info

Editing Circles & Ovals with Object Info

Editing Panels with Object Info

Performing Math Operations with Object Info



Eraser (Paint Palette)    

The Eraser tool removes details within a selected black & white template.

To delete details within a selected template, first change to Paint mode by clicking the Paint 
palette tool on the Draw palette.    Once in Paint mode, select the template by clicking it with 
the Arrow tool.    Select the Eraser tool and drag it over the area to be deleted, just as you 
would with a real eraser.

To delete an enclosed area within a selected template, use the Selection Rectangle or the Lasso 
tool to enclose the area and then press the Delete key.

To delete individual pixels, use the Pencil tool.

To delete an entire template, select the template by clicking it with the Arrow tool. Press the Delete
key.

To remove stray marks, such as those found on a photocopied image, use the Noise Cleaning 
tool.

See Also
Paint palette

Arrow tool (Paint mode)

Selection Rectangle

Lasso tool

Pencil tool

Noise Cleaning tool



Estimation Editor (Job, Edit Menu)    
Displays all of the Estimation Worksheet's default fields for editing. The Estimation Editor allows you to 
adjust markup, unit cost, materials, and other items to correspond to your normal charges and supplies.

The Estimation Editor is a separate program from Flexi. To use it, quit or minimize Flexi to start the 
Windows Program Manager. (See your Windows manual for more information on the Program Manager.) 
Double-click the Estimate Editor icon found in the Estimate Editor program group. The Estimation Editor is
displayed.

Estimation Editor Options
Category    Displays the list of row types shown in the Estimation Worksheet's Item field. To edit a 
category, choose it in this list box. Note that the Type and Item cannot be edited for the category Built In.

Item    Displays the Item list shown in the Estimation Data dialog box for the selected category.

- To select an item, click on its name in the Item list box.To edit its name, enter it in the Item 
entry box just below the list box.

- To change the cost, markup, minimum charge, or tax percentage for all of the types in several
items at once, select the types in the appropriate list box. (To select a continuous list, click 
the first item, hold down the Shift key, and click the last item; to select several separate items,
hold down the Ctrl key while clicking each one.) Choose the field to be changed from the 
Apply All list box, choose the operator (=, +, -, *) from the next list box, and enter the value in 
the entry box. Click Apply to see the results before saving.

- To create a new item, click the New Item button and enter a name in the Item entry box just 
below the list box.Then create the item(s) for the type as explained below.

- To delete an item, click on its name in the Item list box and click the Delete button.

Type    Displays the Type list shown in the Estimation Data dialog box for the selected item. For example, 
the types for the Wood item in the Substrate category include different varieties and thickness of wood 
substrate.

- To edit the name of a type, click on it in the Type list box and edit it in the Type entry box just 
below the list box. Edit the cost, markup, minimum charge, and tax percentage in the 
appropriate entry boxes. (If you do not wish to include a minimum charge, enter 0.00 in this 
entry box.) To change the unit of measure, choose one from the Units list box.

- To change the cost, markup, minimum charge, or tax percentage for several types at once, 
select the types in the appropriate list box. (To select a continuous list, click the first type, 
hold down the Shift key, and click the last type; to select several separate types, hold down 
the Ctrl key while clicking each one.) Choose the field to be changed from the Apply All list 
box, choose the operator (=, +, -, *) from the next list box, and enter the value in the entry 
box. Click Apply to see the results before saving.

- To create a new type, click the New Type button and enter a name in the Type entry box just 
below the list box. Enter the cost, markup, minimum charge, and tax percentage in the 
appropriate entry boxes. (If you do not wish to include a minimum charge, enter 0.00 in this 
entry box.) To change the unit of measure, choose one from the Units list box.

- To delete an item, click on its name in the Item list box and click the Delete button.

Password Protection    Determines whether or not the Estimation Editor is protected with a password. To
keep unauthorized users from seeing or changing your standard charges, check this box. Enter the new 
password in the dialog box which is displayed, click OK, enter the same password again to verify it, and 
click OK. The next time you open the Estimation Editor, it will require a password.

Export    Displays the File Save As dialog box. Enter the desired file name and click OK.

Print    Prints all of the data in the estimate table to the default printer.



Save    Save the changes to the estimate table.

Quit    Exits the Estimation Editor.

See Also
Job Info

Estimation

Save Header

Save Footer



Estimation... (Job, Edit Menu)    
Stores accounting information on the current job, automatically calculates costs, and prints a price 
estimate or cost analysis.    All of the information stored in Job Info except for comments and keywords is 
automatically printed as well.

Once you choose a row's type from the Item field, all of the information for that row is calculated 
automatically using default unit costs, markups, etc. The exception to this is the Quantity (Quan) field, 
which you need to enter for Material by area (by choosing colors from the Color list), Services, and 
Custom (all which you have to enter manually). All of these fields are then updated automatically every 
time you change your sign.You also may change any of the fields (except Amount) by typing in new 
values; these values will then be shown in italics, and will not update automatically.

NOTE To change any of the default values in the Estimation Worksheet such as unit cost or markup, 
use the Estimation Editor.

The Estimation Worksheet contains the following items:

Row    Row number.    When you choose the Material by area option, this number is displayed in the Color
list's Row column for every color which is included in the current row. (See Material by area below for 
more information.)

Item    Type of information calculated in the row. This field provides the following options:

Material by area      Calculates the cost of the selected material by area (for example, square feet).
To use this item, first choose Material by area from the Item list box and then click on the 
desired material (such as high performance vinyl or rubylith) in the Item column of the 
Estimation Data dialog box which is displayed.    If the selected material comes in more than 
one variety, click on the correct one in the Type column on the right. Click Select. The 
selected material is displayed in the row and all of the fields except Quan are filled in. To 
calculate the cost of one or more colors cut in the selected material, click on the name of 
each color on the Color list (lower left).    (To remove a color from the row, click the color 
again.) The total quantity used in the sign of each selected color is added to the row's Quan 
field and all other fields are recalculated automatically. If the Use panel area checkbox is 
selected, only the panel area is calculated.

Transfer tape      Automatically calculates the area of the transfer tape required to apply all of the 
colors used in the sign. If the Use panel area checkbox is selected, only the panel area is 
calculated.

Substrate      Automatically calculates the cost of the selected substrate based on the drawing size.
To use this item, first choose Substrate from the Item list box and then click on the desired 
substrate (such as foam or wood) in the Item column of the Estimation Data dialog box which
is displayed.    Choose the desired type and/or thickness of the selected material in the Type 
column on the right. Click Select. The selected substrate is displayed in the row and all of the
fields are calculated automatically.

Services      Automatically calculates all but the Quan for the selected service.    To use this item, 
first choose Services from the Item list box and then click on the desired service in the Item 
column of the Estimation Data dialog box which is displayed.    If the selected service has 
more than one option, click on the appropriate choice in the Type column on the right. Click 
Select. The selected Service is displayed in the row and all of the fields except Quan are 
filled in; enter the quantity to automatically calculate the remaining fields.

NOTE Several of the services have minimum charges built in. If you enter a quantity that is 
less than the default minimum, the minimum value is displayed with an asterisk (*) 
next to it.

The following services are included:

- Color count:    The number of color changes in the sign.



- Font count:    The number of font changes in the sign.

- Sign effect:    Special effects that require extra time and effort to produce, such as 
distortions, shadowing, or striping.

- Sign frame:    Materials used to mount the sign, such as posts or hardware.

- Silk screen:    Special costs associated with silk screening, including materials, such as a 
T-shirt or baseball cap, and services, such as the actual printing.

NOTE When producing multiple items for a silk screen job, be sure to adjust the Quan 
field for the item being printed (T-shirt, baseball cap) and for the actual printing. Do 
not enter the multiple in the Quantity field below the subtotal, because this would 
also multiply your one-time setup costs.

- Sign preparation:    Various processes (entered in hours) that go into producing a sign, 
such as design & layout, preparing a sign blank, and weeding & application.

- Travel:    Travel costs, including tolls/expenses, for which you enter the actual cost in 
dollars, and travel distance, entered in miles.

Charge by text size     Automatically inserts a row for each size of each font used in the sign and 
calculates the cost for that text size. To use this item, first choose Charge by text size from 
the Item list box and then click on the desired quality (economy, high performance, 
intermediate, or reflective) in the Text Material dialog box which is displayed.

Charge by distance      Automatically calculates how far the cutter head must travel to cut the sign 
and the cost of cutting that distance.    This allows you to charge for the difference in cutting 
time between simple and complex designs or the cost of sharpening blades or replacing 
pens.

Charge by character      Automatically counts how many characters (letters) were used in the sign 
and displays the quantity and cost.

Custom      Creates a custom row.    Ideal for unusual costs, this type of row allows you to type 
information into any of the fields except for Amount, which is calculated automatically.

Insert new before      Adds a new row before the current one.

Insert new after      Adds a new row after the current one.

Delete This Row      Removes the current row from the Estimation Worksheet.

Delete all rows      Clears the Estimation Worksheet, removing all rows and their data.

Description    Displays a description of the information calculated in the row. This field cannot be changed
for Material by area, Charge by text size, Substrate, or any of the Services options. To change the 
Description for one of these items, use the Estimation Editor.

Quan.    Displays the total quantity of the item.    For all row types except Material by area, Services, and 
Custom, this field automatically displays the total number of the row's items (for example, characters) in 
the sign.

Material by area      To calculate a material's area (quantity) automatically, select the row in the 
worksheet and then click on the name of each color in the Color list which uses that material. 
You can also enter the quantity by hand, but if you do, it will not update automatically as you 
make changes to your sign.

Services      The quantity for all services (usually in hours) must be entered by hand.

Custom      The quantity for all Custom rows must be entered by hand.

NOTE For certain types of jobs, such as silk screening, the quantity should be adjusted within the 
rows (number of T-shirts and prints, for example) so setup and other one-time costs are 
only charged once.



Unit Cost    The cost of the row's items per unit, typically per square foot.

Markup (%)    Percentage of the row's cost to add as markup, used for profit margin and to cover the cost 
of wasted materials.

Amount    Total cost of this row, including markup.    This field is calculated automatically and cannot be 
changed directly.    The sum of all of the values in the Amount column is displayed as the Subtotal.

Unit    The unit of measure in which the row is calculated, such as square feet or hours.

Tax    Percentage of the row's cost at which the item will be taxed.

Color list    Shows all of the colors used in the sign and how much area each of them covers.    To add a 
color into a Material by area row, click on the desired row in the worksheet and then click on the name of 
each color that uses the selected material.    To remove a color from the worksheet, click its name again. 
Each row in the Color list contains the following fields:

Row      The number of the row in the Estimation Worksheet to which this color's area has been 
added. If this field is the blank, the color's cost has not been included in the worksheet.

Color name      The name of the color in the sign. To add a color to a Material by area row, select 
that row and then click on the color name of the color to be added.

Area      The actual area of the color used in the sign, or if Use panel area is selected, used in any 
panels in the sign.

Subtotal    Total of all values in the Amount column.    This field is calculated automatically and cannot be 
changed directly.

Quantity    The total number of times the entire job is produced, for example, six identical signs. Note that 
for certain types of jobs, such as silk screening, the quantity should be adjusted within the rows (number 
of T-shirts and prints, for example) so setup and other one-time costs are only charged once.

Quantity discount    For any quantity greater than one, the percentage discount is applied to each item 
(before tax). For example, if you produce six identical signs, the subtotal will show the cost of producing 
one sign (for example, $100). If you then enter a quantity of 6 and a quantity discount of 10% for the 
example, $90 is charged for each sign, for a total of $540 before taxes.

Tax    When selected, total of the sales tax on the job after the quantity discount has been applied. Tax is 
charged on each row with a tax percentage greater than zero. The tax is calculated automatically after 
quantity and quantity discount have been calculated and is then added to the total.

Total    Sum of the tax and the subtotal after the quantity and quantity discount have been calculated.

Use panel area    When selected, only calculates the area of colors in Material by area rows using objects
within panels, rather than in the entire sign.

Area unit    The default unit of measure for area used in Material by area rows. This value can be 
changed using the Estimation Editor.

Forms    Displays the Forms dialog box. Use this dialog to select one of the standard worksheet forms 
included with Flexi, including Normal, Vehicle, and Silkscreen. The following options are available in this 
dialog box:

Select    To select a worksheet form, click on its name and click Select. The selected form is 
displayed on the worksheet.

Export    To export a form to a text file which you can print out later, click on its name and click 
Export. In the dialog box which is displayed, type the name to which you wish to export the 
file and click OK.

Delete    To delete a worksheet form, click on its name and click Delete. The form is removed from 
the list.

Done    To finish working with worksheet forms and close the Forms dialog box, click Done.



Load    To load a form created in another file, click Load. In the Open Forms Library dialog box, 
choose the desired form file (*.frm) and click OK. The Load Forms from Library dialog box is 
displayed. To load a form from the library, click on its name in the Library Forms column on 
the right and click ADD. To delete a form that you just added, click on its name in the Current 
Forms column on the left and click Remove.

Save Form    Saves the current worksheet's setup as a new form, including everything except quantity 
values. To save a form, click the Save Form button, enter the new form's name in the dialog box which is 
displayed, and click OK.

Print    Displays the Estimate Printing Options dialog box. To print, choose one of the print forms and then 
enter how far you want the header and footer to be offset from the edge of the page. Click the Print 
button. The selected form is printed, automatically including all Job Info and Estimation data. There are 
three print forms:

Price Estimate-Itemized    This form can be used as an invoice for the customer. It is a complete 
price estimate breaking down all of the costs of the sign after markup. Contains all Job Info 
data except comments and keywords.

Price Estimate-Summary      A summary of the estimate showing only the subtotal, quantity, tax, 
and total price for the sign. Contains all Job Info data except comments and keywords.

Cost Analysis      Not for the customer!    This form is identical to the price estimate, except that it 
breaks out the job cost (cost to you in time and materials), job price (amount charged to the 
customer), and gross profit.

Cancel    Closes the Estimation Worksheet without saving any changes.

Export    Exports the current worksheet to a text file, including all quantity values.

Done    Saves changes and closes the Estimation Worksheet.

See Also
Save

Save As

Job

Job Info

Save Header

Save Footer

Estimation Editor



Even Striping    
Adds stripes of a specified width to the selected object.    You can specify the width of the gap between 
these stripes; the gap width does not vary with even stripes.

NOTE Any text which is striped is automatically converted to paths and can no longer be edited as text.

The Stripe Options dialog box contains the following items:

Preview display    Shows how the selection will look with the currently specified striping.    Click 
the scroll bar below this display to see more of the selection.

Number of stripes    Changes the number of stripes placed across the object.    (The stripes are 
shown in color and the gaps are shown in white.)    Note that this is the number of stripes 
across the entire object, which means that letters of varying height will have a different 
number of stripes. For example, if you put five horizontal stripes on the word 'stripe', the 
letters t and p will have four stripes each and the rest will have three stripes.

Stripe size    Displays the width of each stripe at the current settings.    This value cannot be 
changed directly.

Gap type    Determines how the gap is measured.    Gap by Size allows you to specify the width of
each gap in the Size entry box.    Gap by Percent allows you to specify what percentage of 
the finished object is made up of gaps in the Proportion to stripe entry box.

Proportion to stripe    When Gap by Percent is selected, determines the percentage of the 
finished object which is made up of gaps.

Size    When Gap by Size is selected, determines the width of each gap.

Angle    When the diagonal striping option is selected, determines the angle of the stripes.

Height, Length    Displays the height and length of the selection.    These values cannot be 
changed from within the Stripe Options dialog box.

Angle icons    Determines whether horizontal, vertical, or diagonal stripes are placed on the 
selection.    Click the desired icon to select it.

See Also
Gradient Striping

Radiant Striping

Circular Striping



Exit (File Menu)    
Ends this Flexi session.    You are prompted to save any changes to the current file.

Yes closes the file after saving any changes you have made since the last save.

No closes the file without saving any of your changes since the last save.

Cancel returns you to the file without closing it.

See Also
Close

Save

Save As



Export Bitmap (File Menu)    
Use this command to save a bitmap file without creating a link to a Flexi file. This feature can be used to 
convert your image into another file format for use in another program, or to save a bitmapped image for 
later use.

To save a vector file to the same name in the Flexi format, use the Save command.

To save a vector file to a new name in the Flexi, Illustrator EPS, DXF, or Clip Art file formats, use 
the Save As command.

NOTE FlexiLETTER cannot open or save bitmap files.

See Also
Close

Save

Save As

Revert

Exit



The Eyedropper selects a color and/or fills an area with the selected color. This tool also changes the 
selected color to the active color.

- To select a color and make it the active color, click the Eyedropper on that color in the 
preview display.

To fill a small area with the active color, select the Eyedropper and hold down the Ctrl key to change 
the cursor to a filled eyedropper. Without releasing the Ctrl key, click on the area to be filled.

- To fill a large area with another color on the preview display, click the Eyedropper on the color
in the template that you want to use and drag it to the area you wish to fill. (The cursor 
changes to a paint bucket while you are dragging.)



File Menu Commands 
New

Open

Merge

Merge Bitmap

Close

Save

Save As

Export Bitmap

Revert

Scan

Scan and Trace

Print Setup

Print

FlexiPRINT

Cut/Plot

Fill Plot

Exit



Fill Box    
The active fill is displayed in this box. When you create an object using the drawing tools, it is filled with 
the active fill. 

If you do not have Flexi-SIGN-PRO:

To change the fill status of an existing object, select the object and click the Fill Box.

To change how all new objects are filled, click the Fill Status box when nothing is selected.

If you have FlexiSIGN-PRO:

To change the fill of an existing object, select the object with the Arrow tool, and choose a fill. This does 
not change the active fill.

To change the active fill, click the Fill box when nothing is selected. Click and hold on the Fill Box and 
choose a fill. A wire frame fill outlines your object with the active color.

Use the solid fill to fill your object with the active color.

Drag to gradient> to display the list of gradient fills.

Drag to pattern> to display the list of pattern fills.

Drag to color stripe> to display the list of color stripe fills.

Return to Color Palette

See Also
Gradient Fills

Pattern Fills

Color Stripe Fills

Color Command Menu



Fill Libraries    
Flexi contains a library of gradients, patterns, and color stripes. You can store fills for future use, retrieve 
stored fills, delete fills, or create new fill libraries. 

Click on any portion of the dialog box for more information.

To create a new fill library or select a library, hold the Control key while you click the Libraries button. The 
Library dialog box is displayed. You can create a new library or choose from your list of existing libraries.
Return to Gradient Options

Return to Pattern Options

Return to Color Stripe Options



Fill Plot (Cut Palette)    

The Fill Plot tool controls the fill plotting process.    Use this tool to pen plot your sign with solid fills.

NOTE To cut a sign or to pen plot its outlines, use the Cut Tool or the Cut/Plot command.

To fill plot panels which you have created and/or edited manually, select them before clicking the 
Fill Plot tool.

To automatically panel and fill plot the entire sign, click on a blank portion of the drawing area 
before clicking the Fill Plot tool. Warning:  If you do this, Flexi will ignore any panels you 
already prepared!

Cut Mode
In Cut mode, you can fill plot using either the Fill Plot tool or the Fill Plot command.

To plot panels which you have created and/or edited manually, select them with the Arrow tool 
before clicking the Fill Plot tool or choosing the Fill Plot command.

To automatically panel and plot the entire sign, click on a blank portion of the drawing area before 
clicking the Fill Plot tool or choosing the Fill Plot command.    Warning:    If you do this, Flexi 
will ignore any panels you already prepared!

Draw Mode
In Draw mode, you can only fill plot by using the Fill Plot command on the File menu.

To plot selected objects, hold down the Shift key and click on the objects with the Arrow tool 
before choosing the Fill Plot command.

To automatically panel and plot the entire sign, click on a blank portion of the drawing area before 
choosing the Fill Plot command.

For more information about the Fill Plot dialog box, see Fill Plot options.

See Also
Cut/Plot

Fill Plot

Plotter Options

Setup

Cut Tool



Fill Plot (File Menu)    
Fill plots the current sign from either Draw mode or Cut mode.

Draw Mode
To plot selected objects, hold down the Shift key and click on the objects with the Arrow tool 

before choosing the Fill Plot command.

To automatically panel and plot the entire sign, click on a blank portion of the drawing area before 
choosing the Fill Plot command.

Cut Mode
To plot panels which you have created and/or edited manually, select them before choosing the 

Fill Plot command or clicking the Fill Plot tool.

To automatically panel and plot the entire sign, click on a blank portion of the drawing area before 
choosing the Fill Plot command or clicking the Fill Plot tool.    Warning:    If you do this, Flexi 
will ignore any panels you already prepared!

Fill Plot Options
Setup selection menu    Lists all plotters set up in Flexi using the Setup command. Use this menu

to change the current device; Windows for Workgroups users can also choose a different 
Production Manager.

Custom menu    Contains special commands for the currently selected device, divided into three 
types of commands

- Start    Sent at the start of the job, for example, Cut fast, Pen plot

- End    Sent at the end of the job

- Custom    Sent immediately to configure plotter, e.g., blade number, pressure

Cut to    Controls where each plotting job goes:

- Send Now:    Sends the job to Production Manager and places it on ready status. (If you 
are working on a network, this command is not always available.)

- Save to file:    Saves the job to a file that can be plotted later using the Add Cut Job 
command in Production Manager. (If you are working on a network, this command is not 
always available.)

- Hold in Queue:    Sends the job to Production Manager and places it on hold.

Preview area    Shows all pages to be cut in current color layer; click the scroll bar to see 
additional pages.    The current page is surrounded by a solid line; all others have a dotted 
line.    Once the page is cut, it is turned off automatically.    Pages which have been turned off 
are dimmed and moved to the end. 

Current page    The page currently selected for cutting; click on a page to select it. If interactive 
plotting is on, double-click a page or click the Show Me button to move the pen/knife around 
the border of the first page without cutting it.    The box in the upper left corner of each page 
controls whether or not the page is cut; an X in this box indicates that it will not be cut. Click 
in this box to turn the page on or off; once the page is cut, it is turned off automatically.

Color selection bar    Controls color layers to be plotted or cut; click on a color to select that layer
for plotting. To make a check plot with all layers plotted at once (in one color), click the 
triangle on top of the color selection bar and choose Plot all colors from the menu which is 
displayed. Colors can be turned off by pressing the Shift key while clicking them and turned 
on again by selecting Show all colors from the Color selection bar menu.



Mirror:    Cuts all panels in reverse; useful for cutting signs that will be applied to the inside of 
windows.

Rotate:    Rotates all panels 90° on the media when cutting them.

Offset    Changes how far each page is shifted horizontally or vertically from the plotter’s origin 
(lower left of preview window).

Copies    Specifies how many copies to cut of each page.

Advance after plot    Moves the media forward and resets the origin after the plot is complete

Interactive    Moves the blade on the cutter as you move the page on the preview display, 
allowing you to see exactly where it will be placed on the media. Not all plotters support this 
feature.

Center  Places each page on the vertical center of the media.

Fill Angle    Specifies the angle at which each object is filled.

Pen Size    Specifies the width of the pen used to plot.

Show Me button    Moves the pen/knife around the border of the first page without cutting it.

Poll Size button    For plotters that support interactive cutting, returns information on the actual 
height and length of the currently loaded media and displays it above the preview display.

Done button    Finishes the current plotting session by closing the Fill Plot dialog box.    This 
button changes to Abort while the job is being plotted.

Cut button    Sends the pages in the current color layer to the destination indicated in the Cut to 
list box.

See Also
Plotter Options

Setup

Fill Plot Tool



Find/Replace... (Text Menu)    
Allows you to search for text in the current sign and/or replace it with different text.

NOTE This command only works for actual text.    It does not work on text which has been converted to 
paths either directly or by applying one of the commands in the Tools menu, many of which 
convert text to paths automatically.

The Find/Replace Text Options dialog box contains the following

Find what    Allows you to enter the text you need to find.

Replace with    Allows you to enter the new text that will replace the old text when you find it.

Match whole word only    When this option is checked, prevents Flexi from finding partial words.  
For example, if you are searching for 'let', you might not want to find 'letter'.

Find    Searches for the next occurrence of the text in the 'Find what' box and displays it in the text
box in the lower left.

Replace    Deletes the text item which Flexi just found and adds the text in the 'Replace with' box 
in its place.

Replace All    Deletes all occurrences of the text item in the 'Find what' box and adds the text in 
the 'Replace with' box in its place.

Done    Ends this Find/Replace session.

See Also
Text Specs 

Text Palette 



FlexiPRINT (Cut Palette)    

The FlexiPRINT feature allows you to print objects and bitmaps on a large-format color printer. Use either 
the FlexiPRINT command on the File menu or the FlexiPRINT tool on the Cut palette to open the 
FlexiPRINT dialog box.

Click on any item in the dialog box below for more information.

Return to the File menu

See Also
Contour Cutting



FlexiPRINT (File Menu)    
The FlexiPRINT feature allows you to print objects and bitmaps on a large-format color printer. Use either 
the FlexiPRINT command on the File menu or the FlexiPRINT tool on the Cut palette to open the 
FlexiPRINT dialog box.

Click on any item in the dialog box below for more information.

Return to the File menu

See Also
Contour Cutting



Font (Text Menu)    
Changes the typeface of the selected text.    If no text is selected, all new text is created in the font 
chosen.    The font can also be changed using the Text Specs command or Object Info.

To use one of the fonts shown on the Font cascading menu, first select the text by dragging one of
the text tools over it or by clicking it with the Arrow tool.    (To change the font for new text, 
make sure nothing is selected.)    Choose Font from the Text menu, displaying the Font 
cascading menu.    Next, either choose the desired font from the cascading menu.

NOTE If the desired font is not displayed because font list is longer than the window, choose Others to 
display additional fonts.    In the Select Font dialog box, click on the desired font and style and 
click OK to select them.

To use an installed font not shown on the Font cascading menu, first select the text by dragging 
one of the text tools over it or by clicking it with the Arrow tool.    (To change the font for new 
text, make sure nothing is selected.)    Choose Font from the Text menu and then choose 
Modify from the Font cascading menu.    Choose the desired font from the Fonts dialog box 
(options discussed below) and click Select.    The text is changed and the selected font is 
added to the Font cascading menu.

Fonts Dialog Box Options
Preview display:    Shows the font and style currently highlighted in the Font Families list.    The 

scroll bar below this display changes the point size of the sample displayed.

Display Sample:    Click this option to preview the sample text in the text entry box below.    If you 
highlighted text before selecting the Other option, that text is automatically displayed in this 
area.    You can type any sample in this area; the sample is saved when you save your 
preferences.

Display ASCII Character:    Click this option to preview a specific ASCII character.    Any character
in the selected font can be displayed, including special characters.    To select a character, 
either click or drag the scroll bar until you reach the desired character or type the character's 
ASCII number in the entry box provided.

Keyboard:    Shows the keystroke combination needed to produce the displayed ASCII character 
in the currently highlighted font.    For example, to produce the copyright symbol (©) in Times 
New Roman, you would hold down the Alt key and type 0169 on the number pad. (Make sure
your keyboard's Number Lock is on before you do this.)

Font Families:    This list shows all of the PostScript and TrueType font families currently installed 
on your computer.    Each family may have several styles associated with it; the style is 
selected using the list box below this list.    The icon to the left of each item indicates the font 
format.    A 'T1' indicates a PostScript Type 1 font; all others are TrueType fonts.    Click on a 
font name to select it.    To select several fonts in a row, hold down the Shift key and click the 
top and bottom font names; to select several fonts in various locations on the list, hold down 
the Ctrl key and click each font name.

Style:    Allows you to choose from the styles available for the font family currently highlighted in 
the Font Families list.    (For example, Helvetica might have the styles Regular, Bold, and 
Bold Italic.)    The number to the right of this menu shows how many styles are available for 
the font family.

Name:    The name of the font currently highlighted in the Font Families list.    This includes both 
the family name and style.

Format:    Shows the file format of the currently selected font.    Flexi allows you to use both 
TrueType and Type 1 Postscript fonts.

Remove button:  Removes the fonts currently highlighted in the Font Families list from the Font 



cascading menu.

Add button:    Adds the fonts currently highlighted in the Font Families list to the Font cascading 
menu, as indicated by a checkmark to the left of the font family name.

Print button:    Displays the Print Font Catalog dialog box. This feature allows you to print out a 
font catalog of either the fonts currently selected in the Fonts dialog box or of all of the fonts 
currently installed on your hard drive.

Select:    Applies the currently highlighted font and displayed style to the selected text, adds the 
font family to the font menu, and closes the Fonts dialog box.    (If no text is selected, all new 
text will be created in the selected font.)

Cancel:    Closes the Fonts dialog box without saving any changes.

Done:    Saves all the changes and closes the dialog box.    If text is selected, that text's font is not 
changed.

See Also
Preferences

Print Font Catalog

Text Specs 

Text Palette 

Object Info



Freehand Polygon (Shape Palette)    

The Freehand Polygon tool allows you to draw polygons with sides of different lengths and angles.

To create a polygon with sides of different lengths, select the Freehand Polygon tool.    Click the 
crosshair cursor which is displayed on the drawing area to place the first corner.    Drag the 
line which is displayed to the next corner and click again.    Continue dragging and clicking to 
place each corner.    (To place any point at a 90° angle from the previous point, hold down the
Shift key while dragging.)    To close the polygon, click on the first corner.    The new polygon 
is closed and filled.

NOTE To create a polygon which is not filled, click the Fill Status Box on the Color palette before 
creating it.

To create a polygon in which all sides are the same length, use the Regular Polygon tool.

See Also
Regular Polygon tool

Color palette



You can choose a high or low frequency when you're using the Angled Screen dither. High frequency 
increases the lines per inch; low frequency reduces the lines per inch.



Full Justify... (Text Menu)    
Changes the arrangement of lines within a selected text block by adjusting spacing so all lines are the 
same length and text is aligned on both the left and right sides of the text block.

To full justify a text block, first make sure it is in the correct font and size. Click on the text block with the 
Arrow tool to select it and then choose Full Justify from the Text menu. A dialog box displays the following 
options:

Adjust word spacing only    Changes the spacing between words to make all lines in the text 
block the same length.

Adjust both letter and word spacing    Changes the spacing between each character and the 
spacing between words to make all lines in the text block the same length.

Specify width    When checked, determines the length of each line in the text block. To specify the
width of a text block, select this option and type the desired size of the text block in the entry 
box.

NOTE Before using Full Justify, you must select a text block with the Arrow tool. This command does 
not work on partial text blocks. Full justify cannot be the default alignment for new text.

To change the alignment of a text block to Left, Right, or Center, use the Alignment command on 
the Text menu.

To change the alignment of graphic objects, use the Align command on the Arrange menu.

See Also
Preferences

Align

Text Specs 

Alignment

Text Palette 

Object Info



When colors are rasterized, the RGB colors that are displayed on your computer monitor are converted to
CMYK separations in preparation for printing. As part of this conversion, areas that contain high 
percentages of cyan, magenta, and yellow are replaced with black ink. This process is called Gray 
Component Replacement (GCR) or Undercolor Removal (UCR).

Flexi does an excellent job converting the RGB image to CMYK and handles GCR automatically.    You 
may want to adjust the amount of black ink used in your print job. There are five settings possible. 

Minimum and Light. Only black areas use the black ink. Grays not accurate. Colors more saturated.

Medium. The default setting. Adequate for most print jobs.

Heavy and Maximum. Better grayscale and black. Colors less saturated.



The gradient bar is used to create your fill. You can change the gradient by manipulating the midpoint 
diamonds and color triangles.



Gradient Options (Color Command Menu)    
You can create new gradient fills from the Gradient Options dialog box. Choose Gradient Fills from the 
Color Command menu to access this dialog box.

Click on any item in the dialog box below for a description of its function.

Return to Color Command Menu

See Also
Pattern Fill

Color Stripe Fill



Gradient Striping    
Adds stripes of varying widths to the selected object.    You can choose to specify the gap between the 
stripes, so it does not vary, or you can vary the gap width as well.

NOTE Any text which is striped is automatically converted to paths and can no longer be edited as text.

The Gradient Stripe Options dialog box contains the following items:

Preview display    Shows how the selection will look with the currently specified striping.    Click 
the scroll bar below this display to see more of the selection.

Height, Length    Displays the height and length of the selection.    These values cannot be 
changed from within the Gradient Stripe Options dialog box.

By percent    Measures the offset values as a percentage of the total object.

By size    Measures the offset values using the default unit of measure (for example, inches).

Number of stripes    Changes the number of stripes placed across the object.    (The stripes are 
shown in color and the gaps are shown in white.)    Note that this is the number of stripes 
across the entire object, which means that letters of varying height will have a different 
number of stripes. For example, if you put five horizontal stripes on the word 'stripe', the 
letters t and p will have four stripes each and the rest will have three stripes.

Offset to first stripe    Determines how far from the edge of the selection the gaps will start.    
(Use the direction icon at the bottom of the dialog box to determine which side of the object 
the stripes will start on.)    Gaps are shown in white and stripes are shown in color.

Offset to last stripe    Determines how far from the edge of the selection the gaps will end.    (Use 
the direction icon at the bottom of the dialog box to    determine which side of the object the 
stripes will end on.)    Gaps are shown in white and stripes are shown in color.

Type    Determines whether both the stripes and gaps vary in size (Variable Stripes and Gaps) or 
just the stripes vary in size (Variable Stripes Only).

Gradient up to    Determines the proportion of the total object which is made up of stripes.

Gap size    When Variable Stripes Only is selected, determines the width of each gap.

Angle    When the diagonal striping option is selected, determines the angle of the stripes.

First stripe size    Displays the width of the first stripe.    (Stripes are shown in color.)    This value 
cannot be changed directly.

Last stripe size    Displays the width of the last stripe.    (Stripes are shown in color.)    This value 
cannot be changed directly.

Angle icons    Determines whether horizontal, vertical, or diagonal stripes are placed on the 
selection.    Click and hold down the mouse button and then drag to select the desired stripe 
angle.

Direction icon    Determines the starting direction of the stripes.    For example, when horizontal 
striping is selected, the up arrow stripes the selection from bottom to top and the down arrow 
stripes it from top to bottom.    Click and hold down the mouse button and then drag to select 
the desired stripe direction.

See Also
Even Striping

Radiant Striping

Circular Striping



Grayscale images are printed with black ink only. Colors are converted to shades of gray.



The grid is a series of intersecting horizontal and vertical dotted lines displayed on the drawing area to 
help you align text and graphic objects.    The grid is hidden and displayed using the Show Grid command 
on the Layout menu.



Group (Arrange Menu)    
Joins multiple objects of one or more colors or types (text or graphic objects) so they are handled as a 
single object. A grouped object can be moved or resized without changing the relationship of the 
individual objects to each other. This feature is particularly helpful when you have placed an outline or 
shadow around an object.

To edit individual members of a grouped object, use the Ungroup command to separate them.

To combine objects of the same color, 'knocking out' overlapping areas, use the Make Compound 
command.    By compounding, you can separate the objects later using the Release 
Compound command.

To join objects into a single graphic object which will not be separated later, use the Combine 
command.

See Also
Ungroup

Make Compound

Release Compound

Combine



A guide is a dotted open or closed path which helps you to arrange or align objects on your sign.    A 
guide does not plot or print.



H and V offset control how much your image or group of images is offset from the printer origin, 
horizontally (H) or vertically (V). The origin is the lower left corner of the preview display.



HSL is a color model that describes a color based on its Hue, Saturation, and Luminance.

Hue is color.

Saturation is the intensity of a color. It represents the amount of gray in a color relative to its hue and is 
measured from 0 (gray) to 240 (fully saturated).

Luminance is the relative lightness or darkness of a color. It is measured on a scale from 0 (black) to 240 
(white).



Hand (View Palette)    

The Hand tool moves the sign on the drawing area, panning in the direction it is dragged.

To pan to a different part of your sign, select the Hand tool from the View palette.    Click and drag 
the Hand tool in the direction you wish to move.

To scroll to a different portion of your sign, use the scroll bars.    To move a short distance, click 
one of the arrows on the scroll bar; to move a longer distance, click on the gray area in the 
scroll bar; to move a specific distance, drag the small box in the scroll bar.    The scroll 
amount is how far the sign moves when the scroll bar is clicked.    This value can be changed 
using the Preferences command.

See Also
Preferences



The Height entry box displays the height of the currently displayed media size. To change the height, 
type a new number in the entry box.



Help Menu Commands    
Contents

Using Help

System Info

About



Hide Guides (Layout Menu)    
Hides and displays all guides.    A checkmark appears next to this command when guides are hidden.

See Also
Make Guide

Lock Guides

Release Guide



Highlights are the pixels in your image that are at the light end of the luminosity or brightness scale.



Hole Filling (Paint Palette)    

The Hole Filling tool fills all small holes and gaps in the selected area of a black & white template.    This 
tool is very good for cleaning up low-quality images, such as artwork which has been photocopied or 
faxed.

To fill in small gaps in an area which is meant to be solid in a black & white template, first change 
to Paint mode by clicking the Paint palette tool on the Draw palette.    Once in Paint mode, 
select the template by clicking it with the Arrow tool.    Select the Hole Filling tool.    Click the 
crosshair cursor on the drawing area and drag a box around the area to be filled.

To fill small gaps in a color template, use the Magic Wand and the Paint Bucket in the ColorTrace 
Options dialog box.

To fill an enclosed area in a template, use the Paint Bucket.

To remove stray marks from a template, use the Noise Cleaning tool.

See Also
Paint palette

Arrow tool (Paint mode)

Paint Bucket

Noise Cleaning tool

ColorTrace



Horizontal Size (Label Palette)    

The Horizontal Size tool labels the horizontal dimensions of the selected area with two arrows and the 
desired text.

To label the horizontal dimensions of an area or object, select the Horizontal Size tool.    Click on 
the first of the two points to be labeled and drag to the second point.    Enter the text and 
desired options in the Label Options dialog box (described below) and click OK. Move the 
mouse up or down to change how far the label is from the object or from side to side to 
change where the label is placed in relation to the dimensioning lines.    (The label can be to 
the left, to the right, or inside the lines.)    Once you are satisfied with the label's placement, 
click on the drawing area to finish it.

To draw an arrow leading from a point directly to a text label, use the Straight Arrow tool.

To draw an arrow with multiple segments, use the Bent Arrow tool.

To label the vertical dimensions of an area or object, use the Vertical Size tool.

To label the diagonal dimensions of an area or object, use the Diagonal Size tool.

Label Options
Label Text    Text to be displayed on the drawing area. Automatically displays the horizontal 

distance you dragged to create the label.

Text Size    Height of the label text.

Arrow Length    Length of the arrow's head.

Arrow Width    Line width of the arrow.

Arrow Style    Shape and style of the arrow's head.

See Also
Straight Arrow tool

Bent Arrow tool

Vertical Size tool

Diagonal Size tool



Info... (Job, Edit Menu)    
Stores information entered about the current sign job, such as P.O. number, customer’s company name 
and address, order and delivery dates, and terms. You can add or change information at any point in the 
design process.

Job Info is also a convenient way to find a file later.    As you enter information on each job, be sure to 
enter one or more keywords which would help you remember the file.    (For example, if the sign included 
a picture of a dog, you might use 'dog' as a keyword.)

To use Job Info, simply type in each field.

To move forward from one field to another, press Tab or click in the desired field.

To select a word, double-click it or drag the text insertion tool over it.

To delete a word or character, select it and press the Delete key.

To save the new job information, click OK and choose Save from the File menu.

See Also
Save

Save As

Job

Estimation



The estimated ink remaining in the ribbon or cartridge is displayed for each process color.



Ink Tracking Calibration (Material/Ink Setup)    
Adjusts the ink tracking formula for the selected color to allow for an individual printer's rate of ink usage. 
FlexiSIGN-PRO's ink tracking system is based on the assumption that your printer is working under 
normal operating conditions. However, several conditions can have a profound effect on how rapidly ink is
used, including temperature, humidity, age, or condition of an ink cartridge, or individual printer 
performance.

To display the Ink Tracking Calibration dialog box for one of the ink colors, click one of the ink color 
buttons in Material/Ink Setup.

CAUTION If you are making a one-time change, such as when you refill a cartridge, do not use the 
Ink Tracking Calibration dialog box. Instead, enter the corrected value in the Remaining entry 
box found in the Material/Ink Setup dialog box.

Click on any item in the dialog box below for more information.

Return to Material/Ink Setup.



The Ink color buttons display the color (C, M, Y, K) for each of the Remaining and Capacity entry boxes. 
To adjust a color's calibration formula, click on its button to display the Ink Tracking Calibration dialog box.



The Ink list box allows you to choose the default ink for the current color printer setup.



The % ink remaining in cartridge entry box displays the current percentage of ink remaining for the 
selected color. Changing this number permanently changes Flexi's ink usage formula for this color. Any 
changes made to this entry box are reflected automatically in the Dots/ml entry box.



The Ink list box displays all of the available inks for the currently selected media and printer. To change 
the name of the selected ink, highlight it and type the new name.



An inline is a closed path created around the inner edge of the selected object.



Inline/Outline... (Tools Menu)    
Places an inline, outline, or contour around the selected text or graphic object.

Inline/Outline Options
Preview display    Shows the proportions of the currently specified inline, outline, or contour.

Outline button    Creates an outline of the original object.

Inline button    Creates an inline of the original object.

Contour button    Creates a contour of the original object.    To place a single contour around a 
group of objects, increase the Width setting.

By size    Measures Distance and Width in the default unit of measure, for example, inches.

By percent    Measures Distance and Width as a percentage of the original object's total size.

Color    Determines the color of the inline, outline, or contour.

Distance    Determines how far the outer edge of the inline, outline, or contour will be from the 
edge of the original object.    If a Width value is entered, this portion of the outline is knocked 
out, creating a space between the original object and an outline of the specified Width.

Width  If a value of 0 is entered or the checkbox isn't checked, this entry box has no effect on the 
inline, outline, or contour.    If a value of greater than 0 is entered and the checkbox is 
checked, the outline changes such that the Distance becomes an offset.    This means that 
the first outline created by the Distance value is knocked out (blank), and a second outline of 
the specified Width is placed outside it.

Copies    Creates multiple inlines, outlines, and contours.    The Distance of each copy is 
measured from the outer edge of the Distance inside it.    The Width value does not affect 
copy placement, only whether or not the Distance portion of the outline is knocked out.

Joint Style    Determines how corners are inlined, outlined, or contoured.

Correct direction    Automatically prepares paths so they are in the correct order.    They will start 
with a clockwise path, alternating with counterclockwise paths from the inside out.    If this 
option is not selected, Flexi will automatically outline all counterclockwise closed paths and 
inline all clockwise paths.

With backing    Determines whether or not the inline, outline, or contour extends behind the 
original object.

Keep original objects    Determines whether the original objects are deleted after they are 
inlined, outlined, or contoured.

Weld overlapped objects    Determines whether overlapping inlines, outlines, or contours are 
automatically joined into a single object.

Stroke open paths    When open paths are selected, determines whether they are automatically 
stroked when they are inlined, outlined, or contoured.

See Also
Show Path Direction

Path Direction



The inner radius of a starburst measures the distance from the center of the starburst to the base of its 
points.



If you choose the Interactive mode, the alignment process is controlled by your computer. You can use 
this method with any cutter that supports interactive, even parallel devices.



Objects in an invisible color cannot be seen, plotted, cut, printed, or edited. Any color except the active 
color can be made invisible.

- To make an invisible color visible, hold down the Shift key while clicking it.

- To make all colors visible, choose Show All Colors from the Color Command menu or hold down the 
Shift key and double-click a color box.



Job (Edit Menu)    
Allows you to manage the job, storing information and estimating costs in time and materials.    When 
selected, this command displays a cascading menu with the following options:

Info...

Estimation...

Estimation Editor

Save Header

Save Footer

NOTE The Estimation, Save Header, and Save Footer commands are only included in FlexiSIGN-PRO 
and FlexiSIGN-Plus. Job Info is a separate command on the Edit menu for all other FlexiFAMILY
products.

See Also
Job Info

Estimation

Save Header

Save Footer

Estimation Editor



Join Points (Path Edit Palette)    

Merges or joins the endpoints of two open paths or closes an open path by merging or joining its 
endpoints. This tool allows you to merge two control points by combining them into one point, join two 
points by drawing a straight segment between them, or connect multiple open paths by merging all pairs 
of endpoints within a specified distance from each other.

Merging two points
To connect two open paths or close an open path by combining their endpoints into a single point:

- Click the Point Selection tool on the first point you wish to merge. (Each point must be at the 
beginning or end of an open path.) This point will not move when the points are merged.

- Hold down the Shift key and click the Point Selection tool on the second point you wish to 
merge.

- Click the Join Points tool to merge the points.

NOTE If Flexi draws a line connecting the two points instead of merging them, you need to select the 
Merge option. To do this, double-click or hold down the Ctrl key and click the Join Points tool, 
choose the Merge option in the dialog box which is displayed, and click OK.

Joining two points
To combine two open paths or close an open path by drawing a straight segment between the points:

- Click the Point Selection tool on the first point you wish to join. (Each point must be at the 
beginning or end of an open path.)

- Hold down the Shift key and click the Point Selection tool on the second point you wish to 
join.

- Double-click or hold down the Ctrl key and click the Join Points tool.

- In the Join Points Options dialog box, click next to the Join option.

- Click OK to join the points.

Connecting multiple points
To merge all pairs of endpoints within a selected area which are within a specified distance from each 
other:

- Select several paths or points by dragging a box across them with the Arrow tool or the Point 
Selection tool.

- Double-click or hold down the Ctrl key and click the Join Points tool.

- In the Join Points Options dialog box, click next to the Connect multiple option.

- In the Tolerance entry box, enter how close two points should be to each other in order to be 
merged.

- Click OK to merge the points.

See Also
Show Path Direction

Convert to Paths

Path Direction



Point Selection tool



Join Together (Text Menu)    
Joins multiple text blocks into a single block in the order they were selected, allowing you to format them 
as a single unit.

To join multiple text blocks into a single block, hold down the Shift key and click on each text block
with the Arrow tool. (Be sure to select the blocks in the order in which you want them to be 
joined.) Choose Join Together from the Text menu.

To join lines within a text block, click the appropriate text tool at the left of the second line and 
press the Backspace key.

To break apart a block of text, use the Break Apart command.

See Also
Break Apart

Text Palette



Kern (Text Menu)    
Automatically changes the kerning of a selected text block.

To change kerning automatically, select one or more blocks of text with the Arrow tool.    Choose 
Kern from the Text menu and then choose the desired kerning option from the cascading 
menu which pops up.    The text is displayed with the new kerning and a checkmark appears 
next to the selected kerning option.

NOTE Unlike font, size, and similar attributes, kerning is not applied to new text automatically.

To change kerning manually, click one of the text tools between the pair of characters you want to 
kern.    Hold down the Ctrl key and press either the left or right arrow key on your keyboard.    
The space between the two characters changes, while the spacing of the other characters in 
the text block stays the same.

To change the kerning between a pair of characters in a font permanently, use the Define Kerning 
command.

To change the tracking of a text block, use the Text Specs command or Object Info. You can also 
adjust tracking manually by holding down the Ctrl key and dragging the center control point 
on one end of the text block.

See Also
Define Kerning

Text Specs 

Text Palette 

Object Info



Kerning is a function which controls how a pair of characters is spaced.    Narrow kerning moves 
characters closer together and wide kerning moves them farther apart.



The Knife offset checkbox allows Flexi to compensate for the differences between how a pen plots and a 
knife cuts on older pen plotters. The correct offset depends on the size of the blade and the thickness of 
the media being used.

Check your cutter's user manual for the best setting for your cutter.



Label Palette    
The Label palette is a tear-off palette. It contains the tools used for measuring and labeling objects.

Measure tool

Straight Arrow tool

Bent Arrow tool

Horizontal Size tool

Vertical Size tool

Diagonal Size tool



Lasso (Paint Palette)    

The Lasso tool allows you to select an area within a selected black & white template by enclosing it 
freehand.

To select an area within a template by enclosing it freehand, first change to Paint mode by clicking
the Paint palette tool on the Draw palette.    Once in Paint mode, select the template by 
clicking it with the Arrow tool.    Next, select the Lasso tool and use it to draw a closed path 
around the desired area.    Everything inside the path is selected, including the background.

To select a rectangular area within the template, use the Selection Rectangle.

To select a template, first change to Paint mode by clicking the Paint palette tool on the Draw 
palette.    Once in Paint mode, click the template with the Arrow tool to select it.

To move a freehand portion of the template, select the area with the Lasso tool as described 
above.    Once the area is selected, move the Lasso tool over it until the cursor changes into 
an arrow.    Use the arrow to click and drag the selected area to the desired location.

To move a rectangular portion of the template, use the Selection Rectangle.

See Also
Paint palette

Arrow tool (Paint mode)

Selection Rectangle



Layout Menu Commands    
Show Fills

Show Path Direction

Show Bitmaps As

Show Preview

Show Rulers

Show Grid

Snap to Grid

Make Guide

Lock Guides

Release Guide

Hide Guides

Palettes

Drawing Size

Redraw



The Length entry box displays the length of the currently displayed media size. To change the length, 
type a new number in the entry box.



The Length entry box allows you to specify the default media length.

Do not increase this value beyond your cutter's maximum page length, or your media may skew when 
cutting. If your sign is longer than your cutter's recommended page length, Flexi will automatically split the
sign into pages when it is paneled.



Gamma controls the brightness in the midtones and highlights of the printed image. 



To delete a color, select its triangle and drag it below the line.



Line (Paint Palette)    

The Line tool draws straight lines at any angle on the selected black & white template.

To draw a straight line on a black & white template, first change to Paint mode by clicking the 
Paint palette tool on the Draw palette.    Once in Paint mode, select the template by clicking it 
with the Arrow tool.    Click the Line tool at the starting point of the desired line and drag the 
line to the desired length and angle.    Release the mouse button to finish the line.

To change the width of the line you are about to draw, double-click or hold down the Ctrl key and 
click the Line tool. Click on the desired line width in the dialog box which is displayed and 
click OK.

To draw a line on a color template, use the Pencil tool in the ColorTrace Options dialog box.

To draw a freehand line on a black & white template, use the Pencil tool.

To draw a filled rectangle on a black & white template, use the Paint Rectangle tool.

See Also
Paint palette

Arrow tool (Paint mode)

Pencil tool

Paint Rectangle tool

ColorTrace



Linearize (Path Edit Palette)    

The Linearize tool straightens a specified section of any path.

To straighten a section of a path:

- Select the Linearize tool.

- Click the tool on the beginning of the section you want to straighten. (You do not have to click
on a point.)

- Click the tool on the end of the section to be straightened.

- To move the section, drag either of the end points to a new location.

- Press Enter, creating a straight segment and deleting all control points between the points 
you selected.

- Repeat the above steps to straighten another section or click on another tool to finish 
straightening.

NOTE You can also straighten a segment on a path or segments on multiple paths by first selecting the 
end points with the Point Selection tool and then clicking either the Linearize tool or the icon for 
the straight segment type in Object Info.    As soon as you select the tool, all selected segments 
are straightened.

See Also
Point Selection tool

Editing Paths in Object Info



Lock Guides (Layout Menu)    
Locks and unlocks all guides.    A locked guide cannot be selected, moved or released.    A checkmark is 
shown next to this command when guides are locked.

See Also
Make Guide

Release Guide

Hide Guides



The Magic Wand selects a color within an area's boundary and all areas that are completely enclosed by 
the selected color. Also, this tool changes the selected color to the active color.



Magnifying Glass (View Palette)    

The Magnifying Glass zooms in or out on an area, magnifying or reducing the view.

Magnifying the View (Zooming In)
To double the size of the view, either click the Magnifying Glass on the point you want to be in the 

center of the window or click Zoom In (large mountain).

To zoom in on a particular area, use the Magnifying Glass to drag a box around it.

To zoom to the edge of the objects on your sign, double-click the Magnifying Glass on the drawing
area.

To zoom in on an object, click on the object with the Arrow tool to select it and then click Zoom to 
Edge (mountain with border).

To zoom to the edge of the drawing area, click on a blank portion of the drawing area to make 
sure nothing is selected and then click Zoom to Edge (mountain with border).    (If you wish to
leave objects selected, simply double-click Zoom to Edge.)

Reducing the View (Zooming Out)
To view the sign at half its current size, displaying a larger area, hold down the Ctrl key and click 

the point you want to be in the center of the window or click Zoom Out (small mountain).

See Also
Zoom Out

Zoom to Edge

Zoom In



When Maintain Proportions is selected, tiles are sized proportionally when you change either the height 
or width of a tile.



Make Arc (Path Edit Palette)    

The Make Arc tool changes any straight segment or curved segment into an arc. You can adjust the size 
and placement of the arc manually or specify its distance from the midpoint of the segment.

NOTE To reshape a section of a path which is made up of multiple segments, use the Optimize Curve 
tool.

Making an arc freehand
To change a single path segment into a circular arc by dragging:

- Double-click or hold down the Ctrl key and click the Make Arc tool.

- In the Make Arc Options dialog box which is displayed, click next to the Freehand button.

- Click OK.

- Click the Make Arc tool on the segment and drag in the direction you want the arc to go.

- Press Enter to finish the arc.

Making an arc by specifying the distance
To change a single path segment into a circular arc by specifying the distance between the baseline of the
curve and the midpoint of the arc:

- Double-click or hold down the Ctrl key and click the Make Arc tool.

- In the Make Arc Options dialog box which is displayed, click next to the Distance button and 
enter the desired distance in the entry box.

- Click OK.

- Click the Make Arc tool cursor (shaped like an arc) on the segment you wish to change and 
drag the mouse in the direction you wish to place the arc.

- Release the mouse button.

- Continue clicking and dragging arcs on each segment you wish to change. Click on any other
tool to finish making arcs.

See Also
Point Selection tool

Optimize Curve tool



Make Compound (Arrange Menu)    
Joins objects of the same color so they are handled as a single object, 'knocking out' overlapping areas.    
Also, changes a path into an object which can be edited using the commands on the Tools menu.

To join multi-colored objects, use the Group command.    (This will not 'knock out' overlapping 
areas.)

To join objects into a single graphic object which will not be separated later, use the Combine 
command.

To edit the points on a compounded path, use the Release Compound command.

To separate the items in a compounded object, choose the Release Compound command.

See Also
Group

Release Compound

Combine



Make Guide (Layout Menu)    
Changes selected uncompounded path into a guide.    You can also create a horizontal or vertical guide 
by clicking the Arrow tool on one of the rulers and dragging away from it.

To change a compounded path into a guide, use the Release Compound command first to 
uncompound it.    Then choose the Make Guide command.

To change a shape or text into a guide, first change it to paths using the Convert to Paths 
command.    Next, uncompound the paths using the Release Compound command and then 
choose the Make Guide command.

To change a guide back into a path, use the    Release Guide command.

See Also
Release Compound

Release Guide

Lock Guides

Hide Guides

Convert to Paths



Make Right Angle (Path Edit Palette)    

The Make Right Angle tool changes the angle of selected control points to 90° (right angle). This tool only 
affects points controlling straight segments.

To change the angle of one or more control points, select them with the Point Selection tool by holding 
down the Shift key and clicking each of them or by dragging across them. Once the points are selected, 
click on the Make Right Angle tool to change the angle at each selected point to 90° (right angle).

See Also
Point Selection tool

Editing Paths with Object Info



A margin is the space between the image being printed and the edge of the panel when the image is 
autopaneled.



Material Ink Setup (Color Printer Setup)    
Allows you to change the items listed for media type, media size, and ink type for each color printer setup.
You can add, delete, or modify items in each list. This dialog box also allows you to adjust Flexi's ink 
tracking system.

To display the Material/Ink Setup dialog box, click the Material/Ink button in Color Printer Setup.

Click on any item in the dialog box below for more information.

Return to Color Printer Setup



The size, height, length, media, and ink you are using are displayed in the materials information box. If 
you deselect the Get from Production Manager checkbox, you can edit the materials information.



Displays the current color printer setup's maximum page length.



Measure (Label Palette)    

The Measure tool measures distances when dragged and indicates distance from the origin of the rulers 
when clicked on the drawing area.

To measure an object or the distance between any two points, click the Measure tool on the first point and
drag it to the second point.    As soon as you release the mouse button, the Measure dialog box displays 
the following information

X1    First point's horizontal distance from the origin

X2    Second point's horizontal distance from the origin

Y1    First point's vertical distance from the origin

Y2    Second point's vertical distance from the origin

Horizontal Distance    Distance between the two points measured left to right

Vertical Distance    Distance between the two points measured up and down

Distance    Length of an imaginary line connecting the two points

Angle    Angle the imaginary line would have from the horizontal

To find out the distance of a point from the origin of the rulers, click the Measure tool on the desired point. 
The Location dialog box immediately displays the point's horizontal (X) and vertical (Y) distance from the 
origin.

See Also
Show Rulers



The Media list box allows you to choose the default media for the current color printer setup.



The media is the material on which you plot or cut your sign, such as paper or vinyl.



The Media setup list box displays all available media types for the currently selected printer. (For 
example, media types for a NovaJET include PhotoGloss and Backlist Heavy). To change the name of the
selected media type, highlight it an type the new name.



Menu Commands 
File Menu

Edit Menu

Arrange Menu

Layout Menu

Text Menu

Tools Menu

Help Menu



Merge Bitmap... (File Menu)    
Retrieves an existing bitmap file to be edited and printed or to be used as a template. See the table below
for a list of available file types.

To retrieve: Pick this format:
BMP BITMAP

DCX DCX

GIF GIF

JPeg JPEG

Paintbrush ZSoft PCX

PCX ZSoft PCX

Pict PICT

Targa TARGA

TIFF TIFF

PhotoShop PSD

PhotoCD PCD

To open a bitmap file:

1. Choose Merge Bitmap from the File menu. The Merge Bitmap dialog box appears. 

2. Choose a File Format, Drive, and Directory. 

3. Select a file from the list box. 

4. Click OK. 

5. Place the bounding box in the proper location and click the mouse button. Your bitmapped file is 
displayed and available for editing and printing.

See Also
Save

Save As

Scan

Scan and Trace

Outline tool

Centerline tool

PictureCut tool

Paint Palette

Show Bitmaps As

Return to File menu.



Merge... (File Menu)    
Retrieves an existing file into the current sign.

To choose the kind of file you want to open, use the File Type list box in the Open dialog box.

To retrieve: Pick this format:
BMP See Merge Bitmap

Clip Art Clip Art

CorelDRAW! 3.0 CorelDRAW! 3.0 EPS

DCX See Merge Bitmap

DesignCAD DesignCAD DC2

DXF DXF

FlexiDESIGNER FlexiSIGN PRO (enter *.fs) (from FlexiSIGN-PRO or FlexiDESIGNER)

FlexiFAMILY Clip Art

FlexiLETTER FlexiLETTER (enter *.fs) (from FlexiLETTER on up)

FlexiSIGN FlexiSIGN (enter *.fs) (from FlexiSIGN on up)

FlexiSIGN-Plus FlexiSIGN Plus (enter *.fs) (from FlexiSIGN-Plus on up)

FlexiSIGN-PRO FlexiSIGN PRO (enter *.fs) (from FlexiSIGN-PRO)

FreeHand 3.0 FreeHand 3.0 EPS

Generic CADD DWG

GIF See Merge Bitmap

HPGL HPGL

Illustrator 1.1 Illustrator 1.1 AI

Illustrator 88 Illustrator 88 AI

Illustrator 3.0 Illustrator 3.0 AI

JPeg See Merge Bitmap

Paintbrush (PCX) See Merge Bitmap

PCX See Merge Bitmap

PICT See Merge Bitmap

Targa See Merge Bitmap

Text-only Text

TIFF See Merge Bitmap

See Also
New

Open

Close

Merge Bitmap

Exit





Midpoint diamonds indicate the midpoint between the two colors that make up the gradient. By default, 
a midpoint diamond is located in the middle of the two colors, or at 50%. To change the percentage of a 
color, you can click and slide the diamond to the left or right, or select a diamond and enter a number in 
the percentage entry box.



Midtones are the pixels in the middle or the luminosity or brightness scale.



Color balance adjustments affect Midtones, Highlights, or Shadows. Changes to the Midtones are usually 
the most dramatic.



The mirror button controls the way the page is printed. 

 The image is not mirrored.

 The image is mirrored. If the page is in landscape orientation, it flips from left to right
If the page is in portrait orientation, it flips from top to bottom.



Mirror... (Arrange Menu)    
Flips the selection horizontally, vertically, or diagonally.

NOTE To cut an entire sign in reverse in order to apply to the inside of a window, use the Mirror option 
in the Cut/Plot dialog box.

The following options are available in the Mirror Options dialog box

Freehand    Click on one of the following icons to determine the direction the selection is mirrored:

Mirror horizontally    Drag the mirrored image of the selection in the desired direction to place it. 
To center the mirrored object directly on top of the original, hold down the Shift key and click.

Mirror vertically    Drag the mirrored image of the selection in the desired direction to place it. To 
center the mirrored object directly on top of the original, hold down the Shift key and click.

Mirror diagonally    Click on the point from which you wish to mirror the selection and drag to the 
desired angle. To center the mirrored object directly on top of the original, hold down the Shift
key and click.

Specify distance    Allows you to enter how far the mirrored object should be placed from the 
original.

Direction buttons    Allows you to choose the direction to mirror the selection; click the 
appropriate button to highlight it.    From left to right, the options are: mirroring horizontally, 
vertically, or on an axis.

Keep Original    This checkbox allows you to mirror a copy of the original, leaving the original in 
place.

See Also
Rotate



Mode Palettes    
Mode palettes control how you work with your sign, changing to Draw mode, Cut mode, or Paint mode.    
Each mode displays your sign differently and allows you to select and edit a unique aspect of it.    One 
mode palette must be displayed at all times.

Flexi has the following mode palettes

Draw Palette

Paint Palette

Cut Palette



Mode palettes control how you work with your sign, changing to Draw mode, Cut mode, or Paint mode.    
Each mode displays your sign differently and allows you to select and edit a unique aspect of it.    One 
mode palette must be displayed at all times.



The More button displays the Color Printer Options dialog box. 



Move Backward (Arrange Menu)    
Move the selected object backward one layer.

To move the selected object to the bottom layer, use the Move to Back command.

To move the selected object to the top layer, use the Move to Front command.

To move the selected object forward one layer at a time, use the Move Forward command.

See Also
Move to Front

Move Forward

Move to Back

Color palette



Move Forward (Arrange Menu)    
Move the selected object forward one layer.

To move the selected object to the top layer, use the Move to Front command.

To move the selected object to the bottom layer, use the Move to Back command.

To move the selected object backward one layer at a time, use the Move Backward command.

See Also
Move to Front

Move to Back

Move Backward

Color palette



Move to Back (Arrange Menu)    
Move the selected object to the bottom layer.

To move the selected object backward one layer at a time, use the Move Backward command.

To move the selected object forward one layer at a time, use the Move Forward command.

To move the selected object to the top layer, use the Move to Front command.

See Also
Move to Front

Move Forward

Move Backward

Color palette



Move to Front (Arrange Menu)    
Move the selected object to the top layer.

To move the selected object forward one layer at a time, use the Move Forward command.

To move the selected object backward one layer at a time, use the Move Backward command.

To move the selected object to the bottom layer, use the Move to Back command.

See Also
Move Forward

Move to Back

Move Backward

Color palette



Move... (Arrange Menu)    
Places the selected object or objects in the specified location.    Also, if the Copy button is clicked rather 
than the OK button, this command places a copy of the object in the specified location without changing 
the location of the original object.

The Move dialog box contains the following items:

Reference    Specifies the reference point relative to which the selection will be moved. This drop-
down list box contains the following options:

Absolute    Moves the object relative to ruler's origin.

Relative    Moves the object relative to its current position.

From Border    Moves the object relative to the borders of the drawing area. Click on the 
edges of the preview area at the right of the dialog box to highlight which borders should 
be used as a reference.

Distance, Angle    When Relative is selected, moves the object the specified distance and angle.

Horizontal, Vertical    Moves the object a specified horizontal and/or vertical distance.

Control point option buttons    Allow you to select which point on the object's bounding extent 
the Move command will use as a basis for measurement.

Preview display:    Displays how the object will move with the specified settings. When From 
border is selected, click on the preview display's border to specify which side should be used 
as a reference.

Copy button    Places a copy of the object in the specified location without changing the location 
of the original object.

You can also move an object by dragging or by nudging:

To move by dragging, select the object with the Arrow tool. Once the object is selected, click on it 
without clicking a control point and hold down the mouse button until the bounding extent 
appears around the object. Without releasing the mouse button, drag the object to its new 
location.

To nudge an object, select it with the Arrow tool and then press the arrow keys on the keyboard to 
nudge the object left, right, up, or down.

See Also
Nest

Arrow Tool



Multicolor Panel (Cut Palette)    

The Multicolor Panel tool selects the area that will be printed by the FlexiPRINT feature    This tool allows 
you to place one panel arounds bitmaps and objects of various colors.    By freehand paneling or by 
adjusting the page and strip divisions after autopaneling, you can control how the objects and bitmaps on 
your sign are divided.

CAUTION To print the panels you created, you must select them before opening the FlexiPRINT dialog 
box. If you do not, Flexi will disregard any paneling you have done and will autopanel the sign
before printing it.

To draw panels freehand, first change to Cut mode by clicking the Cut Palette tool on the bottom 
of the Draw palette.    Choose the Multicolor Panel tool from the Cut palette.    Click the tool at 
one corner of the area to be printed and drag it to the opposite corner, enclosing it.    When 
you release the mouse button, the panel is displayed.    If the panel is larger than the media 
currently loaded in your plotter, it is automatically divided into pages and/or strips.    Use the 
Arrow tool to adjust these dividing lines as described below.

To panel automatically, first change to Cut mode by clicking the Cut Palette tool on the bottom of 
the Draw palette.    Double-click the Multicolor Panel tool on the Cut palette.    In the dialog box
which is displayed, choose one of the following options:

- Objects:    Places the panels so it fits around all objects in the sign.

- Bitmaps:    Places the panel so it fits around all bitmaps in the sign.

- Objects and bitmaps:    Places the panel so it fits around everything in the sign.

- Use drawing border as panel:    Places the panel directly on the drawing border, so 
everything on the drawing area is printed, including any white space.

If you want a margin between the paneled objects and/or bitmaps and the edge of the panel, 
enter the desired width in the Margin entry box.    Click OK to display the panel.    If a panel is 
larger than the material currently loaded in your printer, it is automatically divided into pages 
and/or strips.    Use the Arrow tool to adjust these dividing lines as described below.

To panel objects for cutting or plotting, use the Panel tool.

NOTE The FlexiPRINT feature only recognizes multicolor panels created using the Multicolor Panel 
tool. You cannot use panels created with the regular Panel tool for color printing.

Adjusting a panel
To adjust the placement of page or strip divisions within a panel, use the Arrow tool to click and 

drag one of the small black control points on the division line.

To add a new dividing line to a panel, drag one of the small black points on an outside edge to the 
desired location.    For a horizontal dividing line, drag from the top or bottom edge; for a 
vertical dividing line, drag from the left or right edge.

To mark a page so it will not be printed, click the Arrow tool in the center of the page.    An X will 
appear across the page.    To remove the X, click the page again.

See Also
FlexiPRINT

Cut palette



Arrow tool

Panel tool

FlexiPRINT tool



Nest (Arrange Menu)    
The Nest command conserves material when printing or cutting by moving selected text and graphic 
objects into an optimum arrangement.

The following options are contained in the Nest Options dialog box:

Nest Size The Height and Length entry boxes display the size of the area to which the objects will be 
nested. To change the size of the nest area, enter new values in either of these entry boxes.

Spacing Enter the minimum amount of space allowed between nested objects.

Text Objects    When this option is selected, text remains together as a text block. When this option is not
selected, text breaks apart into characters and is converted into paths.

Using the Nest command
1. Select the objects to be nested. All selected objects must be the same color.

2. Choose Nest from the Arrange menu.

3. Change the settings in the Nest Options dialog box as desired.

4. Click Go.

5. Click your mouse to place the nest box on the drawing area.

6. If desired, drag the nest box's handles to size the nesting box.

7. Press Enter or click the right mouse button to display the nested objects.

See Also
Move



You can create a new fill by clicking New. Edit the default fill, rename it and click Done to add it to the 
Color palette.



The New Ink button adds a new ink based on the current ink displayed. For example, if CMYK Inkjet 
cartridge is displayed, clicking this button creates a new ink called CMYK Inkjet Cartridge-1.



The New Preview displays your bitmap after the color correction. If you click on the New Preview, your 
image is reset to its original.



The New Setup button creates a new setup that is called 'User Setup.' Type a new name in the Setup list
box if desired.



The New Size button adds a new size based on the current size displayed. For example, if Standard is 
displayed, clicking this button creates a new size called Standard-1. The new size will have the same 
Height and Length as the size it was based on.



The New media button adds a new media type based on the current media displayed. For example, if 
PhotoGloss is displayed, clicking this button creates a new media type called PhotoGloss-1.



New... (File Menu)    
Opens a new Flexi file.    The new file has the name "Untitled".

Click the Auto Layout button to open a new sign using an existing Flexi sign as a master. 
(FlexiSIGN-PRO only.)

Click the Open button to open an existing Flexi file or to import a file created in another 
application.

See Also
Open

Close

Exit



Noise Cleaning (Paint Palette)    

The Noise Cleaning tool removes all stray marks in the selected area of a black & white template.    This 
tool is very good for cleaning up low-quality images, such as artwork which has been photocopied or 
faxed.

To remove stray marks from a selected area of a black & white template, first change to Paint 
mode by clicking the Paint palette tool on the Draw palette.    Once in Paint mode, select the 
template by clicking it with the Arrow tool.    Select the Noise Cleaning tool.    Click the 
crosshair cursor on the drawing area and drag a box around the area to be cleaned up.

To remove stray marks from a color template, use the Magic Wand and the Paint Bucket in the 
ColorTrace Options dialog box. Also, you may wish to adjust the Edge filter before posterizing
the image.

To delete an enclosed area within a selected template, use the Selection Rectangle or the Lasso 
tool to enclose the area and then press the Delete key.

To delete individual pixels within a template, use the Pencil tool.

To delete an entire template, select the template by clicking it with the Arrow tool. Press the Delete
key.

See Also
Paint palette

Arrow tool (Paint mode)

Paint Bucket

Selection Rectangle

Lasso tool

Pencil tool



Noise is any small mark on a template that does not belong there. This can include stray marks scanned 
in from a poor original, or in the case of a color template, areas of uncertain color at the boundary 
between two objects.



Normal Text Specs    
Allows you to create or edit normal text.    This dialog box contains the following options

Line spacing    In multi-line text blocks, changes the amount of space between the baseline of the
upper line of text and the baseline of the lower line of text.    Click the Manual option to enter 
a specific distance; click Automatic to use the default spacing for the current font and text 
size.

Tracking    Changes the spacing between all characters in a text block.    Normal tracking is 0%.    
For wider spacing, enter a number between 1 and 99%; for narrower spacing, enter a 
number between -1 and -99%.    This option applies to the entire text block.    (To change the 
space between individual characters, use manual kerning.)

Stretch    Changes the percentage of distortion applied to the length of the text block.    To stretch 
the text, enter a number between 1 and 99%.    To compact the text, enter a number between 
-1 and -99%.    This option applies to the entire text block.

Slant    Changes the angle at which selected characters slant away from their default position.    
Negative values slant characters to the left; positive values slant them to the right.

Text Entry Box    Located at the bottom of the Text Specs dialog box.    Any selected text is shown
in this entry box, and can be changed or added to using standard text editing functions.    
(These functions include dragging or double-clicking    the insertion tool to highlight text and 
using the Delete key to remove it.)    This area does not preview any of the text attributes.

Font    Changes the current typeface.    Using this list box, you can choose a font which was 
previously selected.    If the desired font is not listed, choose the Other option to display the 
Fonts dialog box.

Size    Changes the text height when a new value is entered in the entry box.

Alignment    Changes the arrangement of lines within a text block to Left, Center, or Right.    This 
option applies to the entire text block.

Orientation    Determines whether text is arranged in a horizontal row or a vertical column.

See Also
Font

Size

Alignment

Kern

Text Palette 

Object Info



You can specify the number of times the knife cuts the contour by entering a value in the Number of 
Passes entry box.



When you click OK, the dialog box closes and the changes you made are implemented.



Object Info    

Object Info displays the current position of the active tool.    If an object is selected, Object Info provides 
additional information which can be displayed by clicking the triangle in the upper right.    This information 
can be edited directly to change the attributes of the selected object.

To display Object Info, choose the Palettes command from the Layout menu.

The following options are available for Object Info:

Editing Text

Editing Paths

Editing Rectangles & Borders

Editing Circles & Ovals

Editing Panels

Performing Math Operations

See Also
Editing Text with Object Info

Editing Paths with Object Info

Editing Rectangles & Borders with Object Info

Editing Circles & Ovals with Object Info

Editing Panels with Object Info

Performing Math Operations with Object Info



If you need to adjust the way your pattern fills the object, you can enter a horizontal and vertical offset in 
the Horiz. and Vert. Offset entry boxes. When offsets are set to "0," your pattern begins tiling in the lower
left corner of the object.



Open... (File Menu)    
Retrieves an existing file.    To retrieve another file into the existing file, combining their contents, use the 
Merge command.

To choose the kind of file you want to open, use the File Type list box in the Open dialog box.

To retrieve: Pick this format:
BMP See Merge Bitmap

Clip Art Clip Art

CorelDRAW! 3.0 CorelDRAW! 3.0 EPS

DCX See Merge Bitmap

DesignCAD DesignCAD DC2

DXF DXF

FlexiDESIGNER FlexiSIGN PRO (enter *.fs) (from FlexiSIGN-PRO or FlexiDESIGNER)

FlexiFAMILY Clip Art

FlexiLETTER FlexiLETTER (enter *.fs) (from FlexiLETTER on up)

FlexiSIGN FlexiSIGN (enter *.fs) (from FlexiSIGN on up)

FlexiSIGN-Plus FlexiSIGN Plus (enter *.fs) (from FlexiSIGN-Plus on up)

FlexiSIGN-PRO FlexiSIGN PRO (enter *.fs) (from FlexiSIGN-PRO)

FreeHand 3.0 FreeHand 3.0 EPS

Generic CADD DWG

GIF See Merge Bitmap

HPGL HPGL

Illustrator 1.1 Illustrator 1.1 AI

Illustrator 88 Illustrator 88 AI

Illustrator 3.0 Illustrator 3.0 AI

JPeg See Merge Bitmap

Paintbrush (PCX) See Merge Bitmap

PCX See Merge Bitma



Optimize Curve (Path Edit Palette)    

The Optimize Curve tool optimizes a selected section of a path by replacing it with a single curved 
segment, smoothing the curve.    Using this tool, you can create a new curve freehand, create straight 
lines which are joined by an arc, or create a circular arc of any radius.

NOTE When you choose an option in the Optimize Curve dialog box, that option remains selected until 
you change it. (The Curve option is selected by default.) You do not need to open the Optimize 
Curve dialog box unless you wish to change the Optimize Curve tool's settings.

Creating a freehand curve
To replace a section of a path with a smooth curve:

- Double-click or hold down the Ctrl key and click the Optimize Curve tool.

- Click the Curve button and click OK.

- Click the crosshair at the beginning of the section of the path to be optimized. (You do not 
have to click on a control point.)

- Click the crosshair at the end of the section.

- To reshape the preview of the curve, move the direction handles; to change the length of the 
segment, drag the endpoints.

- Press Enter to optimize the curve.

Repeat the above steps to optimize another curve or click another tool to finish optimizing.

Creating a smooth arc
To create two straight segments with a circular arc connecting them:

- Double-click or hold down the Ctrl key and click the Optimize Curve tool.

- Click the Smooth arc button and click OK.

- Click the crosshair at the beginning of the section of the path to be optimized. (You do not 
have to click on a control point.)

- Click the crosshair at the end of the section.

- To change the length of the straight segments in the preview, click the control point on the arc
segment and drag it toward the corner.

- Press Enter to optimize the curve.

Repeat the above steps to optimize another curve or click another tool to finish optimizing.

Creating a 3-point arc
To replace a section of a path with a circular arc:

- Double-click or hold down the Ctrl key and click the Optimize Curve tool.

- Click the 3-point arc button and click OK.

- Click the crosshair at the beginning of the section of the path to be optimized. (You do not 
have to click on a control point.)

- Click the crosshair at the end of the section.

- To make the arc larger or smaller, click anywhere on the preview of the arc and drag it in or 



out.

- Press Enter to optimize the curve.

Repeat the above steps to optimize another curve or click another tool to finish optimizing.

NOTE You can smooth an entire path automatically using the Reduce Points tool.    Also, you can delete
individual points using the Delete Control Point tool.

See Also
Point Selection tool

Delete Control Point tool

Reduce Points tool



The orientation button controls the way the image is placed on the page, portrait or landscape. The 
default orientation is landscape, but if the image is too large to fit on the media, it will be placed in the 
portrait orientation instead.



The Original Preview displays the image before color correction. If you click on the Original Preview, the 
image reverts to the last change made.



The outer radius of a starburst measures the distance from the base to the tip of its points.



Outline (Autotrace Palette)    

The Outline tool automatically determines whether a template is color, grayscale, or black & white and 
then traces each shape, outlining it with closed, editable paths.    Outline tracing is ideal for images which 
will be cut in vinyl.

Once a template has been traced, the resulting paths can be edited normally using the tools in the Path 
Edit Palette.

To trace an outline around the shapes in a black & white or grayscale template, first open a 
template using the Merge Bitmap command or scan in an image using the Scan command.    
Select the Outline tool.    Drag the Outline tool's crosshairs from one corner of the area to be 
traced to the corner diagonally opposite it to trace it.    You can select all or part of the 
template.

To trace an outline around the shapes in a color template, first open a template using the Merge 
Bitmap command or scan in an image using the Scan or Scan and Trace command.    Select 
the Outline tool.    Drag the Outline tool's crosshairs from one corner of the area to be traced 
to the corner diagonally opposite it.    You can select all or part of the template. The 
ColorTrace dialog box is displayed. Posterize and edit the template as desired and then click 
OK to trace it.

To change the Outline tool's settings for tracing black & white or grayscale templates, double-click 
or hold down the Ctrl key and click the Outline tool.    In the dialog box which is displayed, 
choose the desired options and click OK.    (These options are discussed in the following 
section, Outline Tracing Options.)    

To scan an image and outline autotrace it in one simple step, use the Scan and Trace command.

To trace a line down the center of the shapes in a black & white template, use the Centerline tool.

To create special striping effects from the shapes in a black & white or grayscale template, use the
PictureCut tool.

Outline Tracing Options
Round Corners    Automatically rounds all corners which are detected in the template.    Toggles 

with Sharp Corners.

Sharp Corners    Automatically makes all corners detected in the template sharp.    Round corners
are traced as curve segments.

Corner Detection    Determines how aggressively Flexi will detect corners when autotracing.

Setting Result
None Recovers no corners

Less Recovers fewer corners

Normal Default setting; recovers corners accurately for most templates

More Recovers more corners

Most Recovers maximum number of corners; for templates with very uneven edges

Tolerance    Determines how closely the template is followed during tracing.    A higher tolerance 
value follows the curve more loosely and therefore produces fewer points.    If you scanned in
the artwork at 300 dpi, you probably do not need to adjust this value.    If you scanned at a 
higher resolution (e.g., 600 dpi) or your artwork is of poor quality, you may wish to set a 



higher tolerance so the image is traced less precisely.

Restore Defaults    Changes all settings in the dialog box back to Flexi's standard settings.

See Also
ColorTrace

Merge Bitmap

Scan

Scan and Trace

Point Selection tool

Path Edit Palette

Centerline tool

PictureCut tool



An outline is a closed path created around the selected object, including all holes.    For example, an 
outline of the letter O would have two paths, one outside the O and one inside it.



Oval (Shape Palette)    

The Oval tool draws ovals. Double-click this tool to choose options.

To draw an oval freehand, click the Oval tool at one edge of the intended oval and drag it 
diagonally to the opposite edge.    (To drag from the center of the oval to an edge, hold down 
the Ctrl key while dragging.)

To create one oval of a specific size, click the Oval tool once at the intended oval's lower left edge.
(To indicate the center point, hold down the Ctrl key while clicking.)    In the Oval Size dialog 
box which is displayed, enter the desired width and height and click OK.

NOTE If an oval appears on the drawing area as soon as you click, you need to choose to draw 
freehand.    Double-click or hold down the Ctrl key and click the Oval tool.    In the Oval Options 
dialog box which is displayed, click the Draw Freehand option and click OK.

To specify the dimensions of one or more identical ovals, double-click or hold down the Ctrl key 
and click the Oval tool.    In the Oval Options dialog box which is displayed, click the Specify 
Size option.    Enter the desired width and height and click OK.    The dialog box closes and 
the cursor changes to an oval of the specified size.    Click on the drawing area at the desired 
location for the center of each oval.    Click another tool to finish.

To create a circle, use the Circle tool.

See Also
Circle tool



If your job is to be printed in strips and pages, you can control the amount of overlap by entering a value 
in the Overlap entry box.



If a panel is longer than your plotter's page length, vertical lines divide it into pages.



Paint Bucket (Paint Palette)    

The Paint Bucket automatically fills an enclosed blank area on the selected black & white template.

To fill an enclosed area in a black & white template, first change to Paint mode by clicking the 
Paint palette tool on the Draw palette.    Once in Paint mode, select the template by clicking it 
with the Arrow tool.    Select the Paint Bucket and click it within the area to be filled.

To fill tiny holes or gaps in an area in a black & white template which is meant to be solid, use the 
Hole Filling tool.

To fill areas on a color template, use the ColorTrace feature.

CAUTION Only use the Paint Bucket on areas which are completely enclosed!    Otherwise you may fill a
larger area than you intended.

See Also
Paint palette

Arrow tool (Paint mode)

Hole Filling tool

ColorTrace



Paint Palette    

The Paint palette is a mode palette. It contains the tools used to edit a black & white template before 
tracing it. When Flexi is in Paint mode, only templates can selected or edited.

If you click the Paint Palette tool when a black and white bitmap is selected, the Paint palette is 
displayed.

If you click the Paint Palette tool when a grayscale or color bitmap is selected, the Bitmap Editor is
displayed. (FlexiSIGN-PRO only)

NOTE Tools in the Paint palette will only work on the currently selected template. To select a template, 
click it with the Arrow tool.

Arrow tool

Selection Rectangle

Lasso tool

Eraser tool

Pencil tool

Line tool

Paint Rectangle tool

Paint Bucket

Hole Filling tool



Noise Cleaning tool

Scale Template

Draw Palette



Paint Rectangle (Paint Palette)    

The Paint Rectangle tool draws filled rectangles and squares    on the selected black & white template.

To draw a filled rectangle on a template, first change to Paint mode by clicking the Paint palette 
tool on the Draw palette.    Once in Paint mode, select the template by clicking it with the 
Arrow tool.    Select the Paint Rectangle tool.    Click the tool on one corner of the intended 
rectangle and drag it diagonally to the opposite corner.    Release the mouse button to finish 
the rectangle.

To draw a filled square on a template, follow the directions above, but hold down the Shift key 
while dragging the Paint Rectangle tool.

To draw a freehand line on a template, use the Pencil tool.

To draw a straight line on a template, use the Line tool.

See Also
Paint palette

Arrow tool (Paint mode)

Pencil tool

Line tool



Palettes
Flexi has a number of palettes that allow you to quickly pick a tool or function directly from the Flexi 
window. Flexi contains four types of palettes:

Mode Palettes

Tear-off Palettes

Color Palette

View Palette



Palettes (Layout Menu)    
Displays a cascading menu with the following options:

Fixed Tool/Floating Tool:    Controls how the mode palettes, View palette, Color palette, Object 
Info, and Tool Info are displayed, toggling between Fixed tool and Floating tool.    When Fixed
tool is selected, these palettes cannot be moved, resized, or closed.    When Floating tool is 
selected, these palettes can be moved and resized and all except the current mode palette 
can be closed. (One mode palette must be displayed at all times.)

View Tools:    Hides and displays the View palette.

Colors:    Hides and displays the Color palette.

Tool Info:    Hides and displays Tool Info.

Object Info:    Hides and displays Object Info.

NOTE You can also hide most palettes by clicking the close box in the upper left of the palette.    The 
Draw, Cut, and Paint palettes cannot be closed this way because they are mode palettes.

See Also
View palette

Color palette

Tool Info

Object Info



Panel (Cut Palette)    

The Panel tool selects the area to be cut for each color using the Cut/Plot or Fill Plot features.    A sign can
be paneled manually (freehand) or automatically.    By freehand paneling or by adjusting the page and 
strip divisions after autopaneling, you have complete control over how your sign will be cut.    You can 
keep objects from being split inappropriately and can even mark out blank areas to save vinyl.

CAUTION To cut your panels, you must select them before cutting.  If you do not, Flexi will disregard 
any paneling you have done and will autopanel the sign before cutting it.

To draw panels freehand, first change to Cut mode by clicking the Cut Palette tool on the bottom 
of the Draw palette.    Click the first color to be paneled in the Color palette, making it the 
active color.    Choose the Panel tool from the Cut palette.    Click the tool at one corner of the 
area to be cut in that color and drag it to the opposite corner, enclosing it.    When you release
the mouse button, the panel is displayed.    If the panel is larger than the media currently 
loaded in your plotter, it is automatically divided into pages and/or strips.    Use the Arrow tool 
to adjust these dividing lines as described below.

To panel automatically, first change to Cut mode by clicking the Cut Palette tool on the bottom of 
the Draw palette.    Double-click the Panel tool on the Cut palette.    In the dialog box which is 
displayed, choose one of the following options:

- Active color only:    Panels only the active color on the Color palette.

- Each color separately:    Places all of the objects for each color in a separate panel

- All colors together:    Places all of the objects in the sign in a single panel, regardless of 
color.

- Use drawing border as panel:    Places the panel directly on the drawing border, so all of 
the objects on the drawing area are cut, and any white space around them is preserved.

If you want a margin between the paneled objects and the edge of the panel, enter the 
desired width in the Margin entry box.    Click OK to display the panels.    If a panel is larger 
than the media currently loaded in your plotter, it is automatically divided into pages and/or 
strips.    Use the Arrow tool to adjust these dividing lines as described below.

NOTE The FlexiPRINT feature only recognizes multicolor panels created using the Multicolor Panel 
tool. You cannot use panels created with the regular Panel tool for color printing.

To panel bitmaps or to place objects of multiple colors in a single panel, use the Multicolor Panel 
tool.

Adjusting a panel
To adjust the placement of page or strip divisions within a panel, use the Arrow tool to click and 

drag one of the small black control points on the division line.

To add a new dividing line to a panel, drag one of the small black points on an outside edge to the 
desired location.    For a horizontal dividing line, drag from the top or bottom edge; for a 
vertical dividing line, drag from the left or right edge.

To mark a page so it will not be cut, click the Arrow tool in the center of the page.    An X will 
appear across the page.    To remove the X, click the page again.

See Also
Cut/Plot



Fill Plot

FlexiPRINT

Cut palette

Arrow tool

Multicolor Panel tool

Cut tool

Fill Plot tool

FlexiPRINT tool



A panel is the area selected for cutting for each color layer.



When the Panel to Drawing Border option is selected, Flexi uses the drawing border as a panel so that 
any white space around the selected images is preserved.



Paste (Edit Menu)    
Inserts the contents of the Clipboard into your sign. Items can be placed on the Clipboard using either the 
Cut or Copy commands.

When you choose the Paste command, a bounding box with the same shape and size of the object to be 
pasted appears on the cursor.    Click on the drawing area at the desired location to paste the object.

To immediately place a copy of the selection below the original, use the Duplicate command.

To make multiple copies of the selection, use the Step & Repeat command.

See Also
Cut

Copy

Duplicate

Step & Repeat



Path Create Palette    
The Path Create palette is a tear-off palette. It contains the tools used to draw paths.

Pen tool

Digitize tool



Path Direction (Tools Menu)    
Changes the direction of the selected path.    This command has the following options

Reverse    Switches the direction of the selected path.

Solid    Makes the selected path counterclockwise.

Hole    Makes the selected path clockwise.

Automatic    Determines the correct direction of the selected paths and changes them 
accordingly.    The innermost hole will be clockwise, the next path outside it will be 
counterclockwise, the next clockwise, etc.

NOTE The Automatic option automatically splits a path anywhere it crosses itself and changes all 
resulting paths to the same path direction.

To display all path directions, choose Show Path Direction from the Layout menu.

Counterclockwise paths are indicated with solid lines.    These paths should generally be on the 
outside.

Clockwise paths are indicated with dotted lines.    These paths should generally be on the inside.

See Also
Show Path Direction



Path Edit Palette    
The Path Edit palette is a tear-off palette. It contains the tools used to edit the paths created when you 
autotrace a template or when you use the Pen tool or Digitize tool, both found on the Path Create palette.

Point Selection tool

Linearize tool

Optimize Curve tool

Reduce Points tool

Sharp Corner tool

Round Corner tool

Make Arc tool

Cleaver tool

Scissors tool

Join Points tool

Delete Control Point tool

Add Control Point tool



Apply Length tool

Apply Angle tool

Align Horizontal tool

Align Vertical tool

Align Diagonal tool

Make Right Angle tool

NOTE FlexiLETTER does not include the Reduce Points tool.



A path is an uncompounded object consisting of straight and/or curved segments. A path can either be 
open (a line) or closed (a shape).



Pattern Options (Color Command Menu)    
Pattern fills are created by selecting objects in your drawing and then duplicating and repeating them so 
that they fill another object. Your pattern fill can contain colors and shapes. You can specify the size of the
items in your pattern and how they are spaced.

Use the Pattern Options dialog box to create a new pattern fill or to import a fill from the library. Choose 
Pattern Fill from the Color Command menu to open this dialog box.

Click on any item in the dialog box for a description. 

Return to Color Command Menu

See Also
Gradient Fill

Color Stripe Fill



When Pause between pages is selected, the printer pauses after a page has been printed. This allows 
you to cut off the printed pages before printing subsequent pages.



Pen (Path Create Palette)    

The Pen tool draws paths freehand.    Using the Pen tool, you can draw paths with straight segments, 
curved segments, and/or corner points.

Straight segment    Click the Pen tool on the point where you want the segment to begin and then
click a second time on the point where you want the segment to end.    To make a straight 
vertical or horizontal line, hold down the Shift key while clicking the second point.

Curved segment    To start the segment, click the Pen tool on the point where you want the 
segment to begin and then hold down the mouse button and drag in the direction you want 
the curve drawn.    To finish the segment, click the Pen tool on the point where you want the 
segment to end, hold down the mouse button, and drag away from the direction you want the
curve drawn. When you drag, a direction handle appears, rotating around the point where 
you clicked.    The direction bar's length determines the height of the curve and its angle 
determines the roundness and shape of the curve.

NOTE When you create a straight or curved segment in the middle of a path, you only have to create 
the second point of a segment. Flexi automatically uses the last point you chose as the first point
of the new segment.

Corner point    A corner point (cusp) connects a straight segment to a curved segment or one 
curved segment to another. (If you want to create a straight segment after a curved segment, 
you must create a corner point first.) To create a corner point between the segment you just 
finished and the next segment, hold down the Ctrl key while you either click or click and drag 
the second point on the new segment.

NOTE To change an existing point to a corner point, select it with the Point Selection tool and click the 
Cusp point type option in Object Info.

When you end a path created with the Pen tool, you can either leave it open or close it:

Open    When done, click any other tool or press Return.

Closed    When done, click the Pen tool on the start point of the path.

To attach two open paths that are a distance apart to form one closed path, click the Pen tool on the end 
point of the first path and then on the end point of the second one.    Do the same for the other end of both
paths.    Paths can also be connected using the Join Points tool.

See Also
Digitize tool

Point Selection tool

Join Points tool

Editing Paths with Object Info



Pencil (Paint Palette)    

The Pencil tool draws a line freehand and adds and deletes pixels for fine detail work on the selected 
black & white template.

To draw a freehand line on a black & white template, first change to Paint mode by clicking the 
Paint palette tool on the Draw palette.    Once in Paint mode, select the template by clicking it 
with the Arrow tool.    Use the Pencil tool to click and drag the desired line as if the tool were a
real pencil.    Release the mouse button when finished.

To change the width of the line you are about to draw, double-click or hold down the Ctrl key and 
click the Pencil tool. Click on the desired line width in the dialog box which is displayed and 
click OK.

To add or delete details from a black & white template pixel by pixel, first change to Paint mode by
clicking the Paint palette tool on the Draw palette.    Once in Paint mode, select the template 
by clicking it with the Arrow tool.    Select the Pencil tool and click it on blank areas to add a 
pixel or click it on dark areas to remove a pixel.

To draw a freehand line or edit pixels on a color template, use the Pencil tool in the ColorTrace 
Options dialog box.

To draw a straight line on a black & white template, use the Line tool.

To draw a filled rectangle on a black & white template, use the Paint Rectangle tool.

See Also
Paint palette

Arrow tool (Paint mode)

Line tool

Paint Rectangle tool

ColorTrace



If you select a color triangle, its location on the gradient bar is displayed in the percentage entry box. You
can also move the active triangle by entering a value in the entry box.

If you select a midpoint diamond, its location between the two color triangles is displayed. You can enter a
percentage in the box instead of dragging the diamond.



Performing Math Operations with Object Info    
Any field in Object Info that shows a numerical value also allows the entry of mathematical formulas. 
When a formula is entered, the results are automatically entered in the field and applied to the selected 
object.

The following mathematical operators can be used in Object Info

+ addition

- subtraction

* multiplication

** exponent (power)

Flexi also supports the following mathematical functions

Function Value Range
sin(x) any value (in degrees)

cos(x) any value (in degrees)

tan(x) any value (in degrees)

asin(x) from -1 to 1

acos(x) from -1 to 1

atan(x) any value

log(x) any value greater than zero

log10(x) any value greater than zero

sqrt(x) any value greater than zero

The formulas below are examples of the syntax that should be used for mathematical operations in Flexi.

(2+3)*3

2*sin(30)

2*(3**2)

log10(20)*3

See Also
Editing Text with Object Info

Editing Paths with Object Info

Editing Rectangles & Borders with Object Info

Editing Circles & Ovals with Object Info

Editing Panels with Object Info



Perspective Shadow    
Creates a perspective shadow around the selected text or graphic object.    Like a block shadow, a 
perspective shadow is stretched away from the original object, giving a 3-D effect to your sign.    With a 
perspective shadow, you can also vary the size of the shadow.    You can create a perspective shadow by 
either clicking and dragging the shadow in the preview display or by entering specific values for offset 
distance, angle, and depth.

NOTE Unlike block shadows, one perspective shadow is applied to all of the objects selected, rather 
than applying a separate shadow to each object.

The Perspective Shadow Options dialog box contains the following

Preview display    Shows the proportion of the specified shadow to the original object.    To 
change the shadow manually, move the cursor over this area until it changes into a Hand 
tool.    With the Hand tool, you can click and drag the shadow to any size or angle.    To 
change the angle of the shadow in 45° increments, hold down the Shift key while you drag.

Height,length    Shows the height and length of the original object.

Offset by percent    Measures the offset distance as a percentage of the total size of the original 
object.

Offset by size    Measures the offset distance in the default unit of measure, for example, inches.

Horizontal offset    Determines how far the shadow is placed to the left or right of the original 
object.    A negative value places the shadow to the left of the original object.

Vertical offset    Determines how far the shadow is placed above or below the original object.    A 
negative value places the shadow below the original object.

Angle    Determines the angle of the shadow from the original object, changing the shadow's 
horizontal and vertical offset at the same time.

Depth    Determines how far back the shadow is placed from the original object.    This value does 
not change the angle.

Relief    Determines how the shadow is cut out from the original object.    See Relief Options later 
in this topic.

Distance    When the offset or directional relief options are selected, determines the width of the 
space between the shadow and the original object.

Boundary shadow    Cuts out the inside of the original object, leaving an outline of the width 
specified in the Boundary thickness entry box. This option is only available when one of the 
following relief options is selected:    None, None with backing, Surround, or Offset surround.

Boundary thickness    When Boundary shadow is selected, specifies the width of the shadow's 
outline.

Color    Determines the color of the shadow.

Relief Options
None    Cuts out the shadow from the original object with no gap between that object and the shadow. 

None with backing    Does not cut out the shadow, but instead welds it with a duplicate of the original, so 
there are two layers of vinyl for the original object. 

Offset relief  Cuts out the shadow from the original object and offsets all adjoining edges by a specified 
distance.

Directional relief    Cuts out the shadow from the original object and offsets it from that object, taking into 
account the angle of the shadow from the original to create a 3-D effect. With directional relief, the 
distance specified by the user indicates the farthest distance the shadow will be offset from the original.



Surround    Places a shadow around all sides of the original object.

Offset surround    Reverse of offset relief. Cuts out the shadow from the original object and then widens 
it by a user-specified distance around all edges, surrounding the object.

Directional surround    Reverse of directional relief. Cuts out the shadow from the original object and 
then widens it around all edges. The distance by which the shadow is widened varies according to the 
angle of the shadow to the original object to create a 3-D effect.

See Also
Shadow

Drop shadows

Block shadows

Cast shadows



Photo Mask (Tools Menu)    
A Photo Mask is created by placing an object over a bitmap and then cutting away the portion of the 
bitmap not covered by the object.

To create a Photo Mask:

1. Import a bitmapped image using the Merge Bitmap or Scan commands.

2. Create an object and move it to the desired location on the bitmap. 

3. Select the bitmap and object using the Arrow tool.

4. Select PhotoMask from the Tools menu. Your bitmap takes the shape of the object.

You can apply a stroke to the object you used to create the bitmap, if desired, to create an outline effect.

See Also
Merge Bitmap

Scan

Stroke

Inline/Outline



PictureCut (Autotrace Palette)    

The PictureCut tool draws a series of stripes of varying widths over black & white or grayscale templates, 
creating a special effect.    Excellent for images such as scanned photographs of people, as this effect 
creates the illusion of depth.

Once a template has been traced, the resulting paths can be edited normally using the Point Selection 
tool and the Path Edit Palette.

To create a special striping effect from a template, first open the template using the Merge Bitmap 
command or scan in an image using the Scan command.    Select the PictureCut tool.    Drag 
the PictureCut tool's crosshairs from one corner of the area to be traced to the corner 
diagonally opposite it.    You can select all or part of the template.    When you release the 
mouse button, the PictureCut Options dialog box is displayed.    Choose the desired options 
and click OK.    (This dialog box is discussed in the following section, PictureCut Options.)

To trace an outline around the shapes in a template, use the Outline tool.

To trace a line down the center of the shapes in a template, use the Centerline tool.

PictureCut Options
Stripe Spacing    The amount of space between each of the stripes.

Darkness    Determines how light or dark the finished image will be.    Each stripe has a black area
on one side and a white area on the other.    When the darkness value is 50%, these areas 
are the same width.    When it is 0%, the black disappears and the white is twice as wide; 
when it is 100%, the white goes away and the black is twice as wide.

Template width    Displays the width of the area you selected with the PictureCut tool.

Template height    Displays the height of the area you selected with the PictureCut tool.

Result width    Determines the width of the finished image.    This option allows you to resize the 
image while tracing it.

Result height    Determines the height of the finished image.    This option allows you to resize the
image while tracing it.

Horizontal    Stripes the selection horizontally.    Toggles with Vertical.

Vertical    Stripes the selection vertically.    Toggles with Horizontal.

Invert Picture    Reverses the dark and light areas in the finished image.

Use less memory    Creates wider stripes and follows the template more loosely. This option is 
useful if you have a template with too much detail or if file space is at a premium.

Image enhancement    Creates medium-width stripes and traces the template with a moderate 
level of accuracy.

More image enhancement    Creates narrow stripes and traces the template with a high level of 
accuracy. This option usually produces the clearest results, but also creates the largest files.

See Also
Merge Bitmap

Scan

Point Selection tool



Path Edit Palette

Outline tool

Centerline tool



Plotter Options    
Allows you to change special options for your plotter setup. This dialog box is displayed by clicking the 
Options button in either the Cut/Plot or Fill Plot dialog box.

Device    The name of the currently selected cutter or plotter and which port it is connected to.

Device's max. length    The maximum length of material the selected cutter or plotter can handle 
accurately, without skewing the material.

Get size from Production Manager    Tells Flexi to display the media height and length entered 
for the selected cutter or plotter in Production Manager. If this box is checked, you have to go
to Production Manager to changes these values; if it is not checked, you can either type in 
new values or click the Poll Size button to display the size of the currently loaded media.

Media height and length    The height and length of the media currently loaded in your plotter or 
cutter.

Overlap    Used for panels with multiple strips. In each panel, a band of the specified Overlap 
width will be cut twice, once on each side of the split line between each pair of strips. This 
allows you to overlap the pieces of any split objects in your sign when you mount them. (If the
Overlap between pages option is selected, the same Overlap width will be applied to each 
page and its neighbor.)

Copy spacing    The margin around all four sides of each copy that is cut. Used when cutting 
multiple copies and for step & repeat cutting.

Easy Weed Margin    The margin between the objects being weeded and the Easy Weed border.

Easy Weed Minimum size    The smallest height or width of a text character or graphic object for 
which Easy Weed will cut an individual border.

Easy Weed Overcut length    The distance Easy Weed will cut beyond each weeding border 
intersection.

Margin    The space between the objects on each page and the weeding border.

Number of passes    The number of times the knife cuts each object on your sign, including the 
weeding borders. Unless you are cutting very thick media, one pass is usually enough.

Overlap between pages    Tells Flexi to apply the Overlap value between pages as well as 
between strips. (See Overlap above.)

Cut holes first    Tells the cutter to cut the holes in graphics or in characters such as p or o before 
cutting the outer part of the graphic or character.    This option is useful for cutting small text 
or routing paths.    To see where the holes are, choose Show Path Direction from the Layout 
menu.

Pause between colors  Used with the Plot all colors option in the Cut/Plot or Fill Plot dialog box.   
Tells the plotter to pause when it has finished each color. This allows you to change the pen 
or media when plotting a multi-color sign.

Pause between pages    Tells the cutter to pause after each page and/or strip is finished.    This 
allows you to cut off each page and weed it while the next page is being cut.

Display color info    When the user clicks Cut in the Cut/Plot or Fill Plot dialog box, displays a 
dialog box showing all of the vinyl information for the color layer which is about to be cut.

Restore Defaults button    Returns all plotter options to Flexi's standard settings.

Poll Size button    For plotters that support interactive cutting, returns information on the actual 
height and length of the currently loaded media and displays it in the Media height and length
fields.

More    Displays advanced plotter options. For most users, the default values of these options will 



give the best results.

Curve quality    Controls the mathematical accuracy with which Flexi cuts curves. Best, Faster,
and Draft are preset to give you a range from more accurate (Best) to faster (Draft). To 
enter your own value, click User and type a number in the entry box.

Optimize cut order    Speeds cutting/plotting by plotting the sign in sections of the specified 
length, cutting all of the objects in one section before continuing to the next section. To 
change the length of the sections Flexi uses to optimize plotting, enter a new value in the 
entry box. Turning this option off forces the objects in each color layer to cut in the order in 
which they were created. Optimize cut is selected by default.

Cut page/strip crossings    For stencils. Cuts a cross at each page/strip intersection.

NOTE The Cut page/strip crossings option is in FlexiSIGN-PRO only.

Plot dimensions and labels    Plots dimensions added with the Size tools (Vertical, 
Horizontal, and Diagonal) on the Label palette. By default, labels do not plot.

NOTE The Plot dimensions and labels option is in FlexiSIGN-PRO only.

See Also
Cut/Plot

Fill Plot



Plotter Setup (Setup, Edit Menu)    
Allows you to create, modify, and delete plotter setups on the displayed port setup as well as to move the 
port setup to another port. Before plotting your first sign, you need to create a setup for each of the cutters
or plotters that will use each port. Each plotter setup contains the brand and model of the plotter, the 
height and width of the plotting area, and how the plotter will communicate with your computer. 

Click on any item in the dialog box below for more information.

See Also
Plotter Options
Preferences



Point Selection (Path Edit Palette)    

The Point Selection tool selects points or segments on uncompounded paths.    You can also edit paths 
using the Point Selection tool.

Selecting points
To select a point on an uncompounded path, click on it with the Point Selection tool. To select 

multiple points, hold down the Shift key while clicking.

NOTE If you cannot select a single point, the path may be compounded.    To correct this, choose 
Release Compound from the Arrange menu.

To select all points on a path, hold down the Ctrl key and click on the path with the Point Selection
tool.

Selecting path segments
To select a segment on an uncompounded path, click on it with the Point Selection tool. A large 

circle appears at the segment's midpoint.

Editing paths
To change the length of a straight or curved segment, use the Point Selection tool to drag one of 

its control points.

To change the shape of a curved segment, click and drag the curve itself using the Point Selection
tool.    Another method is to show the direction handle for the segment by clicking on the 
control point at the beginning or end of the segment and then dragging the direction handle to
change the curve shape.    You may have to alter the direction handles at both ends of the 
segment.

To reshape a path at a point by making the two ends of a direction handle move separately, hold 
down the Ctrl key as you click the Point Selection tool on the control point.    This is a toggle--
to make the ends move together again, repeat the process.

To connect two open paths, use the Join Points tool. You can also click the Pen tool on the end 
point of the first path and then on the end point of the second path.    To close the resulting 
path, do the same for the other end of both paths.

See Also
Release Compound

Convert to Paths

Path Create Palette

Pen tool

Join Points tool



The Poll Size button displays the actual height and length of the currently loaded media in the Height 
and Length entry boxes.

For Poll Size to work, Production Manager must be connected to a copy of Flexi, your plotter must be 
turned on, on line, and connected to a serial port, and your media must be loaded. Also, not all plotters 
support interactive features. See your plotter's user manual for more information.



A polygon is a closed object with three or more sides.



The Port list box allows you to choose a different port for the active port setup. Only ports that do not 
already have a setup are displayed in the list box. If you change the port setting, it will change for all of 
the associated plotter and color printer setups.



Posterizing is the process of reducing the number of colors in a color template in order to produce a 
clean, simple trace.



Preferences... (Edit Menu)    
Allows you to change and save Flexi's default settings. The following options are included in this dialog 
box:

Scroll amount:    Determines how far the sign moves each time you click a scroll bar.

Auto-save:    When Yes    is selected, Flexi saves your sign automatically. Enter a new number to 
change how frequently files are saved.

Grid size:    Specifies how much space appears between each point on the grid.

Gray outside of drawing area:    Determines whether the window around the drawing area is 
gray (selected) or white (not selected).

Print buffer size:    Controls how much information is sent to your printer at one time. For most 
printers, the default setting of 100% is correct. However, printers with limited memory may 
have difficulty with large, compounded objects. To solve this problem, reduce the print buffer 
size to 50% or 75%.

Default Drawing Directory:    Specifies the preferred directory in which to save files.    If you use 
the Open, Merge, or Save As commands, the default drawing directory will be opened first.

Units-Default:    Determines whether Flexi uses the English or metric system.    Every default 
value in the program, including ruler units and default values in dialog boxes, is affected by 
your choice.

Units-Drawing:    Determines the unit of measurement for all objects except text.

Units-Text:    Determines the unit of measurement for all text.

Font size based on capital height of:    Determines the reference letter on which font size is 
based (default L), as measured from that letter's capital height.    For example, if you need a 
2-inch-tall W, enter W in this box and choose inches as the text unit.    Using a reference letter
does not make all characters the same size as that letter.    It simply tells you the exact height
of that letter, with the size of the other letters adjusting in relation to it.

Font cache:    Sets up a separate memory location for the fonts.    If your system has a large 
number of fonts, increasing this value can speed up text handling.    The default value of 
200KB is good for 10-20 fonts; if you have 100 fonts installed, you may wish to increase this 
value to as much as 1MB (1000KB).    This value is limited by how much memory is available 
on your computer.

Dictionary:    Specifies the dictionary used by the spell checker.    Click the Choose button to 
display the standard file selection box.    Click the desired dictionary file to select it and click 
OK.    (The default dictionary file for the US is named USENG.NDX.)

NOTE You cannot select a dictionary in FlexiLETTER.

Restore Defaults:    This button changes all of the preferences to Flexi's original default settings.

Save All Preferences:    This button tells Flexi to keep all of the preferences settings so they will 
already be set up the next time you open Flexisign-Pro.    Preferences outside of this dialog 
box that are saved include

- Colors added to the Color palette

- Palette options (displayed or hidden, location)

- Drawing size

- Position and display of the rulers and grid

- Location and size of the Flexi window

- Fonts added to the Font list box



- Sizes added to the Size list box

- Active color (saved to default)

See Also
Open

Merge

Save

Save As



The preview of the selected fill is displayed when Show Preview is checked.



The active fill is displayed in the preview. You can also change the angle of the fill by clicking and 
dragging within the display.



You can see your pattern fill in this preview.



The preview displays the pages to be printed. Click the scroll bar to see additional pages. The current 
page is surrounded by a solid line.



Previous View (View Palette)    

Previous View returns to the last view of your sign that was displayed.

To return to the last view, click the Previous View tool.

See Also
Magnifying Glass

Zoom Out

Zoom to Edge

Zoom In



Click the Print button to rasterize the current page. The button reverts to Abort while the job is 
processing. When the job is rasterized -- the Print button appears again -- you can go to Production 
Manager.



Print Font Catalog (Font, Text Menu)
Allows you to print a catalog of either the fonts currently highlighted in the Fonts dialog box or of every 
font installed on your computer. You can choose to print out one font per page, showing every character in
the font, or six fonts per page, showing the Fonts dialog box's display sample for each font.

To select multiple fonts which are listed consecutively, click on the first font in the list to select it, 
then hold down the Shift key and click on the last font. Click the Print button.

To select multiple fonts which are not listed consecutively, hold down the Ctrl key and click on 
each font.

Print Font Catalog Options

One font per page (left icon)    This button prints one font per page, showing every character in the font. 
(When this option is selected, a blue box appears around the icon.)

Six fonts per page (right icon)    This button prints six fonts per page, showing the Fonts dialog box's 
display sample for each font. (If Include styles is selected, this icon changes to show each style.) (When 
this option is selected, a blue box appears around the icon.)

Include styles    When selected, this checkbox causes Flexi to include every style of each selected font in
the font catalog. If it is not selected, only the Regular style of each font will be included.

Cancel    Closes the Print Font Catalog dialog box without printing a catalog.

Print All    Sends a font catalog of every font which you have installed on your computer to the current 
printer.

Print Selected    Sends a font catalog of the fonts currently highlighted in the Fonts dialog box to the 
current printer.

See Also
Print

Font



Print Setup... (File Menu)    
Sets default printer, paper size, orientation, scale, and other printer options for standard printers. See your
Windows and printer manuals for more information on this dialog box, which varies according to the 
printer selected.

To set up a large-format color printer, use the Color Printer option of the Setup command on the 
Edit menu.

NOTE Do not reduce or enlarge the sign from this dialog box. To change scaling, use the Print 
command.

See Also
Print

Setup



Select Print as separations to print each of the selected colors in black on a separate sheet.



Check Print substrate color if you want your drawing's background color to print.



Print... (File Menu)    
Prints the current sign using the specified options. You can print either a composite image (default) or 
separations.

NOTE If Show Fills is off, filled objects will be printed as outlines. Turn this option on to print filled 
objects with fills.

To print all of the visible colors on the sign at one time, choose Composite from the Print as list 
box in the Print Options dialog box (discussed below) and then choose either the Fit to Paper
or the Scale option.    (Invisible colors are not printed.)

To print spot color separations directly, printing each color layer exactly as it is shown on the 
screen, choose Show All Colors from the Color Command menu and then choose the Print 
command from the File menu.    Select Separations from the Print as list box in the Print 
Options dialog box discussed below.

NOTE Before printing separations, be sure to use the Color Trapping or Stroke commands as needed. 
Also, FlexiLETTER cannot print separations.

Print Options
Preview display:    Displays the sign and allows you to use the Print tools to change the area printed or 
the area viewed.    If the Show Templates command is checked, any open templates are also displayed for
printing.    Use the scroll bars below and to the right of this display to view more of the sign.

Drawing Width, Length:    Displays the total width and length of your design.

Printable Area Width, Length:    Displays how large an area can be printed with the selected printer and 
paper size.    To change the selected printer or paper size, use the Print Setup command.

Print tools:    These tools allow you to use the preview display to change the portion of the sign which is 
printed or change your view of the sign.

In a scaled print, moves the heavy lines which mark the edges of the area to be printed.    In a tiled print, 
moves the tiling grid to control what is printed on each page.

Zooms in on an area when clicked or when used to drag a box around an area.    Hold down the Ctrl key 
and click this tool to zoom out.

Moves the view in the direction and distance that it is dragged.

Displays the entire sign.
Print as:    This list box allows you to select either Composite or Separations.    Composite prints all of the 
visible colors on the sign at one time, and Separations prints spot color separations.    Before printing 
separations, be sure to take care of any necessary color trapping or stroking.

NOTE FlexiLETTER cannot print separations.

Fit to paper:    Automatically scales the design to fit on the selected paper size.

Scale:    Allows you to select how much the design is scaled for printing.    When this option is selected, 
you can either enter a value in the Ratio entry box or choose one of the options on the list box below it.    



(Any value chosen from the list box is automatically displayed in the Ratio entry box.)

Overlap:    For tiled print jobs, determines how much each page overlaps.    A strip of this width will be 
printed on both of the common sides of the tiles, allowing you to overlap pages to align them.

Offset:    In composite scaled print jobs, determines how far from the edge of the highlighted side of the 
page the design will print.    To offset the design from one side of the page, choose the Scale option, hold 
down the Ctrl key, and click the preview display to zoom out.    Choose the 4-headed arrow tool and click it
on the edge from which you wish to offset the design.    When that edge is highlighted, the Offset box 
undims.    Enter the desired value.

Include job info:    When using the Fit to paper option on a composite print job, selecting this checkbox 
prints all job information at the top of the page. The area in which the job info will be printed is shown as a
gray area at the top of the preview display.

Drawing border:    When composite printing, this checkbox automatically prints a border around the 
design that is the same size and proportion as the border on the drawing area.

Bitmaps:    Automatically prints all open bitmaps, showing them in the preview display and taking their 
size into account for the overall print job.

NOTE FlexiLETTER cannot print bitmaps.

Underlay:    When printing separations, allows you print all visible colors on one page as an underlay.    To
turn off a color so it is not printed in the underlay, hold down the Shift key and click the color in the Print 
Options dialog's Color palette.

NOTE FlexiLETTER cannot print an underlay.

Registration marks:    When printing scaled composite jobs, clicking this checkbox automatically places 
crop marks in all four corners and along the sides of each page printed.    When printing separations, 
clicking this checkbox automatically places registration marks in all four corners and prints the file name 
and color on the top and bottom of the page.

Print cutting panels    Prints any panels created in Cut mode.

Margins button:    Displays a dialog box in which you can enter the top, bottom, left, and right printing 
margins, as measured from the outside of the page.    The margins change the printable area, outside of 
which nothing will print.    (The page margins are shown as a heavy black box around the design; the 
width of each side of this box reflects the actual margin size.)    This dialog box also includes a Default 
button; click this button to automatically enter the selected printer's default margins.

See Also
Print Setup

Color Trapping

Stroke

Color Command Menu

Show Fills

Show Templates



The active printer and its port is displayed here. Choose a new setup from the list box, if desired.



Displays the name of your Production Manager station.



Production Manager (Setup, Edit Menu)    

This option is only available if you are working on a Windows for Workgroups network. It allows you to 
select the Production Manager to which you will cut or plot.

NOTE Before you select this option, make sure that Production Manager is installed and set up on the 
computer you wish to choose.

The following options are provided in the Default Device Setup dialog box:

On this computer    Sets Flexi up to cut from the computer where it is installed.

On another computer    Allows you to choose any Production Manager station on the network.

No connection    Allows you to run Flexi without connecting to a Production Manager station.

See Also
Plotter Setup



Click on the Production Manager Icon to bring its window to the top. Click on the FlexiSIGN-PRO title 
bar to return to the FlexiPRINT dialog box.



RIP Options (FlexiPRINT)    
When you send a file to print, the image you see on the screen is first converted into dots that can be 
printed with process (CMYK) colors.

When you choose a printer, the optimum RIP settings are activated. You can make adjustments to these, 
if necessary.

Click on any item in the dialog box below for more information on each option.

Return to the FlexiPRINT dialog box



The following RIP options are available:

Send then Print. Rasterizes the file and sends it directly to the printer.
Send Now. Rasterizes and prints simultaneously.
Hold in List. Rasterizes the files and places it on hold in Production Manager.
Save to File. Rasterizes the file and saves it to disk.



Radiant Striping    
Adds stripes to the selected object which radiate from a specified center point.

NOTE Any text which is striped is automatically converted to paths and can no longer be edited as text.

The Radiant Stripe Options dialog box contains the following items

Preview display    Shows how the selection will look with the currently specified striping.    To 
change the center point from which the stripes will radiate manually, move the cursor over the
center point in the preview and click and drag the center point to the desired position.

Invert    Reverses the colors of stripes and gaps, so stripes are shown in white and gaps are 
shown in color.

Center X    The horizontal center point from which the stripes will radiate.

Center Y    The vertical center point from which the stripes will radiate.

Number of stripes    Changes the number of stripes placed across the object.    (Unless Invert is 
selected, the stripes are shown in color and the gaps are shown in white.)

Radiant percent    Determines the proportion of the total object which is made up of stripes.

See Also
Even Striping

Gradient Striping

Circular Striping



The radius is the distance from the center of a circle or regular polygon to its edge.



Rectangle (Shape Palette)    

The Rectangle tool draws rectangles and squares.

To draw a rectangle freehand, click the Rectangle tool at one corner of the intended rectangle and
drag it diagonally to the opposite corner.    (To drag from the center of the rectangle to an 
edge, hold down the Ctrl key while dragging.)

To draw a square freehand, click the Rectangle tool at one corner of the intended square and hold
down the Shift key while dragging the tool diagonally to the opposite corner.

To create one rectangle of a specific size, click the Rectangle tool once at the intended rectangle's
lower left corner.    (To indicate the center point, hold down the Ctrl key while clicking.)    In the
Rectangle Size dialog box which is displayed, enter the desired width and height and click 
OK.

NOTE If a rectangle appears on the drawing area as soon as you click, you need to choose to draw 
freehand.    Double-click or hold down the Ctrl key and click the Rectangle tool.    In the 
Rectangle Options dialog box which is displayed, click the Draw Freehand option and click OK.

To specify the dimensions of one or more identical rectangles, double-click or hold down the Ctrl 
key and click the Rectangle tool.    In the Rectangle Options dialog box which is displayed, 
click the Specify Size option.    Enter the desired width and height and click OK.    The dialog 
box closes and the cursor changes to a rectangle of the specified size.    Click on the drawing 
area at the desired location for the center of each rectangle.    Click another tool to finish.

To create a rectangular border, use the Border tool.

See Also
Border tool



Red, Green, and Blue (RGB) is a color model that describes a color based on the quantities of red, green,
and blue it contains. RGB colors are additive because they combine to create white. The pixel for each 
color has an intensity value ranging from 0 (black) to 255 (white). When all three colors are at 255, the 
result is pure white.



Click the Redo button to cancel the last undo.



Redo (Edit Menu)    
Cancels the last Undo, reversing the results.

See Also
Undo



Redraw (Layout Menu)    
Refreshes the window. This command is useful when a new change is only partially displayed or does not
appear as you expected. If the change does not appear after you have applied the Redraw command, 
your edits may not have affected the object in the way that you expected.

See Also
Undo

Redo

Revert



Reduce Points (Path Edit Palette)    

The Reduce Points tool smoothes open or closed paths, automatically removing unnecessary control 
points.    This tool is excellent for cleaning up images which have been scanned or imported into Flexi and
then autotraced.

To reduce the number of points on an entire path automatically, select the path by clicking on it 
with either the Point Selection tool or the Arrow tool.    Click on the Reduce Points tool.    All 
unnecessary control points are deleted from the path.

NOTE To change the Reduce Points tool's settings, double-click on the Reduce Points tool or hold 
down the Ctrl key and click it.    Drag the scroll bar in the Point Reduction Options dialog box to 
change how tightly the new curve will follow the shape of the original curve.    (Tighter tolerance 
follows the original path more closely, keeping more points.    Looser tolerance allows larger 
curves with fewer points.)    Click OK to save the settings and smooth the selected path.

To smooth a selected section of a path, use the Optimize Curve tool.

To delete individual control points, use the Delete Control Point tool.

See Also
Point Selection tool

Optimize Curve tool

Delete Control Point tool



The reference angle is a value saved in Object Info which you can apply to any control point or segment 
either by clicking the Apply Ref button in Object Info or by using the Apply Angle tool. (You cannot apply 
the reference angle to a cusp.)



The reference length is a value saved in Object Info which you can apply to any segment either by 
clicking the Apply Ref button in Object Info or by using the Apply Length tool.



Registration Mark (Cut Palette)    

The Registration Mark tool places registration marks wherever it is clicked on the drawing area.    
Registration marks cut on every color layer of your sign and help you align objects from different color 
layers when you apply the finished sign to the substrate.

To choose the shape and specify the size of registration marks, first change to Cut mode by 
clicking the Cut Palette tool on the bottom of the Draw palette.    Next, double-click or hold 
down the Ctrl key and click the Registration Mark tool.    In the Registration Mark Options 
dialog box which is displayed, click next to the desired mark shape.    If you chose the cross 
or diamond shape, enter the desired width of each mark in the Size entry box.    Click OK.

To place a freehand registration mark on the drawing area, first choose the Freehand shape in the
Registration Mark Options dialog box as described above and click OK.    Click and drag the 
Registration Mark tool on the drawing area to place each mark.

To place a cross or diamond registration mark on the drawing area, first choose the desired shape
in the Registration Mark Options dialog box as described above and click OK.    Click the 
Registration Mark tool on the drawing area to place each mark.

See Also
Cut/Plot

Cut palette

Cut tool



The registration/crop marks menu includes the following choices:

- Registration marks (3 types)

- Crop marks

- No marks



Regular Polygon (Shape Palette)    

The Regular Polygon tool draws polygons in which all sides are the same length.

To draw a regular polygon freehand, double-click or hold down the Ctrl key and click the Regular 
Polygon tool.    Enter the desired number of sides in the first entry box and click the Freehand
option.    When the preview display shows the desired polygon shape, click OK.    Click the 
crosshair cursor on one of the corners of the intended polygon and drag it to enlarge or 
reduce the size of the polygon.    To change the angle of the polygon in 45° increments, hold 
down the Shift key while dragging.

NOTE If a polygon appears on the drawing area as soon as you click, you need to choose to draw 
freehand.    Double-click or hold down the Ctrl key and click the Regular Polygon tool.    In the 
Regular Polygon Options dialog box which is displayed, click the Freehand option and click OK.

To specify the size of one or more regular polygons, double-click or hold down the Ctrl key and 
click the Regular Polygon tool.    Enter the desired number of sides in the first entry box and 
click the Specify option.    Enter the desired radius and angle.    When the preview display 
shows the desired polygon, click OK.    The cursor changes to a polygon of the specified size. 
Click on the drawing area at the desired center point of each polygon.    Click another tool to 
finish.

To create a polygon with sides of different lengths, use the Freehand Polygon tool.

See Also
Freehand Polygon tool



Release Compound (Arrange Menu)    
Separates compounded objects.    Also, when applied to compounded paths, releases the object so its 
control points can be edited.

If you click on an object which appears to be compounded but the Release Compound command 
is dimmed, the object may be grouped. (Grouped objects have square control points; 
compounded objects have round control points.) To separate grouped objects, choose the 
Ungroup command.    If the Ungroup command is also dimmed, you will need to choose the 
Convert to Paths command from the Tools menu and then choose Release Compound.

NOTE Use the Release Compound command in order to edit text or shapes which have been 
converted to paths.    Most of the Path Edit tools will not work on compounded objects!

See Also
Group

Ungroup

Make Compound

Convert to Paths



Release Guide (Layout Menu)    
Changes selected guide into an uncompounded path.

NOTE    If you cannot select a guide to release it, all guides are locked.    Choose Lock Guides from the 
Layout menu to unlock them.

See Also
Make Guide

Lock Guides

Hide Guides



The Remaining entry boxes display the estimated amount of ink remaining for each color as a 
percentage of total capacity. To change this number, type in the correct percentage.

If you just replaced or refilled a cartridge, type 100% in the entry box for that color.



Click the Remove button to delete a fill from the Library. You cannot use the Remove button on the 
Current list.



Resize... (Arrange Menu)    
Changes the size of selected objects.

The following options are available in the Resize Options dialog box:

To resize the selection proportionally, make sure Maintain Proportions is selected.

To resize the entire sign by the same scale factor as the selection, click in the Scale All checkbox.

To resize the object to a specific measurement, enter the desired size in the Height and Length 
entry boxes. (If Maintain Proportions is on, only one of these values needs to be entered; the 
other one adjusts automatically.)

To resize the object by a certain scale factor, enter a percentage in the Scale Factor Height and 
Length entry boxes. (If Maintain Proportions is on, only one of these values needs to be 
entered; the other one adjusts automatically.)    Values greater than 100% enlarge the object, 
values less than 100% reduce it.

To specify a margin between the object and the specified dimensions, enter the space desired in 
the box labeled Margin.    If you do not want a margin around the object within the specified 
area, enter zero as the value.

To change the size of text, you can also use either the Size command or the Text Specs 
command, as well as Object Info.

To resize a template, use the Scale Template tool found on the Paint palette. (Templates can only 
be resized in FlexiSIGN-PRO and FlexiSIGN-Plus.)

See Also
Size

Text Specs

Scale Template



Revert (File Menu)    
Discards all changes made to the current file since the last save.

See Also
Close

Save

Save As

Exit



Rotate... (Arrange Menu)    
Turns an object around a fixed point.    The following options are provided:

- 90 degrees clockwise (CW)
- 90 degrees counterclockwise (CCW)
- 180 degrees
- Other displays the Rotate Options dialog box:

Freehand    Allows you to rotate the selection by dragging.    To use it, click Freehand and click 
OK.    Click the Arrow on the point around which you want to rotate the selection and then 
drag the bounding box to the desired angle.    (To rotate around the selection's center, hold 
down the Ctrl key while dragging.)

Specify Angle    Allows you to enter the exact rotation angle for the selection.    Negative values 
rotate it clockwise from the horizontal and positive values rotate it counterclockwise.    To use 
this option, click Specify Angle and enter the desired angle in the entry box beside it.    Click 
OK, and then drag the bounding box which appears to the desired position.    (To center the 
rotated object directly on top of the original, hold down the Shift key and click the mouse to 
place the bounding extent.)

Rotate to    Allows you to rotate the selection along an alignment line.    This option is excellent for 
straightening autotraced images which are skewed.    To use this option, click Rotate to and 
then select Horizontal, Vertical, or Other from the list box.    If you selected Other, enter the 
desired angle in the Angle entry box just below the list box.    Click OK, and then click and 
drag a line along the part of the object that you wish to align.    (For example, to straighten 
text, drag the line along its baseline.)    The object rotates as soon as you release the mouse 
button.

Keep Original  Rotates a copy of the selection without changing the original.    To turn this option 
on, click in this box to place an X in it.

NOTE To rotate a bitmapped image, use the Bitmap Editor. (FlexiSIGN-PRO only)

See Also
Move



Round Corner (Path Edit Palette)    

The Round Corner tool converts the intersection of two straight segments into a round corner.    Note that 
it will not convert the intersection of two curved segments--the intersecting segments must be straight.

To convert the intersection of two straight segments into a corner:

- If you plan to round several corners at once, hold down the Shift key and click on each of the 
corner points with the Point Selection tool.    Each selected point should turn into a filled black
circle.    (If you are only rounding one corner, you do not need to select it first.)

- Select the Round Corner tool.

- Place the tool over the corner point.

- Click and drag away from the corner until the circular extent shows the desired corner radius.

- Release the mouse button.    All of the selected corners take the same shape.

- Repeat the above steps to round more corners or click another tool to finish.

NOTE Instead of dragging to determine the radius of the corner, you can specify the radius by holding 
down the Ctrl key and clicking or double-clicking the Round Corner tool.    Enter the desired 
radius in the dialog box which is displayed and click OK. Next, click on each corner that you wish
to round.

See Also
Point Selection tool

Sharp Corner tool



Rulers are the guides which are displayed along the top and left of the Flexi window.    They help you 
measure and align text and graphics.    As you move a tool on the    drawing area, a tick mark on each 
ruler follows the movement of the cursor.



Drag the slider to the left or right to decrease or increase the saturation, or color intensity, of all the 
colors in the image.



Saturation controls the intensity of the colors in the printed image. Highly saturated colors are intense; 
desaturated colors are gray.



Save (File Menu)    
Saves the current file.

To save the file to a new name or to a different file format, use the Save As command.

See Also
Close

Save As

Revert

Exit



Save As... (File Menu)    
Saves the current vector file to another name, location, or file format.    The original file is not replaced.

To save the file to a new name, enter the name in the Save file as entry box in the Save As dialog 
box.

To save the file to a different vector format, choose Illustrator EPS, DXF, or Clip Art from the File 
Format list box in the Save As dialog box.

To save a bitmap file, use the Export Bitmap command on the File menu.

NOTE FlexiLETTER cannot open or save bitmap files.

See Also
Close

Save

Export Bitmap

Revert

Exit



Save Footer (Job, Edit Menu)    
Stores a new footer for the selected form. If you do not save a new footer, Flexi automatically places the 
statement "This price estimate is good for 30 days" in the center of the footer.

To save a footer, create the desired text and/or graphics using Flexi. Be sure to create the footer in black 
and white and in the actual size it will appear on the form. Once you are satisfied with how the footer 
looks, including the size and arrangement of the objects, select them, choose Job from the Edit menu, 
and then choose Save Footer from the cascading menu which is displayed. In the Save Estimation Footer
dialog box which is displayed, choose the form to which you wish to save the footer and click OK. The 
following options are provided:

Price Estimate-Itemized    This form can be used as an invoice for the customer. It is a complete 
price estimate breaking down all of the costs of the sign after markup. Contains all Job Info 
data except comments and keywords.

Price Estimate-Summary      A summary of the estimate showing only the subtotal, quantity, tax, 
and total price for the sign. Contains all Job Info data except comments and keywords.

Cost Analysis      Not for the customer! This form is identical to the price estimate, except that it 
breaks out the job cost (cost to you in time and materials), job price (amount charged to the 
customer), and gross profit.

See Also
Job

Job Info

Save Header



Save Header (Job, Edit Menu)    
Stores a new header for the selected form. If you do not save a new header, Flexi automatically places 
the name of the form in the center of the header.

To save a header, create the desired text and/or graphics using Flexi. Be sure to create the header in 
black and white and in the actual size it will appear on the form. Once you are satisfied with how the 
header looks, including the size and arrangement of the objects, select them, choose Job from the Edit 
menu, and then choose Save Header from the cascading menu which is displayed. In the Save 
Estimation Header dialog box which is displayed, choose the form to which you wish to save the header 
and click OK. The following options are provided:

Price Estimate-Itemized    This form can be used as an invoice for the customer. It is a complete 
price estimate breaking down all of the costs of the sign after markup. Contains all Job Info 
data except comments and keywords.

Price Estimate-Summary      A summary of the estimate showing only the subtotal, quantity, tax, 
and total price for the sign. Contains all Job Info data except comments and keywords.

Cost Analysis      Not for the customer! This form is identical to the price estimate, except that it 
breaks out the job cost (cost to you in time and materials), job price (amount charged to the 
customer), and gross profit.

See Also
Job

Job Info

Save Footer



The Saved Fills are those stored in your library.



Scale Template (Paint Palette)    

The Scale Template tool resizes the selected black & white, grayscale, or color template. This is a helpful 
feature when you are using a template as a reference over which you are designing your sign.

To make the size of the template match the size of your design, you can use the Scale Template 
tool to drag a comparison line along one side of your template and tell Flexi how long you 
want it to be.    For example, if you know that your sign needs to be exactly 3 feet high, drag 
the line from the top to the bottom of the template and then tell Flexi that it should equal 36". 
The entire template will then be resized proportionally.

You can also use the Scale Template tool for less specific enlarging and reducing.    For example, 
if you drag a 2" comparison line and then indicate that you want it to be equal to 1", your 
template will be reduced 50%.

To resize a template without typing a specific number, use the Arrow tool to click and drag one 
corner of the template until it is the desired size.

To resize a template, first change to Paint mode by clicking the Paint palette tool on the Draw palette.    
Once in Paint mode, select the template by clicking it with the Arrow tool.    Select the Scale Template tool.
Use the tool to drag a comparison line along the desired portion of the template. (For example, if you 
know that the template should be exactly 24" high, drag a line from the top to the bottom of the template.) 
In the dialog box which is displayed, enter how long you wish the indicated area to be (in the example, 
24") and click OK.    The entire template is resized proportionally.

See Also
Paint palette

Arrow tool (Paint mode)



Scan and Trace... (File Menu)    
Previews and scans a black & white, grayscale, or color image and automatically outline traces it with 
closed, editable paths.

NOTE Before selecting this command, set up your scanner by choosing the Setup command from the 
Edit menu and selecting one of the scanner drivers included with Flexi. To scan in a color or 
grayscale image, use the TWAIN driver provided by your scanner manufacturer. To scan in a line
art (black & white) image, choose one of the scanner drivers included with Flexi. FlexiSIGN 
cannot scan color templates; also, only FlexiSIGN-PRO and FlexiSIGN-Plus can trace color 
templates.

To scan an image without autotracing it right away, use the Scan command. Before tracing the 
resulting template, you can use the Paint Palette to edit it. (Color templates can only be 
edited in the ColorTrace Options dialog box included with FlexiSIGN-PRO and FlexiSIGN-
Plus.) You can then autotrace it with the Outline tool, the Centerline tool, or the PictureCut 
tool or manually trace it using the Digitize tool. (Grayscale templates can be autotraced using
the Outline tool or PictureCut tool; color templates can be autotraced in FlexiSIGN-PRO or 
FlexiSIGN-Plus using the Outline tool.)

The following settings are found in the Scan Options dialog box:

Brightness:    Lightens or darkens the image. Values range from 0% (dark) to 100% (light).

Contrast:    Softens or sharpens the image. Values range from 0% (soft) to 100% (sharp).

Resolution:    Increases or decreases the number of dots per inch (dpi) scanned in the image. 
The recommended setting is 300 dpi. If the artwork has numerous stray marks or large black 
areas, consider reducing the resolution.

Orientation:    Determines the rotation of the image in the template file. The landscape option (on 
the right) rotates the image 90 degrees.

To save your new template, use the Export Bitmap command on the File menu.

See Also
Merge Bitmap

Export Bitmap

Scan

Setup

Digitize tool

Paint Palette

Outline tool

Centerline tool

PictureCut tool

ColorTrace



Scan... (File Menu)    
Previews and scans a black & white, grayscale, or color image to be used as a template for tracing or as 
a guide for designing your sign.    Before selecting this command, set up your scanner by choosing the 
Setup command from the Edit menu.

To scan in a color or grayscale image, use the TWAIN driver provided by your scanner 
manufacturer.    (See the Setup command and your scanner's user manual for more 
information.)

NOTE FlexiSIGN cannot scan color templates.

To scan in a line art (black & white) image, choose one of the scanner drivers included with Flexi.

To scan a black & white, grayscale, or color image and outline autotrace it in one step, use the 
Scan and Trace command.

The following settings are found in the Scan Options dialog box

Brightness:    Lightens or darkens the image.    Values range from 0% (dark) to 100% (light).

Contrast:    Softens or sharpens the image.    Values range from 0% (soft) to 100% (sharp).

Resolution:    Increases or decreases the number of dots per inch (dpi) scanned in the image. 
The recommended setting is 300 dpi. If the artwork has numerous stray marks or large black 
areas, consider reducing the resolution.

Orientation:    Determines the rotation of the image in the template file. The landscape option (on 
the right) rotates the image 90 degrees.

To save your new template, use the Export Bitmap command on the File menu.

See Also
Merge Bitmap

Export Bitmap

Scan and Trace

Setup

Paint Palette



Scanner Setup (Setup, Edit Menu)    
Before scanning, you need to select the scanner you will be using. If you only have one scanner, once 
you specify its type and save a file or save your preferences, you will not need to select a scanner again.   
When you select the Scanner option from the Setup cascading menu, the Scanner Setup dialog is 
displayed.    Use the Select Scanner list box to set up your scanner.

NOTE Before you select this option, make sure the scanner is turned on and on-line.

To scan in line art (black & white) images, choose one of the scanner drivers included with Flexi, 
e.g., UMAX UC630. Or choose TWAIN and follow the steps below.

To scan in a color or grayscale image, choose TWAIN.    When you click OK, the Select Source 
dialog box is displayed.    Choose your scanner's driver and click OK again. (FlexiSIGN 
cannot scan in a color image.)

NOTE If the Option button undims, click it to open the Set Scanner I/O Address dialog box and set the 
I/O address. See your scanner manual for more information. This option is only available with 
scanners made by certain manufacturers, such as UMAX.

See Also
Scan

Scan and Trace

Preferences



Scissors (Path Edit Palette)    

The Scissors tool splits an open or closed path into separate open paths.

NOTE To use the Scissors tool on text or any shape except freehand polygons or autotraced objects, 
you must first select it and choose Convert to Paths from the Tools menu. Then select the 
objects and choose the Release Compound command from the Arrange menu. 

To make a single break, click the Scissors tool on the desired break point.

To make multiple breaks, click the Scissors tool outside the path beside the first split point and 
drag a cut line to the other side of the path beside the other split point.    Another method is to 
click outside the path beside the first split point, click again beside the second split point, and 
press Enter. Repeat the previous step to break another segment or click on another tool to 
finish.

To split a closed path into separate closed paths, use the Cleaver tool.

See Also
Convert to Paths

Cleaver tool

Release Compound



A scroll bar is the vertical or horizontal bar at the side and bottom of a window.    To move up and down or
back and forth on your sign, click one of the gray areas on the scroll bar.



A segment is a curved or straight section of a path that connects two neighboring control points.



Select All (Edit Menu)    
Selects all of the objects and text in your sign.    Flexi also has other methods for selecting objects, text, or
points.

Selecting objects
To select one object, click on the edge of it with the Arrow tool.

To select more than one object by clicking, hold down the Shift key while clicking on the edge of 
the object with the Arrow tool.

To select by dragging a box, hold down the mouse button and drag the Arrow tool to form a box 
over any part of the object(s) to be selected.

To select only objects which are completely enclosed in the box, hold down the Ctrl key while 
dragging the Arrow tool. This option is helpful when you have several objects layered on top 
of each other.

To select by dragging a box on an angle, hold down the Ctrl key and drag the Arrow tool to draw 
the first side of the box. Release the Ctrl key (but NOT the mouse button) and continue 
dragging to enclose the object.

Selecting text
To select a block of text, click on its baseline with the Arrow tool.

To select part of a block of text (individual characters or lines), drag the Text tool or Arc Text tool 
across the desired characters.

Selecting points
To select a point on an uncompounded path, click on it with the Point Selection tool.

To select all control points on an uncompounded path, hold down the Ctrl key and click on it with 
the Point Selection tool.

See Also
Arrow tool

Text palette

Point Selection tool



Selection Rectangle (Paint Palette)    

The Selection Rectangle allows you to select an area within a selected black & white template by 
dragging a box around it.

To select an area within a template by dragging a box around it, first change to Paint mode by 
clicking the Paint palette tool on the Draw palette.    Once in Paint mode, select the template 
by clicking it with the Arrow tool.    Next, select the Selection Rectangle and use it to click and 
drag a box around the desired area.    Everything inside the box is selected, including the 
background.

To select a template, first change to Paint mode by clicking the Paint palette tool on the Draw 
palette.    Once in Paint mode, click the template with the Arrow tool to select it.

To move a rectangular portion of the template, select it with the Selection Rectangle as described 
above.    Once the area is selected, move the Selection Rectangle tool over the selected area
until the cursor changes into an arrow.    Use the arrow to click and drag the selected area to 
the desired location.

To move a freehand portion of a template, use the Lasso tool.

See Also
Paint palette

Arrow tool (Paint mode)

Lasso tool



When you choose Send Contour Now, only the cut job is sent to Production Manager when you click 
OK.



The Send arc/curve commands checkbox allows you to take advantage of the internal curve handling of
certain plotters.

See your plotter manual to determine whether this option is available with your plotter.



If you choose Send Contour with Print, the print job and the cut job are sent to Production Manager. 



The Send packets N K bytes checkbox allows you to control the size of the data packets sent to certain 
cutter/plotters with no handshaking.

This option is not available for all cutter/plotters.



Setup (Edit Menu)    
Allows you to set up your scanner and each cutter, plotter, and color printer. When selected, this 
command displays a cascading menu with the following options:

Plotter

Scanner

Color Printer

Production Manager (available to network users only)

Before you select the Plotter or Scanner option, make sure the device is turned on and on-line. If you are 
setting up a plotter, make sure the media is loaded and ready.

Before you select the Production Manager option, make sure Production Manager is installed and set up 
on the computer you wish to choose. (This option is only available to network users running Windows for 
Workgroups.)

NOTE FlexiLETTER does not include the Scanner option of the Setup command.

See Also
Scan

Scan and Trace

Plotter Options

Preferences



The Setup list box displays the name of the currently selected setup. You can change the name by 
clicking in this entry box and typing. You can also display a different setup by holding down the arrow next
to the list box.



Shadow (Tools Menu)    
Creates a shadow around the selected text or graphic object.    There are four types of shadows available:

Drop shadows

Block shadows

Cast shadows

Perspective shadows

NOTE FlexiLETTER has a Drop Shadow command on the Tools menu. It does not include block, cast, 
or perspective shadows.

See Also
Inline/Outline



Shadows are the pixels in your image that are at the dark end of the luminosity or brightness scale.



Shape Palette    
The Shape palette is a tear-off palette. It contains the tools used to create closed objects.

Rectangle tool

Circle tool

Oval tool

Border tool

Regular Polygon tool

Freehand Polygon tool

Starburst tool



Sharp Corner (Path Edit Palette)    

The Sharp Corner tool changes a specified section of a path into a sharp corner.

To create a sharp corner between two points:

- Select the Sharp corner tool.

- Click on one side of the desired corner.

- Click on the other side of the desired corner.

- To reshape the preview of the corner, move its end points.

- Press Enter or click the right mouse button to insert the corner.

Repeat the above steps to make another corner or click another tool to finish.

See Also
Round Corner tool



Show Bitmaps As (Layout Menu)    
You can display or hide your bitmapped images by selecting the Show Bitmaps As command from the 
Layout menu. A bitmapped image is the same as a template.

Full Preview displays all bitmapped images.

Box Only displays the boundaries of the bitmapped image. You can resize and move the image 
more efficiently when Box Only is on.

Off    Bitmapped images are hidden.

See Also
Merge Bitmap

Scan



Show Fills (Layout Menu)    
Turns the display of fills on and off.    The Show Fills tool on the View palette performs the same function.

When Show Fills is on, all objects are shown with their actual fills.

When Show Fills is off, all objects are shown as outlines that represent the actual lines as they will
be cut.

To change whether or not a closed path is filled, use the Fill Status box on the Color palette.

NOTE Show Fills and Show Path Direction cannot be on at the same time.    If Show Fills is on when 
Show Path Direction is turned on, Show Fills is automatically turned off.    It is then dimmed on 
the menu and cannot be selected until Show Path Direction is turned off.

See Also
Show Path Direction

Show Fills tool 

Fill Status box

Color Palette



Show Fills (View Palette)    

Show Fills turns the display of fills on and off.    The Show Fills command on the Layout menu performs 
the same function.    When Show Fills is on, all objects are shown with their fills; when it is off, all objects 
are shown as outlines. To see the lines that will be cut, turn Show Fills off.

NOTE To change whether or not an object is filled, use the Fill Status box on the Color palette.

Show Fills and Show Path Direction cannot be on at the same time.    If Show Fills is on when Show Path 
Direction is turned on, Show Fills is automatically turned off.    It is then dimmed on the menu and cannot 
be selected until Show Path Direction is turned off.

See Also
Show Fills 

Show Path Direction

Fill Status box

Color Palette



Show Grid (Layout Menu)    
Turns display of the grid on and off.

To change the distance between the grid lines, use the Grid Size option of the Preferences 
command.

To automatically align objects to the grid as you create them, use the Snap to Grid command.

To save changes to grid settings so they are the same for every new sign,    use the Save all 
preferences option of the Preferences command.

See Also
Preferences

Align

Snap to Grid



Show Path Direction (Layout Menu)    
Displays the direction of all closed paths, including text which has been converted to paths.

Counterclockwise paths are indicated with solid lines.    These paths should generally be on the 
outside.

Clockwise paths are indicated with dotted lines.    These paths should generally be on the inside.

When checking path direction, look from the inside out.    A hole should be clockwise, the next path 
outside it should be counterclockwise, the next clockwise, etc.    To change path direction, use the Path 
Direction command on the Tools menu.

NOTE Show Fills and Show Path Direction cannot be on at the same time.    If Show Fills is on when 
Show Path Direction is turned on, Show Fills is automatically turned off.    It is then dimmed on 
the menu and cannot be selected until Show Path Direction is turned off.

See Also
Show Fills

Path Direction



When the Show Preview box is checked, the preview of the current fill is displayed.



Show Preview (Layout Menu)    
Turns preview on and off. This feature is especially useful when moving or resizing an object.

- When preview is on, an image of the object is displayed while you edit it.

- When preview is off, the bounding extent of the object(s) being edited is displayed.

NOTE Performing certain memory-intensive operations, such as moving an object's control points, may 
slow system performance when Show Preview is turned on.



Show Rulers (Layout Menu)    
Turns the display of rulers on and off.

To change the ruler from English system to metric or vice versa, use the Default unit system 
option of the Preferences command.

To change the origin of the rulers, drag a crosshair from the arrows in the upper left corner of the 
rulers  to a new location.

To save all changes to the rulers so they are displayed the same way for every sign, use the Save all 
preferences option of the Preferences command.

See Also
Preferences



Size (Text Menu)    
Changes the size of the selected text.    If no text is selected, all new text is created in the size chosen.    
The size can also be changed using the Text Specs command or Object Info.

To use one of the sizes shown on the Size cascading menu, first select the text by dragging one of
the text tools over it or by clicking it with the Arrow tool.    (To change the size for new text, 
make sure nothing is selected.)    Choose Size from the Text menu and then choose the 
desired size from the cascading menu.    When you release the mouse button, the text is 
changed.

To use an size not shown on the Size cascading menu, first select the text by dragging one of the 
text tools over it or by clicking it with the Arrow tool.    (To change the size for new text, make 
sure nothing is selected.)    Choose Size from the Text menu and then choose Other from the 
cascading menu.    Enter the desired size in the Type Size dialog box and click OK.    The text 
is changed and the new size is added to the Size cascading menu.

To add a size to the Size cascading menu, choose Size from the Text menu and then choose 
Modify from the Size cascading menu. In the Font Sizes dialog box which is displayed, type 
the desired size in the New Size entry box and click the Add button. The new size is added to
the list box on the right of the dialog box. Once you have finished adding sizes to the menu, 
click OK.

To remove a size from the Size cascading menu, choose Size from the Text menu and then 
choose Modify from the Size cascading menu. In the Font Sizes dialog box which is 
displayed, the sizes currently included on the Size cascading menu are displayed in the list 
box on the right. Click on the size to be deleted and then click the Remove button. The size is
removed from the list box. Once you have finished deleting sizes, click OK.

To change the units in which type size is measured, for example, from inches to points, use the 
Preferences command.

To change the default text size, choose a size as described above.    Then choose Preferences 
from the Edit menu and save all preferences.

See Also
Preferences

Text Specs 

Text Palette 

Object Info



The Size list box allows you to choose the default size for the current color printer setup. The sizes 
available depend on which media you have selected.



The Size list box displays all of the available sizes for the currently selected media and printer. To 
change the name of the selected size, highlight it and type the new name.



Snap to Grid (Layout Menu)    
Turns the grid snap option on and off.    This option aligns new objects by automatically pulling them to the
nearest grid intersection.    When it is on, the Rectangle, Oval, and Pen tool cursors have a small plus sign
in the middle and dotted lines.

To create an object which is not aligned with a grid line, turn off grid snap.    You can turn it on again to 
align objects you create later.    Grid snap does not affect the placement of existing objects.

NOTE The grid does not have to be displayed to use grid snap.

See Also
Align

Show Grid



Spacing (Arrange Menu)    
Places two or more objects a specified horizontal or vertical distance from each other.

To change the horizontal spacing of two objects, select the two objects using the Arrow tool.    
Choose the Spacing command from the Arrange menu and then choose Horizontal from the 
cascading menu which pops up. Enter the desired spacing between the adjacent sides of the 
selected objects in the dialog box which is displayed.

To change the vertical spacing of two objects, select the two objects using the Arrow tool.    
Choose the Spacing command from the Arrange menu and then choose Vertical from the 
cascading menu which pops up. Enter the desired space between the bottom of the upper 
object and the top of the lower object in the dialog box which is displayed.

See Also
Align

Resize

Move



To control the amount of spacing between the tiles in your pattern, enter a positive number in Horiz. and 
Vert. Spacing.



Spelling (Text Menu)    
Checks the spelling of selected text or of the entire sign.

NOTE Spell checking only works on actual text.    You cannot check the spelling of text which has been 
converted to paths directly or by applying one of the features on the Tools menu, many of which 
convert text to paths automatically.

To check the spelling of the entire sign, choose Spelling from the Text menu.    From the cascading
menu, choose Check Document.

To check the spelling of individual words or text blocks, select the text by dragging one of the text 
tools over it or by clicking it with the Arrow tool.    Choose Spelling from the Text menu and 
then choose Check Selection from the cascading menu.

To change the default dictionary used by the spell checker, choose Preferences from the Edit 
menu and click the Choose button in the Preferences dialog box to display the standard file 
selection box.    Click the desired dictionary file to select it and click OK. Then save 
preferences to open the selected dictionary every time you use Flexi.

Spell Checking Options
Unknown word    Displays the first word not found in the dictionary.    The first line simply displays 

the word as it appears in your sign.    The second line places the word in a text entry box 
which you can change by clicking one of the suggestions in the list below it or by typing in the
corrected spelling.    Flexi uses this spelling when you click the Replace button.

Suggestions list    Shows all the possible correct spellings for the current word found in the 
dictionary.    If none were found, the message "No suggestion" is displayed.

Context display    The box below the suggestions list shows the entire line in which the current 
unknown word was found.    The unknown word itself is underlined.

Replace button    Deletes the unknown word, puts the correct spelling shown in the top entry box 
in its place, and continues to the next unknown word.

Check button    Searches for the next unknown word.

Skip button    Ignores the unknown word and continues to the next one.

Learn button    Adds the unknown word to the dictionary and continues to the next one.

Done    Ends the current spell checking session.

See Also
Text Palette 

Preferences



Starburst (Shape Palette)    

The Starburst tool draws starbursts.

To draw a starburst freehand, double-click or hold down the Ctrl key and click the Starburst tool.    
Enter the desired number of points in the first entry box and click the Freehand option.    If the
preview display shows the desired starburst, click OK.    Click and drag a circle to indicate the
inner radius or    the outer radius of the starburst.    (A small X marks the center of the 
starburst while you drag.)      When you are satisfied with the first radius, click on the drawing 
area.    Drag the cursor to stretch or shrink the points of the starburst and to change its 
rotation. To restrict the angle of the starburst in 45° increments, hold down the Shift key while 
dragging. When you are satisfied with its appearance, click again on the drawing area.

NOTE If a starburst appears on the drawing area as soon as you click, you need to choose to draw 
freehand.    Double-click or hold down the Ctrl key and click the Starburst tool.    In the Starburst 
Options dialog box which is displayed, click the Freehand option and click OK.

To specify the size of one or more starbursts, double-click or hold down the Ctrl key and click the 
Starburst tool.    Enter the desired number of points in the first entry box and click the Specify 
option.    Enter the desired inner radius, outer radius, and angle.    If the preview display 
shows the desired starburst, click OK.    The cursor changes to a starburst of the specified 
size.    Click on the drawing area at the desired center point of each starburst.    Click another 
tool to finish.

See Also
Regular Polygon tool



The status icon is animated when the sign is being rasterized.



A message displays the current page's status: preparing data, processing image, or rasterizing image.



Step & Repeat... (Edit Menu)    
Makes multiple copies of the selection, allowing you to specify number of copies, spacing between 
copies, and how those copies will be arranged.

The following options are provided in the Step & Repeat Options dialog box:

Arrangement    Click on one of the buttons in the upper left corner of the dialog box to choose 
how the copies will be laid out on the drawing area. The choice you make will determine 
which of the remaining options are available.

Horiz. Copies    How many horizontal (left to right) copies will be made.

Vert. Copies    How many vertical (up and down) copies will be made.

Total Copies    How many copies will be made overall.

Keep Original    Determines whether or not the original should be deleted.    Click in this box to 
leave the original on the drawing area; leave it blank to delete the original.

Copy Spacing    These icons determine how spacing is measured. Click the left icon to measure 
just the space between each copy.    Click the right icon to include the copy itself, measuring 
from the left edge of the first copy to the left edge of the second copy.    This option is not 
available for either of the circular Step & Repeat options.

Horiz. Spacing  The space between each of the horizontal (left to right) copies.

Vert. Spacing    The space between each of the vertical (up and down) copies.

Radius    (Circular options only)    The size of the circle around which the copies should be placed. 
Measured from the center to the outer edge of the circle.

Start Angle    (Circular options only)    In degrees, the starting point for placing the copies on the 
circle. For example, to start at the middle left of the circle, enter 180°.

Sweep Angle    (Circular options only)    Click this option to distribute the copies over a certain 
angle. For example, to spread the copies across the top half of a circle, click this option and 
enter 180°.

Angle Between    (Circular options only)    Click this option to measure the angle between each 
copy. For example, to distribute 10 copies evenly around the circle, click this option and enter
36°. (Note    When using this option, make sure the radius is large enough that the copies 
won't all come out on top of each other.) 

See Also
Copy

Duplicate



Straight Arrow (Label Palette)    

The Straight Arrow tool labels the selected area with a straight arrow and the desired text.

To draw an arrow leading from a point directly to a text label, select the Straight Arrow tool.    Enter
the text and desired options in the Label Options dialog box (described below) and click OK.   
Click the crosshair cursor on the drawing area to place the tip of the arrow and then drag the 
mouse until the arrow is the desired length and angle.    Click again to finish the label.

To draw an arrow with multiple segments, use the Bent Arrow tool.

To indicate the size of an object with two arrows, use the Horizontal Size tool, Vertical Size tool, or
Diagonal Size tool.

Label Options
Text Size    Height of the label text.

Arrow Length    Length of the arrow's head.

Arrow Width    Line width of the arrow.

Arrow Style    Shape and style of the arrow's head.

See Also
Bent Arrow tool

Horizontal Size tool

Vertical Size tool

Diagonal Size tool



A straight segment on a path does not have direction handles at its end points and cannot be reshaped 
by dragging. To change a straight segment into a curved segment, click on the Curved segment icon in 
Object Info.



If the image you are printing is taller than your media, the media is automatically divided into strips. The 
strip information is displayed here.



If a panel is wider than the media currently loaded on your plotter, horizontal lines divide it into strips.



Stripe (Tools Menu)    
Adds horizontal, vertical, or diagonal stripes to the selected text or graphic object.    There are four types 
of striping available

Even Striping

Gradient Striping

Radiant Striping

Circular Striping

NOTE Any text which is striped is automatically converted to paths and can no longer be edited as text.

See Also
Even Striping

Gradient Striping

Radiant Striping

Circular Striping



Manipulate the triangles on the Stripe Bar to create your fill.

To add a color stripe, click the lower edge of the bar to create a new triangle, then click the Color .... 
button and choose a color from the Color dialog box.

Click and drag the triangles horizontally to adjust the width of the stripes. The entry box displays the 
position of the active color. You can enter a value here, if desired.

To remove a stripe, click and drag the triangle beneath the line.

Click on the triangle to make it active. The active color is underlined.

Click the lower edge of the stripe bar to create a new color.

The stripe bar is scaled to represent the width entered in the Width: entry box.

Return to Color Stripe Options



Stroke... (Tools Menu)    
Places an outline around the selected object.

The Stroke Options dialog box contains the following items

Stroke Width    Determines the thickness of the stroke.

Color    Determines the color of the stroke.

Correct Direction      Automatically changes the direction of affected paths so they are in the 
correct order. When this option is selected, they will start on the inside with a clockwise path, 
alternating with counterclockwise paths from the inside out. Unless you are creating special 
effects, this option should always be on.

See Also
Inline/Outline

Combine

Color Trapping

Color Palette



Choose a saved pattern from the Style list box. You can also create, delete, or copy styles.



The substrate is the actual material to which you apply your sign, such as a truck, window, or show card. 
You can change the color of the drawing area to match the substrate, making it easier to see how the 
finished sign will look. 



System Info (Help Menu)    
Displays all of the vital information about your computer, such as the DOS and Windows versions, how 
much RAM is available, and which fonts are installed.

To save the system information to a text file you can print later, click the Save As button.    The 
standard save dialog box is displayed.

To edit your system configuration files, click the View Configuration Files button.    This displays 
the following files for editing

-      autoexec.bat

-    config.sys

-    win.ini

-    system.ini

See Also
Contacting Product Support



System Requirements    
To use Flexi, you should have the following hardware and software:

- i386™, i486™, or Pentium™ processor (Pentium recommended)

- 16 MB RAM (minimum); 32 MB RAM for color scanning

- Hard disk with at least 20 MB free plus one 3 -1/2" floppy drive; 100 MB free for color 
scanning/printing large files

- Windows version 3.1, 3.11, or Windows for Workgroups

- Adobe Type Manager 2.5 or later

- 13'" color VGA monitor or better recommended

- Scanner (except FlexiLETTER)

- Plotter or cutter

- Mouse

See Also
System Info



Tear-Off Palettes    
Tear-off palettes are subpalettes which can be dragged off the Draw palette. To use one of these palettes,
click on a tool and then move the mouse slightly to display the tear-off palette. You can then either drag 
the mouse to the desired tool and release the mouse button, displaying the new tool on the Draw palette, 
or you can drag the entire palette away from the Draw palette, releasing the mouse button to drop the 
palette on the drawing area.

To close a tear-off palette, click the close button at the top left of the palette. You can open any of the tear-
off palettes by pulling them off the Draw palette as needed.

To move a tear-off palette that has been placed where you cannot drag or close it, tear off a second copy 
of the palette. The palette displays in the new position and the first copy of the palette disappears.

Flexi has the following tear-off palettes:

Text Palette

Path Create Palette

Path Edit Palette

Shape Palette

Autotrace Palette

Label Palette



Tear-off palettes are subpalettes which can be dragged off the Draw palette. You can either drag the 
mouse to the desired tool and release the mouse button, displaying the new tool on the Draw palette, or 
you can drag the entire palette away from the Draw palette, releasing the mouse button to drop the 
palette on the drawing area.



A template is a bitmapped image used as a 'stencil' for autotracing.



Text (Text Palette)    

The Text tool creates and edits normal text.    Arc text is edited using the Arc Text tool.

Creating normal text
To create normal text using the Text tool, click the tool on the drawing area and type the desired 

text.    When the text is entered, either click another tool to finish entering text or click the Text
tool on the drawing area to create a new text block.

To create normal text using the Text Specs command, first click the Text tool to select it and then 
choose Text Specs from the Text menu.

Editing normal text
To add characters, click the Text tool where you want to insert characters and begin typing.

To delete characters, highlight them by dragging the Text tool over them and either press the 
Delete key or choose the Clear command from the Edit menu.

To move two lines of text closer together, click the Text tool in the lower line of text, hold down the 
Ctrl key, and press the up arrow key.

To move two lines of text farther apart, click the Text tool in the lower line of text, hold down the 
Ctrl key, and press the down arrow key.

To change the size or shape of text using the Arrow tool, click and drag one of the control points 
on the text block. 

To edit a block of text using Text Specs, click on it with the Arrow tool and then double-click it.    
The Text Specs dialog box is displayed.

To edit part of a block of normal text using Text Specs, drag the Text tool over the desired text to 
highlight it and choose Text Specs from the Text menu.

See Also
Text Specs 

Arc Text tool



Text Menu Commands    
Font

Size

Alignment

Case

Text Specs

Copy Style

Apply Style

Full Justify

Kern

Define Kerning

Find/Replace

Spelling

Break Apart

Join Together



Text Palette    
The Text palette is a tear-off palette. It contains the tools used to create and edit text.

Text tool

Arc Text tool



Text Specs... (Text Menu)    
Changes the text attributes of selected normal or arc text.    If no text is selected, changes how new text 
will be created.    You can also use Object Info or individual menu commands to change these text 
attributes.

To edit normal text, select the text by dragging the Text tool over it or by clicking it with the Arrow 
tool.    Choose Text Specs from the Text menu or double-click the selected text.    The Text 
Specs dialog box is displayed.

To edit Arc Text, drag the Arc Text tool over it or click it with the Arrow tool.    Choose Text Specs 
from the Text menu or double-click the selected text.    The Arc Text Specs dialog box is 
displayed.

To create normal text using Text Specs, click the Text tool.    Choose Text Specs from the Text 
menu.    The Text Specs dialog box is displayed.

To create arc text using Text Specs, click the Arc Text tool.    Choose Text Specs from the Text 
menu.    The Arc Text Specs dialog box is displayed.

To change the size or shape of a text block manually, use the Arrow tool to drag the control points.

See Also
Text Specs dialog box

Arc Text Specs dialog box

Text Palette 

Object Info



Enter the width or height of the object in your pattern. If Maintain Proportion is checked, the tile maintains 
its proportions when you enter a height or width.



A scaled print job is automatically tiled when it is too big to fit on the page size selected in Page Setup.    
This process divides the sign into pages, printing a piece of the sign on each page according to a grid.    A 
tiled job can be no more than 2 tiles wide in one direction, and can have an infinite number of tiles in the 
other direction.    For example, a sign can be 2 tiles wide and 5 tiles high, or it can be 5 tiles wide and 2 
tiles high, but it cannot be 5 tiles wide and    5 tiles high.



The Title changes according to what is selected for printing. The possibilities are: FlexiPRINT Objects, 
FlexiPRINT Panels, or FlexiPRINT All Colors.



Tool Info is an information box which displays hints about the selected tool, including any special options 
that are available at each step of the current task.    To display Tool Info, choose Palettes from the Layout 
menu.



Tools Menu Commands    
Combine

Inline/Outline

Shadow

Distort

Stripe

Contour

Color Trapping

Stroke

Convert to Paths

Path Direction

Photo Mask

Color Correction



When Transparent Fill is checked, there is no background color behind your pattern fill. The fill takes the 
color of the object you are filling when the box is not checked.



You can fill your object with a linear or circular gradient. Linear gradients blend in stripes; circular 
gradients blend in concentric circles.



Click the Undo button to reverse the last change you made to the image. You can undo to the last save.



Undo (Edit Menu)    
Cancels your last action, backing up one step. Choose this command repeatedly until you back up to the 
step in which you made an error. Flexi allows you to undo any changes you have made since you last 
saved the file; saving the file resets the Undo information, so you cannot back up past that point.

To reverse an Undo immediately, choose Redo from the Edit menu.

To undo all of the changes you have made since the last time you saved, choose the Revert 
command from the File menu.

NOTE    If you are warned that Flexi is running out of memory, save the file immediately. This resets the 
Undo information and frees the memory it is using.

See Also
Redo

Revert



Ungroup (Arrange Menu)    
Separates objects which have been joined using the Group command.

If you click on an object which appears to be grouped but the Ungroup command is dimmed, the object 
may be compounded. (Grouped objects have square control points; other objects have round control 
points.) To separate compounded objects, use the Release Compound command.

See Also
Group

Make Compound

Release Compound



Using Help (Help Menu)    
Displays instructions for using help in Windows, including FlexiFAMILY Help.



A vector file contains objects that are composed of lines and curves, rather than rows of pixels. A vector 
image can be resized without changing its resolution. All of the file types found in the Open Drawing 
dialog box that is displayed when you use the Open or Merge commands are vector file formats.



Vertical Size (Label Palette)    

The Vertical Size tool labels the vertical dimensions of the selected area with two arrows and the desired 
text.

To label the vertical dimensions of an area or object, select the Vertical Size tool.    Click the 
crosshair on the first of the two points to be labeled and drag to the second point. Enter the 
text and desired options in the Label Options dialog box (described below) and click OK.    
Move the mouse from side to side to change how far the label is from the object or up and 
down to change where the label is placed in relation to the dimensioning lines.    (The label 
can be above, below, or inside the lines.)    Once you are satisfied with the label's placement, 
click on the drawing area to finish it.

To draw an arrow leading from a point directly to a text label, use the Straight Arrow tool.

To draw an arrow with multiple segments, use the Bent Arrow tool.

To label the horizontal dimensions of an area or object, use the Horizontal Size tool.

To label the diagonal dimensions of an area or object, use the Diagonal Size tool.

Label Options
Label Text    Text to be displayed on drawing area. Automatically displays the vertical distance you

dragged to create the label.

Text Size    Height of the label text. 

Arrow Length    Length of the arrow's head.

Arrow Width    Line width of the arrow.

Arrow Style    Shape and style of the arrow's head.

See Also
Straight Arrow tool

Bent Arrow tool

Horizontal Size tool

Diagonal Size tool



View Palette    
Use items on the View palette to change how your sign is displayed on the screen. The tools in this 
palette do not change the sign itself.

Hand tool

Magnifying Glass

Zoom Out

Zoom to Edge

Zoom In

Previous View

Show Fills



Enter the width of your stripe pattern here. If you enter 5 inches, the stripe pattern will repeat every 5 
inches. The stripe bar is also scaled to 5 inches.



The Width entry box allows you to specify the default media width.

Do not increase this value beyond your plotter's maximum page width.



Zoom In (View Palette)    

Zoom In magnifies the view of your sign, making it larger on your display.

To double the size of the view, either click Zoom In (large mountain) or click the Magnifying Glass 
on the point you want to be in the center of the window.

To zoom in on a particular area, use the Magnifying Glass to drag a box around it.

To zoom to the edge of the objects on your sign, double-click the Magnifying Glass on the drawing
area.

To zoom in on an object, click on the object with the Arrow tool to select it and then click Zoom to 
Edge (mountain with border).

To zoom to the edge of the drawing area, click on a blank portion of the drawing area to make 
sure nothing is selected and then click Zoom to Edge (mountain with border).

See Also
Magnifying Glass

Zoom Out

Zoom to Edge



Zoom Out (View Palette)    

Zoom Out reduces the view of your sign, allowing you to see a larger area.

To view the sign at half its current size, displaying a larger area, click Zoom Out (small mountain) 
or hold down the Ctrl key and click the Magnifying Glass on the point you want to be in the 
center of the window.

To zoom to the edge of the drawing area, click on a blank portion of the drawing area to make 
sure nothing is selected and then click Zoom to Edge (mountain with border). 

See Also
Magnifying Glass

Zoom to Edge

Zoom In



Zoom to Edge (View Palette)    

Zoom to Edge zooms in or out to the edge of the selected object(s). If nothing is selected, it zooms to the 
edge of the drawing area, centering your sign on the window.

To zoom in on an object, click on the object with the Arrow tool to select it and then click Zoom to 
Edge (mountain with border).

To zoom to the edge of the drawing area, click on a blank portion of the drawing area to make 
sure nothing is selected and then click Zoom to Edge (mountain with border).

To zoom to the edge of the objects on your sign, double-click the Magnifying Glass on the drawing
area.

See Also
Magnifying Glass

Zoom Out

Zoom In



The active color is used when creating objects using either the wire frame or solid fills. The active color 
is displayed in the Fill Box and highlighted in the Color palette.



New objects are created using the active fill.



A color stripe fill is made from two or more color stripes of fixed width that are repeated to fill an object.



A gradient fill is created by combining one or more color pairs so that the first color in a pair blends 
smoothly with the next.



A pattern fill is created by duplicating and repeating objects that you create.



A tile is one repeat of a pattern. 






